## Contents

**Preface** ................................................................. 11
  - Best Practice and New icons ................................. 12
  - About the BMC Remedy IT Service Management Suite. .... 12
    - BMC Atrium CMDB 2.0 ........................................ 12
    - BMC Remedy Asset Management 7.0 ...................... 13
    - BMC Remedy Change Management 7.0 .................... 13
    - BMC Remedy Incident Management 7.0 .................. 13
    - BMC Remedy Problem Management 7.0 .................. 13
    - BMC Service Level Management 7.0 ..................... 14
**Audience** .............................................................. 15
**BMC Remedy IT Service Management Suite documents** .... 15
  - Documents important for BMC Remedy Change and Configuration Management .... 19

### Chapter 1 Introducing BMC Remedy Change Management .......... 23
  - About BMC Remedy Change Management ................... 24
  - Dependencies and sequences in changes and tasks ........ 25
  - Approvals ......................................................... 26
  - Risk and impact analysis ...................................... 27
  - Cost analysis and management ............................... 27
  - Reporting ......................................................... 27
  - BMC Remedy Change Management user roles ............... 27
    - Requester ....................................................... 28
    - Change manager ................................................ 28
    - Change assignee ............................................... 30
Task implementer. .................................................. 30
Change implementer ............................................. 31
Approvers and the CAB ........................................ 32
Manager. ............................................................. 33
Company executives ............................................. 33
Application administrator ..................................... 34
Process flow and the stages of a change request ........ 34
State transitions of change requests ......................... 36
Additional status values for change requests ............. 39
Requirements for status reasons ......................... 40
Sending and receiving notifications ..................... 41
Notifications by groups ....................................... 42
Notifications by roles ......................................... 43
Steps in the life cycle of a change request .............. 44

Chapter 2 Working with the Requester Console .......... 47
Requester role. .................................................. 48
Service Request Management users ................... 48
Understanding the Requester Console ................. 50
Opening the Requester Console ......................... 51
Functional areas and tasks ................................ 52
Working with service requests ....................... 54
Creating a service request ................................ 54
Filtering your service requests ......................... 57
Viewing a service request record ....................... 58
Modifying a service request ............................... 59
Searching for service requests by Request ID ......... 60
Printing a service request ................................ 60
Canceling a service request ............................... 61
Reopening a request ......................................... 61
Completing surveys .......................................... 62
Viewing requests with errors ......................... 64
Working with service requests as the Request Master . 65
Opening a Service Request record .................... 66
Reopening a request ......................................... 67
Viewing or adding Work Info ............................. 68
Viewing the event log and troubleshooting ............. 71
Chapter 4 Using the Change Management Console ........................................ 105
  Using the Change Management Console ........................................ 106
  Using the Manager Console as a change manager ....................... 107
  Using the Support Console as a change assignee ....................... 108
  Opening the Change Management console ............................... 109
  Viewing tasks assigned to you ........................................ 109
  Company and Console View ........................................ 111
    Viewing changes assigned to selected groups ..................... 111
  General Functions ........................................ 112
  Advanced Functions ........................................ 113
  Other Applications ........................................ 114
  Searching for change requests ........................................ 114
    Searching your requests ........................................ 115
    Using the Advanced Search function ..................................... 116
    Searching all change requests ........................................ 117
    Searching for change requests assigned to groups ..................... 117
    Printing change requests ........................................ 122
  Search Criteria ........................................ 123
  Broadcast messages ........................................ 124
  Assigned Tasks table ........................................ 124
  Assigned Change table ........................................ 125
    Work Info ........................................ 125
  Quick Actions ........................................ 125
  Using Reminders ........................................ 126
    Creating Reminders ........................................ 126
    Viewing, modifying, and deleting reminders ...................... 128
  Working with reports ........................................ 130
    Generating a report ........................................ 130
    Using qualifications to generate a report ...................... 131
    Generating a report using saved qualifications ..................... 134
  Managing inventory locations ........................................ 135
    Viewing inventory locations ..................................... 135
    Relocating CIs ........................................ 137
    Reserving and using inventory ..................................... 138
  Using the Process Overview ........................................ 139
  Using the Configuration Manager ..................................... 140
# Chapter 5  
## Change assignee role  
- Working as a change assignee  
- Using the Change form  
  - Using Quick Links  
  - Using the Functions tab  
  - Using Advanced features  
  - Creating other requests  
  - Using other ITSM consoles  
  - Sending pages and email messages  
  - Viewing audit log  
  - Viewing impacted areas  
  - Using advanced search  
  - Selecting change templates  
  - Copying change requests  
  - Viewing risk reports  
- Viewing, creating, and modifying change requests  
  - Viewing change requests  
  - Creating change requests—Basic steps  
  - Modifying existing change requests  
- Working with change request assignments  
  - Automatically assigning changes  
  - Assigning change requests  
  - Assigning changes to change implementers  
  - Tracking efforts  
  - Receiving notifications of change request assignments  
  - Reassigning change requests  
- Planning the change request  
  - Registering time segments  
  - Searching for available times for change requests  
  - Assessing risk and impact  
  - Planning dependencies for change requests  
- Understanding the approval process  
  - Approving or rejecting change requests  
  - Handling approvals for emergency change requests  
  - Resubmitting a rejected change request  
  - Implementing the change request
Contents

BMC Remedy Change Management 7.0

Working with tasks ........................................... 213
  Relation of task states to change states ................. 214
  Viewing task groups and tasks .......................... 216
  Relating ad hoc tasks to change requests ............... 218
  Relating predefined task group or task templates to a change request .......................... 221
  Assigning a sequence number to task groups and tasks ........................................... 224
  Modifying tasks ............................................ 226
  Assigning tasks ............................................ 226
  Planning the time for tasks ............................... 228
  Tracking the time spent working on tasks ............... 229
  Adding work information to a task ....................... 231
  Canceling tasks ............................................ 232

Working with relationships and dependent change requests ................. 233
  Defining relationships ................................. 235
  Copying relationships .................................. 240
  Modifying relationships ................................ 241
  Viewing relationships .................................. 242
  Removing relationships ................................ 244
  Creating related change requests ....................... 244
  Working with related configuration items ............... 250
  Creating CI unavailability ................................ 259
  Working with related LDAP objects ....................... 271
  Working with related software library items .......... 273
  Working with incidents related to change requests .... 277

Monitoring the progress of a change request ................. 279
  Monitoring associated tasks ............................ 280
  Viewing SLM service targets ............................ 282

Working with costs ........................................... 283
  Using auto-cost estimates ................................ 286
  Allocating costs to configuration items ................ 287
  Tracking the time spent working on change requests .... 290

Completing change requests ................................ 292

Identifying change requests as rollbacks .................... 293
Chapter 6  Change manager role ............................................. 295
  Working as a change manager ...................................... 296
    Using the Overview Console .................................. 298
    Using the Change Management Console .................... 299
  Working with reassignment requests ............................ 301
  Generating BMC Remedy Change Management reports ..... 302
    Generating predefined reports ............................... 303
    Generating reports using qualifications .................... 304
  Predefined reports with Change Management ................. 307
  Using the Broadcasts feature as a manager ................. 308
  Creating change requests ........................................ 308
  Searching for change requests ................................ 309
  Managing configuration items .................................. 309
  Managing SLM service targets .................................. 311
  Working with change request approvals ....................... 312
    Viewing change requests awaiting approval ............... 313
  Calculating the costs of a change request .................. 313
  Using the Change Management Dashboard .................... 315
    Viewing the CCM Change Calendar ........................... 318
      Filtering criteria in the Change Calendar ............... 320
      Displaying change requests ............................... 323
      Displaying business events ............................... 325
      Using Quick Links ......................................... 325

Chapter 7  Task implementer role ................................. 327
  Working with BMC Remedy Change Management as a task implementer 328
  Accepting task assignments .................................... 329
  Reassigning tasks ................................................. 332
  Searching for assigned tasks .................................. 333
  Working with a task in progress ............................... 333
  Closing tasks ..................................................... 335
  Adding financial information to a task ....................... 336
  Using CCM tasks .................................................. 336
Chapter 8  Approver role ........................................... 345
  Working with Change Management as an approver ............ 346
    Approval criteria ............................................ 347
  Approval phases ............................................. 348
  Approving or rejecting change requests ....................... 349
  Adding approvers ............................................. 352
  Viewing non approver notifications ............................. 353

Appendix A  Change and Configuration Management (CCM) ........ 355
  About Change and Configuration Management (CCM) .......... 356
  Processing Configuration Management tasks .................... 358
    Policy-based tasks .......................................... 358
    Deployment-based tasks ..................................... 359
    Verification-based tasks .................................... 359
  CCM solution overview ....................................... 360

Appendix B  Change request status transitions .................... 367

Glossary ................................................... 375

Index ....................................................... 389
The *BMC Remedy Change Management 7.0 User’s Guide* describes how to use the BMC® Remedy® Change Management application. Change Management is one of five BMC Remedy IT Service Management applications.

The BMC® Remedy® IT Service Management Suite (BMC® Remedy® ITSM Suite) includes:

- The BMC® Remedy® Asset Management application.
- The BMC® Remedy® Change Management application.
- The BMC® Remedy® Service Desk solution (which includes the BMC® Remedy® Incident Management application and the BMC® Remedy® Problem Management application).
- The BMC® Service Level Management application.

The applications run in conjunction with the BMC® Remedy® Action Request System® platform (BMC® Remedy® AR System® platform) and share a common database. All five applications consume data from the BMC® Atrium® Configuration Management Database (CMDB) application.
Best Practice and New icons

Documentation for the BMC Remedy ITSM Suite contains two icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![New Icon]</td>
<td>The New icon identifies features or products that are new or enhanced with version 7.0.</td>
</tr>
<tr>
<td>![Best Practice Icon]</td>
<td>The Best Practice icon highlights processes or approaches that BMC has identified as the most effective way to leverage certain features in the suite.</td>
</tr>
</tbody>
</table>

About the BMC Remedy IT Service Management Suite

There have been several updates to the BMC Remedy ITSM Suite since version 6.0.

Note the change to the BMC® Remedy® Help Desk application. BMC is now offering the BMC Remedy Service Desk solution, which contains the following applications:

- BMC Remedy Incident Management
- BMC Remedy Problem Management

BMC Atrium CMDB 2.0

BMC Atrium CMDB 2.0 is installed with Asset Management, Change Management, and Service Desk (including Incident Management and Problem Management). It stores information about configuration items and their relationships in an inheritance-based data model, and has the ability to reconcile data from different sources. BMC Atrium CMDB 2.0 provides a “single source of truth” about your IT environment, enabling other BMC applications to manage CIs, predict the impact of configuration changes, and perform other Business Service Management (BSM) functions.

For more information, see the *BMC Atrium CMDB 2.0 User’s Guide*. 
BMC Remedy Asset Management 7.0

The BMC Remedy Asset Management application lets IT professionals track and manage enterprise CIs—and their changing relationships—throughout the entire CI life cycle. As part of the BMC Remedy ITSM Suite, Asset Management is integrated with BMC Remedy Service Desk (which contains the BMC Remedy Incident Management and BMC Remedy Problem Management applications), BMC Remedy Change Management, and BMC Service Level Management, and offers flexibility to support customized business processes.

For more information, see the BMC Remedy Asset Management 7.0 User’s Guide.

BMC Remedy Change Management 7.0

Using ITIL-compatible best practices, BMC Remedy Change Management provides IT organizations with the ability to manage changes by enabling them to assess impact, risk, and resource requirements, and then create plans and automate approval functions for implementing changes. It provides scheduling and task assignment functionality, and reporting capabilities for reviewing performance and improving processes. Because Change Management is integrated with BMC Atrium CMDB, it lets you relate changes to other records, such as configuration items (including services) and incidents.

For more information, see the BMC Remedy Change Management 7.0 User’s Guide.

BMC Remedy Incident Management 7.0

BMC Remedy Incident Management is used to manage incidents. Incident management is reactive, and is typically initiated in response to a customer call or automated event. An example of an automated event might be an alert from a monitoring system, such as BMC® Service Impact Management (BMC® SIM). The primary goal of the incident management process, according to ITIL standards, is “to restore normal service operation as quickly as possible with minimum disruption to the business, thus ensuring that the best achievable levels of availability and service are maintained.”
An incident is any event that is not part of the standard operation of a service and that causes an interruption to or a reduction in the quality of that service. Normal service operation is the operation of services within the limits specified by Service Level Management (SLM).

For more information, see the BMC Service Desk: Incident Management 7.0 User’s Guide.

BMC Remedy Problem Management 7.0

BMC Remedy Problem Management is used to manage problem investigations, known errors, and solution database entries. Problem management can proactively prevent the occurrence of incidents, errors, and additional problems. A problem investigation helps an IT organization get to the root cause of incidents. It initiates actions that help to improve or correct the situation, preventing the incident from recurring.

After a problem investigation identifies the cause, this information can result in either a known error or a solution database entry. A known error is a problem that has been successfully diagnosed and for which a temporary work-around or permanent solution has been identified. A solution database entry contains information that might be required to provide or restore a service.

For more information, see the BMC Service Desk: Problem Management 7.0 User’s Guide.

BMC Service Level Management 7.0

BMC Service Level Management enables a service provider, such as an IT organization, a customer support group, or an external service provider, to formally document the needs of its customers or lines of business using service level agreements, and provide the correct level of service to meet those needs.

Service Level Management also provides a means to review, enforce, and report on the level of service provided. It streamlines the most important task of all, which is the communication between a service provider and its customers. Multiple service targets can be defined and monitored, acting as a bridge between IT service support and IT operations. This enables costs to be controlled and helps to provide a consistent level of service in support of a key business service.

For more information, see the BMC Service Level Management 7.0 User’s Guide.
Audience

Change Management is intended for the following IT professionals:

- Requesters who initiate change requests.
- Change managers who are responsible for creating and planning the change request.
- Change assignees who are responsible for planning and implementing assigned changes.
- Task implementers who are responsible for executing the tasks up a change request.
- Change implementers who are responsible for less complex change requests that do not involve actual tasks.
- Approvers and the CAB who review proposed change requests approve or reject them.
- Support managers and divisional IT managers who generate reports change requests and staff activity, and perform cost analysis.
- Company executives who need to understand the trends relating change configuration management and take appropriate action the flow.
- Application administrators who install and license the application configure it to meet your organization’s business needs.

BMC Remedy IT Service Management Suite documents

The following table lists the documentation available for the BMC Remedy ITSM Suite.

Unless otherwise noted, online documentation in Adobe Acrobat (PDF) format is available on product installation CDs, on the Customer Support website (http://supportweb.remedy.com), or both. You can order printed documentation from SMBU-Upgrade@bmc.com.

Note: To access the support website, you must have a support contract.
You can access application Help by clicking on Help links within the application.

<table>
<thead>
<tr>
<th>Title</th>
<th>Document provides</th>
<th>Audience</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing for Excellence: Using Remedy for Best Practices in IT Service Management</td>
<td>Best practices for implementing the BMC Remedy IT Service Management suite in your organization.</td>
<td>Decision makers (CEOs and CTOs)</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>BMC Remedy Action Request System 7.0 Concepts</td>
<td>Concepts for using the Action Request System.</td>
<td>Administrators</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>BMC Remedy Action Request System 7.0 Installing</td>
<td>Procedures for installing the Action Request System.</td>
<td>Administrators</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>BMC Atrium CMDB 2.0 Common Data Model Diagram</td>
<td>Hierarchical diagram of all classes in the CDM, including unique attributes and applicable relationships.</td>
<td>Administrators</td>
<td>PDF</td>
</tr>
<tr>
<td>BMC Atrium CMDB 2.0 Common Data Model Help</td>
<td>Description and details of superclasses, subclasses, attributes, and relationships for each class.</td>
<td>Administrators</td>
<td>HTML</td>
</tr>
<tr>
<td>BMC Atrium CMDB 2.0 Concepts and Best Practices Guide</td>
<td>Information about CMDB concepts and best practices for planning your BMC Atrium CMDB implementation.</td>
<td>Executives and administrators</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>BMC Atrium CMDB 2.0 Developer’s Reference Guide</td>
<td>Information about creating API programs, C and Web Services API functions and data structures, and a list of error messages.</td>
<td>Administrators and programmers</td>
<td>PDF</td>
</tr>
<tr>
<td>BMC Atrium CMDB 2.0 Help</td>
<td>Help for using and configuring BMC Atrium CMDB.</td>
<td>Users and administrators</td>
<td>Product Help</td>
</tr>
<tr>
<td>BMC Atrium CMDB 2.0 Installation and Configuration Guide</td>
<td>Information about installing and configuring BMC Atrium CMDB, including permissions, class definitions, reconciliation, and federation.</td>
<td>Administrators</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>BMC Atrium CMDB 2.0 Javadoc API Help</td>
<td>Information about Java classes, methods, and variables that integrate with BMC Atrium CMDB.</td>
<td>Programmers</td>
<td>HTML</td>
</tr>
<tr>
<td>BMC Atrium CMDB 2.0 Master Index</td>
<td>Combined index of all books.</td>
<td>Everyone</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>BMC Atrium CMDB 2.0 Release Notes</td>
<td>Information about new features and known issues.</td>
<td>Everyone</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>Title</td>
<td>Document provides</td>
<td>Audience</td>
<td>Format</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>--------------</td>
</tr>
<tr>
<td>BMC Atrium CMDB 2.0 User’s Guide</td>
<td>Information about using the BMC Atrium CMDB, including searching for and comparing CIs and relationships, relating CIs, viewing history, and launching federated data.</td>
<td>Users</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>BMC Remedy 7.0 Approval Server Guide for Users and Administrators</td>
<td>Topics on installation and configuration of the Approval Server, how to use the Approval Server, and understanding the approval workflow.</td>
<td>Users and administrators</td>
<td>Print and PDF</td>
</tr>
<tr>
<td><strong>ITSM Configuration Quick Start</strong></td>
<td>Start with this reference card to quickly install and configure applications in the ITSM suite.</td>
<td>Administrators</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>BMC Remedy IT Service Management 7.0 Configuration Guide</td>
<td>Procedures for configuring the BMC Remedy IT Service Management applications.</td>
<td>Administrators</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>BMC Remedy Asset Management 7.0 Release Notes</td>
<td>Information about known issues in each release of BMC Remedy Asset Management. Also provides a list of new features included with the application.</td>
<td>Everyone</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>BMC Remedy Asset Management 7.0 User’s Guide</td>
<td>Procedures for using the BMC Remedy Asset Management application; includes new features and overview.</td>
<td>Everyone</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>BMC Remedy Change Management 7.0 Release Notes</td>
<td>Information about known issues in each release of BMC Remedy Change Management. Also provides a list of new features included with the application.</td>
<td>Everyone</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>Title</td>
<td>Document provides</td>
<td>Audience</td>
<td>Format</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td>-------------------</td>
</tr>
<tr>
<td><strong>BMC Remedy Change Management 7.0 User's Guide</strong></td>
<td>Procedures for using the BMC Remedy Change Management application; includes new features and overview.</td>
<td>Everyone</td>
<td>Print and PDF</td>
</tr>
<tr>
<td><strong>BMC Remedy Service Desk 7.0 Release Notes</strong></td>
<td>Information about known issues in each release of BMC Remedy Service Desk: Incident Management and BMC Remedy Service Desk: Problem Management. Also provides a list of new features included with the application.</td>
<td>Everyone</td>
<td>Print and PDF</td>
</tr>
<tr>
<td><strong>BMC Remedy Service Desk: Incident Management 7.0 Help</strong></td>
<td>Help for using BMC Remedy Incident Management.</td>
<td>Everyone</td>
<td>Product Help</td>
</tr>
<tr>
<td><strong>BMC Remedy Service Desk: Incident Management 7.0 User’s Guide</strong></td>
<td>Procedures for using the BMC Remedy Service Desk: Incident Management application; includes new features and overview.</td>
<td>Everyone</td>
<td>Print and PDF</td>
</tr>
<tr>
<td><strong>BMC Remedy Service Desk: Problem Management 7.0 Help</strong></td>
<td>Help for using BMC Remedy Problem Management.</td>
<td>Everyone</td>
<td>Product Help</td>
</tr>
<tr>
<td><strong>BMC Remedy Service Desk: Problem Management 7.0 User’s Guide</strong></td>
<td>Procedures for using the BMC Remedy Service Desk: Problem Management application; includes new features and overview.</td>
<td>Everyone</td>
<td>Print and PDF</td>
</tr>
<tr>
<td><strong>BMC Service Level Management 7.0 Configuration Guide</strong></td>
<td>Procedures for configuring the BMC Service Level Management application.</td>
<td>Administrators</td>
<td>Print and PDF</td>
</tr>
<tr>
<td><strong>BMC Service Level Management 7.0 Configuration Help</strong></td>
<td>Help for configuring the BMC Service Level Management application.</td>
<td>Administrators</td>
<td>Product Help</td>
</tr>
<tr>
<td><strong>BMC Service Level Management 7.0 Installation Guide</strong></td>
<td>Procedures for installing the BMC Service Level Management application.</td>
<td>Administrators</td>
<td>Print and PDF</td>
</tr>
<tr>
<td><strong>BMC Service Level Management 7.0 Release Notes</strong></td>
<td>Information about known issues in each release of BMC Service Level Management. Also provides a list of new features included with the application.</td>
<td>Everyone</td>
<td>PDF</td>
</tr>
<tr>
<td><strong>BMC Service Level Management 7.0 User Help</strong></td>
<td>Help for using the BMC Service Level Management application.</td>
<td>Everyone</td>
<td>Product Help</td>
</tr>
</tbody>
</table>
The BMC Remedy CCM solution includes the following additional documents:

<table>
<thead>
<tr>
<th>Title</th>
<th>Document provides</th>
<th>Audience</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMC Service Level Management 7.0 User’s Guide</td>
<td>Procedures for using the BMC Service Level Management application; includes new features and overview.</td>
<td>Everyone</td>
<td>Print and PDF</td>
</tr>
<tr>
<td>BMC Remedy 7.0 Task Management Administrator’s Guide</td>
<td>Procedures to configure Task Management.</td>
<td>Administrators</td>
<td>Print and PDF</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This guide also includes steps to configure seamless authentication between BMC Remedy Change Management and the other components of BMC Remedy Change and Configuration Management (CCM).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Documents important for BMC Remedy Change and Configuration Management**

The BMC Remedy CCM solution includes the following additional documents:

<table>
<thead>
<tr>
<th>Title</th>
<th>Document provides</th>
<th>Audience</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMC Configuration Management 7.0 Planning Guide</td>
<td>Helps you design an infrastructure for your enterprise, which involves determining the machines you will use for the various components and whether you must purchase additional hardware and software.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td>BMC Configuration Management 7.0 Reference Guide</td>
<td>Provides reference information such as command-line options, tuner properties, proxy properties, transmitter properties, channel properties, channel parameters, channel states, ports, and log IDs with associated log messages.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BMC Configuration Management 7.0 System Requirements Guide</td>
<td>Provides hardware requirements (such as processing speed, disk space, and RAM) and operating system requirements for supported platforms. This guide also lists the supported databases, directory services, and locales.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td>Title</td>
<td>Document provides</td>
<td>Audience</td>
<td>Format</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>BMC Configuration Management 7.0 Upgrade Guide</td>
<td>Provides instructions about upgrading Configuration Management products to the current version.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td>BMC Configuration Management Application Packager 7.0 Administrator’s Guide</td>
<td>Provides information about packaging software for distribution to desktops or servers. This guide also includes information about command-line usage, policies, XML templates, and Windows system macros.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td>BMC Configuration Management Infrastructure 7.0 Administrator’s Guide</td>
<td>Provides information about the infrastructure components such of Common Management Services (CMS), tuners, transmitters, and proxies. This guide also describes the tools and features you use to configure these components.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td>BMC Configuration Management Installation and Deployment 7.0 Guide</td>
<td>Provides instructions about installing for the first time the Configuration Management solution and its associated products.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td>BMC Configuration Management Introduction to Products 7.0 Guide</td>
<td>Introduces you to Configuration Management products and solutions and defines basic concepts about core technology.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td>BMC Configuration Management Policy Management 7.0 Administrator’s Guide</td>
<td>Helps you configure and administer Policy Management and the Policy Service plug-in. This guide also includes integration procedures for directory services such as Active Directory, ADAM, and Sun ONE Directory.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td>BMC Configuration Management Report Center 7.0 Administrator’s Guide</td>
<td>Provides instructions about running queries of inventory information, configuring the Inventory and Logging plug-in, configuring endpoints, and integrating Report Center with other Configuration Management applications.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td>BMC Configuration Management Schema Manager 7.0 Help</td>
<td>Provides installation, update, and maintenance instructions for the database schema and directory service.</td>
<td>System Administrator</td>
<td>Help</td>
</tr>
<tr>
<td>Title</td>
<td>Document provides</td>
<td>Audience</td>
<td>Format</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------</td>
<td>--------</td>
</tr>
<tr>
<td><strong>BMC Configuration Management Server Management 7.0 Administrator’s Guide</strong></td>
<td>Describes how to use Deployment Management and Content Replicator to control and monitor the distribution of content and applications across heterogeneous server platforms and data centers. This guide also describes Deployment Management extensions to Report Center and Application Packager.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td><strong>BMC Configuration Management Server Management Command-Line Interface 7.0 Guide</strong></td>
<td>Provides syntax and usage information for the Server Management command-line options and describes how to use the SOAP interface.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td><strong>BMC Configuration Management Configuration Discovery Integration for CMDB Implementation 7.0 Guide</strong></td>
<td>Provides instructions about planning, installing, and configuring the Configuration Discovery integration. This guide also includes information about relationship classes and mappings, data exchanges, and reconciliation definitions.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td><strong>Definitive Software Library 7.0 Administrator’s Guide</strong></td>
<td>Provides a description of the Definitive Software Library and explains how the DSL is useful to you, how to use the DSL console, and how to access the DSL using BMC CM products, such as Report Center and Application Packager.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
<tr>
<td><strong>Patch Management 7.0 Administrator’s Guide</strong></td>
<td>Helps you configure and administer Patch Management and the Patch Service plug-in.</td>
<td>System Administrator</td>
<td>PDF</td>
</tr>
</tbody>
</table>
The BMC Remedy Change Management (Change Management) application enables your organization’s service desk to create, implement, and manage change requests.

This section provides an overview of the Change Management application. The following topics are discussed:

- About BMC Remedy Change Management (page 24)
- BMC Remedy Change Management user roles (page 27)
- Process flow and the stages of a change request (page 34)
- Sending and receiving notifications (page 41)
- Steps in the life cycle of a change request (page 44)
About BMC Remedy Change Management

The BMC Remedy Change Management application provides a system of planning, scheduling, implementing, and tracking changes that need to be completed within your organization. Change Management 7.0 has updated the service management processes for superior ITIL alignment.

Change Management works in conjunction with the BMC Remedy Approval Server and integrates with other Remedy applications including:

- BMC Remedy Incident Management
- BMC Remedy Problem Management
- BMC Remedy Asset Management
- BMC Remedy Service Level Management (SLM)

Using Change Management in combination with these BMC Remedy applications enables you to assess the scope of the change, analyze the costs associated with the change (in terms of time and expense), perform impact and risk analysis, and schedule the resources needed to complete the change. Using the SLM application enables you to define service targets and measure the efforts of your support staff as they implement the changes.

If you have Change Management installed, you already have access to the task management system, which is installed and integrated as part of the application set. The Change Management application has the following additional features that the Task module does not have:

- Dependencies between change requests, and a definable sequence with enforcement
- Approval processes for change requests
- Risk and impact analysis
- Cost analysis and management functionality
- Expanded set of predefined reports

The following sections provide detailed information about these features.
Dependencies and sequences in changes and tasks

In the task management system integration with Change Management, all tasks belonging to a change request are related to one another through their association with the parent change request. You use Change Management to set dependencies among the tasks associated with a change request. You can also use Change Management to set dependencies among change requests.

- **Sequencing change requests**—In Change Management, you can assign change requests a sequence number that determines dependencies among the change requests. Change requests with a lower sequence number must be completed before those with higher numbers can be completed. You are warned if you try to complete dependent change requests out of sequence. More than one change can have the same sequence number; changes with the same sequence number are considered peers.

**Important:** Your application administrator can configure the level of enforcement of the change dependency rules. For example, Change Management can be configured so that users see an error, not just a warning, if they complete changes out of sequence. For more information, see the *BMC Remedy IT Service Management 7.0 Configuration Guide*.

When sequence numbers are assigned to change requests, the changes must be completed in numerical order. For example, a change with the sequence number 3 can be completed only after all changes with sequence numbers 1 and 2 are completed. Peer changes can be completed in any order among themselves.

For more information, see “Planning dependencies for change requests” on page 206.

- **Sequencing tasks**—When you include tasks in a change request, the tasks are automatically assigned a sequence number, in the order in which they are added. Tasks with lower sequence numbers must be completed before those with higher numbers can be completed. More than one task can have the same sequence number; tasks with the same sequence number are considered peers.

Tasks must be completed sequentially. For example, a task with the sequence number 3 can be completed only after all tasks with sequence numbers 1 and 2 are completed. Peer tasks can be completed in any order among themselves.
When the change request’s status is set to Scheduled, the task with sequence number 1 is activated and its status is set to Assigned. When the last task is completed, the change request is closed.

For more information, see “Assigning a sequence number to task groups and tasks” on page 224.

**Approvals**

In Change Management, application administrators can define an approval process in which a series of people must review and approve a proposed change request. Only after approval is granted can the change request be moved to the next state.

The approval process is handled by the following people:

- The **application administrator** selects the approval process, and if necessary, modifies the approval rules.

- The **change manager** (from Information Technology Infrastructure Library [ITIL] terminology, sometimes called the change supervisor) monitors the approval process to make sure that it proceeds as expected. The change manager also determines which types of change requests need approval, and in some cases, selects the approvers.

- The **approvers** review the change request and approve or reject it. If they need more information about a change request, they can request it. Their signature is put “on hold” while they are waiting for the information.

  There can be more than one level of approvers in the change level process, with several approvers on each level. All approvers on a level must approve the change request before the change can be reviewed by the next level of approvers. Approvers can review the actions of previous approvers by viewing their comments and the approval audit trail.

  When all approvers have approved the change request, the status of the change moves to the next status in the approval definition.

  If the change request is rejected by any approver, the approval process is stopped. The manager can then cancel the change request or update it and resubmit it for approval.

- The **requester** can check the status of the change request and follow the approval process throughout its cycle.

  For more information, see “Understanding the approval process” on page 208 and “Approver role” on page 345.
Risk and impact analysis

The change manager is responsible for planning and scheduling the change request. This includes assessing the risks and impact of the change request. The change manager can estimate the impact by using the risk assessment functionality.

For more information, see “Assessing risk and impact” on page 203.

Cost analysis and management

The change manager can specify and assess the costs of the change request including parts, labor, and other associated costs. The cost can be related to services or a configuration item (CI). The total of all allocated costs for a change request is automatically calculated.

For more information, see “Working with costs” on page 283.

Reporting

Support staff and managers can use Change Management to generate predefined reports and to view the reports with the built-in Crystal Reports viewer from Business Objects. They can also design custom reports that are tailored for the needs of their business.

For more information, see “Working with reports” on page 130.

BMC Remedy Change Management user roles

Change Management defines the following types of users:

- Requester
- Change manager (Support)
- Change assignee (Support)
- Task implementer (Support)
- Change implementer (Support)
- Approvers and the CAB
- Manager
- Company executives
- Application administrator
In addition, the Problem Manager user role from BMC Remedy Problem Management can submit change requests if the Problem Manager has Change Master, Change User, or Change Submitter permissions. Problem management enhances the Service Desk process by focusing on discovering and resolving underlying problems, and improving the IT infrastructure to enhance service and reduce the number of service desk cases. The purpose of problem management is not to solve service desk cases quickly, but to implement a reliable, long-term solution.

The roles of requester, support (change manager and task implementer), approver, and manager have separate consoles.

Although the responsibilities of these users can vary from organization to organization (and in some organizations, one person can fulfill several roles), they generally include the responsibilities outlined in the following sections.

**Important:** For complete information about ITSM foundation permissions and roles, see the *BMC Remedy IT Service Management 7.0 Configuration Guide*.

---

**Requester**

A requester is a business user who submits a Request For Change to the support staff. While any Change Management user can enter change requests into the system, change requests are likely initiated by a change manager or manager.

Requesters can access their version of the Change Management application through the Requester Console icon or URL. For information about the requester’s role and step-by-step procedures for completing requester tasks, see “Requester role” on page 48.

**Change manager**

The change manager in Information Technology Infrastructure Library (ITIL) terminology (sometimes called the change supervisor), is typically a member of the support staff and is responsible for creating, planning, and tracking the change request.
Planning activities include:

- Scheduling the change request
- Identifying, creating, and sequencing the tasks that must be performed to accomplish the change
- Assessing risks
- Creating plans
- Scheduling people and resources to implement each task
- Estimating the costs of the change request

While the change request can be created by any requester, it is usually the change manager who creates the change request. When a change request is created, it is automatically assigned to the appropriate change manager according to its criteria. The supervisor group or individual can be notified of assigned change requests by email, pager, or through BMC Remedy Alert. Using the assignment engine, any tasks are then automatically assigned to the appropriate task implementers.

In the final stage of the change request, the manager reviews all implemented changes to make sure that they have met their objectives. They refer back to the task implementers any changes that have been backed out or have failed. They close the completed change records. Finally, they analyze change records to determine any trends or apparent problems that occurred and seek correction with the relevant parties.

Change managers can access their version of the Change Management application through the Change Management console icon or URL.

In summary, the change manager is responsible for the quality and integrity of the change management process. Change managers are the main interface with all other process managers. A single organization can have several change managers.

The change manager requires the following permissions and functional roles:

- Infrastructure Change User or Change Master application permission is required for access to change and task records.
- Infrastructure Change Manager functional role is required to be assigned as the Change Manager for individual changes.
- Membership in your company’s support group is required to create change templates for that group.
For general information about support, see “Introducing the support roles” on page 77. For specific information about the change manager’s role, and step-by-step procedures for completing typical change manager tasks, see “Change manager role” on page 295.

**Change assignee**

The Change assignee is responsible for planning and implementing assigned changes. The Change assignee might be working actively on the change, or coordinating the efforts of other groups or individuals. Assignee activities and responsibilities include:

- Gathering appropriate information based on the type of change being investigated.
- Associating related CIs, incidents, and services to the change.
- Providing status updates to requesters upon request.
- Reviewing change plans and schedules.
- Reviewing all completed tasks.
- Conducting post-implementation reviews to validate the results of the change.
- Determining requester satisfaction with the overall change request.

The Change assignee requires the following permissions and functional roles:

- Change User permission is required for access to change request records.
- Change Assignee functional role is required to be assigned as the Change Assignee for individual changes.

For specific information about the change assignee’s role, and step-by-step procedures for completing typical change assignee tasks, see “Change assignee role” on page 143.

**Task implementer**

Task implementers are support people or groups responsible for executing the tasks that make up a change request. (Task information in this guide focuses on tasks related to change requests, as opposed to tasks related to service desk cases.)
When a change manager creates and schedules tasks, the task implementers are notified of tasks assigned to them by email or through BMC Remedy Alert. After tasks are assigned, task implementers log their progress as they complete the tasks. When all of the tasks related to a change request are closed, the requester and manager are notified that the change is resolved.

Task implementers can access their version of the Change Management application through the Change Management icon or URL.

The change approver requires Change User permission for access to change request and task records.

For general information about support, see “Introducing the support roles” on page 77. For specific information about the task implementer’s role and step-by-step procedures for completing typical task implementer responsibilities, see “Task implementer role” on page 327.

**Change implementer**

Change implementers are support people or groups responsible for less complex change requests that do not involve actual tasks. With these changes, tasks are optional. You can designate a member of your support staff as a change implementer in the Change form.

Change implementers have their own assignment fields in the Change form.

**Figure 1-1: Change Implementer**
Chapter 1—Introducing BMC Remedy Change Management

For example, a change implementer might be assigned a change that does not include a task. Tasks could be any type of routine activity that needs to be accomplished, for example:

- Reviewing the weekly error log report
- Rotating a backup tape
- Turning off the server room lights
- Replacing an office chair

Generally, you want to conduct a taskless change for low risk or low impact activities. You still want to record these activities to meet any audit requirements or to account for the person’s time and effort spent.

**Note:** If a change request includes one or more related tasks, the Change Implementer fields do not appear on the Assignment tab.

For more information, see “Assigning changes to change implementers” on page 174.

**Approvers and the CAB**

The approver, or the Change Authority in ITIL terminology, could be the manager of the requester or the manager of the group that is responsible for implementing the change request, depending on which approval process your organization is using. The approver might be a person (or group) that has been designated by the application administrator. This role is also known as the Change Advisory Board (CAB) in ITIL terminology.

Approvers are notified of approvals that require their review by email or through BMC Remedy Alert.

Approvers can access their version of the Change Management application through the BMC Remedy Approval Central icon or URL.
The change approver requires the following permissions and functional roles:

- Explicit change permission is not required for access to change approval records.
- The Change Approver functional role is required to approve or reject changes on behalf of the approver support group.
- Users with the Change Manager or Change Assignee functional role can approve changes on behalf of their support group.

For information about the approver role and step-by-step procedures associated with approvers, see “Approver role” on page 345.

**Manager**

The manager (sometimes known as the business service manager) is responsible for general, day-to-day issues from a personnel and customer satisfaction perspective. Typical management activities include approving requests, handling assignments, and generating reports to monitor support staff activity involved in fulfilling the change request.

Managers can access their version of the Change Management application through the Change Management console icon or URL. For information about the manager role and step-by-step procedures for completing manager responsibilities, see “Change manager role” on page 295.

**Company executives**

Company executives such as CIOs can use Change Management consoles to understand the trends relating to change configuration management, and take appropriate action to balance the flow.

For example, CIOs can use the Change Management Dashboard to view important data points in an easy-to-read graphical display. They can select appropriate flashboards to display on the Dashboard, along with a time period that applies to all flashboards.

CIOs can also use the Change Calendar to manage CCM activities. Executives can see a holistic picture of changes occurring in the enterprise, as well as associated business activities or events. Some of this information comes from the Change Management application and some through referencing objects in the BMC Atrium CMDB.
For more information, see “Using the Change Management Dashboard” on page 315 and “Viewing the CCM Change Calendar” on page 318.

**Application administrator**

The responsibilities of the application administrator (sometimes known as the change administrator) most likely include installing and licensing the application, and configuring it to meet your organization’s business needs. Some of the configuration tasks include:

- Creating and maintaining change request and task categorization.
- Defining and populating support and general staff notification groups in the People form.
- Assigning licenses.
- Configuring approvals, risk, cost, templates, assignments, and change settings.

For more information about configuring the BMC Remedy Change Management application, see the *BMC Remedy IT Service Management 7.0 Configuration Guide*.

**Process flow and the stages of a change request**

The superior user interface in 7.0 Change Management lets management, administrators, users, and approvers perform regular tasks simply and efficiently. The Process Flow Status area accelerates you through the change process from start to finish. It provides a visual mechanism to track the states of a change request, as prescribed by ITIL best practices.

*Figure 1-2: Process Flow Status area on the Change form*
On the Change form, the Process Flow Status area displays the sequence of the change request from the Draft state to the Closed state. A diagram shows the five stages of a change request, as indicated by best practices, rooted in ITIL processes. The current stage of the incident is highlighted. The status of the change is indicated both by color and text.

The Process Flow Status area functions like a wizard, guiding you through the stages of the change life cycle, from Draft to Closed. To advance through the change request, users click the process flow accelerators to move to the next stage. At each stage, the diagram provides accelerators applicable to the current stage. For example, you can use accelerators to move the change to a pending state or to the next stage. By using the process flow accelerators, you are following ITIL best practices.

**Figure 1-3: Selecting an accelerator from the Process Flow Status wizard**

When you select an accelerator, you are sometimes prompted to enter the data required to complete the stage. For example, you are prompted when you are in the Implement stage and you haven’t entered the required start and end date of the change request and its tasks. You can also enter optional recommended data, for example, the source of the change request.

New and occasional users to Change Management should find the process flow accelerators very helpful.

**Figure 1-4: Example of a process flow dialog box**
You use the Process Flow Status area to control the progression of the change, and perform approvals at different stages in the life cycle. The current and overall approval status of the change is highlighted by color indicators.

**Figure 1-5: Approval status of a change request**

The following colors indicate the current and overall approval status of the change:

- **Yellow**—Pending
- **Green**—Approved
- **Red**—Rejected

If an approval is required, for example, in the Initiate stage, the required users are prompted to approve, cancel, or reject the change request before the change request can then move to the Review and Authorize stage.

**State transitions of change requests**

Some status transitions in the change request life cycle can only be performed by users who have been assigned a specific role. For example, while all users can move a change request into the Request For Authorization state, only a Change Manager can cancel a change request.

**Important:** Some status transitions in the change request life cycle can only be performed by users who have been assigned a specific role. For example, while all users can move a change request into the Request For Authorization state, only a Change Manager can cancel a change request.

Table 1-1 describes the successive stages and approval phases of a change request. It also identifies legal state transitions for each of these forms.
### Table 1-1: Stages and approval phases of a change request

<table>
<thead>
<tr>
<th>Stage</th>
<th>Approval phase</th>
<th>Status</th>
<th>Description</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate</td>
<td></td>
<td>Draft</td>
<td>Verifies that all the required fields to create the change request are entered in the Change form. Use the Draft status to record a change request without submitting it to the Change Management process. For information, see “Creating change requests—Basic steps” on page 162.</td>
<td>Next stage, Enter pending (or resume), Cancel</td>
</tr>
<tr>
<td>Initiate</td>
<td>Review</td>
<td>Request for Authorization</td>
<td>Change is in the Review approval phase. If it is approved, only then does it move forward to the Review &amp; Authorize stage. For information, see “Approval phases” on page 348.</td>
<td>Approve, Reject, Cancel</td>
</tr>
<tr>
<td>Review &amp; Authorize</td>
<td>Business Approval</td>
<td>Request for Change</td>
<td>Change is in the Business Approval phase. Lets approvers review the change and authorize it. For information, see “Approval phases” on page 348.</td>
<td>Approve, Reject, Cancel</td>
</tr>
<tr>
<td>Plan &amp; Schedule</td>
<td>Planning in Progress</td>
<td></td>
<td>Tasks can be built at any change status except Completed. For information, see “Working with tasks” on page 213.</td>
<td>Next stage, Enter pending (or resume), Relate CI, Cancel</td>
</tr>
<tr>
<td>Plan &amp; Schedule</td>
<td>Scheduled for Review</td>
<td></td>
<td>Change Manager reviews and validates the change plans. For information, see “Planning the change request” on page 181.</td>
<td>Next stage, Enter pending (or resume), Cancel</td>
</tr>
<tr>
<td>Plan &amp; Schedule</td>
<td>Implementation Scheduled for Approval</td>
<td></td>
<td>Change is in the Implementation Approval phase. Each level of approvers must review the change and approve it. For information, see “Approval phases” on page 348.</td>
<td>Approve, Reject, Cancel</td>
</tr>
</tbody>
</table>
## Table 1-1: Stages and approval phases of a change request

<table>
<thead>
<tr>
<th>Stage</th>
<th>Approval phase</th>
<th>Status</th>
<th>Description</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan &amp; Schedule</td>
<td>Scheduled</td>
<td>Change is included in the Forward Schedule of Changes (FSC) Calendar.</td>
<td>• Next stage&lt;br&gt;• Enter pending (or resume)&lt;br&gt;• Relate CI&lt;br&gt;• Cancel</td>
<td></td>
</tr>
<tr>
<td>Implement</td>
<td>Implementation in Progress</td>
<td>At least one task related to the change is in progress. For information, see “Working with tasks” on page 213.</td>
<td>• Next stage&lt;br&gt;• Enter pending (or resume)&lt;br&gt;• Cancel</td>
<td></td>
</tr>
<tr>
<td>Implement</td>
<td>Close Down Approval</td>
<td>Completed</td>
<td>Change is in the Implementation Approval phase. The change is completed but needs approval to reach the Closed stage. For information, see “Approval phases” on page 348.</td>
<td>• Approve&lt;br&gt;• Reject&lt;br&gt;• Cancel</td>
</tr>
<tr>
<td>Implement</td>
<td>Final Review Complete</td>
<td>Completed</td>
<td>Reviewers verify change was implemented and all required tasks have been completed. KPIs analyzed.</td>
<td>• Next stage&lt;br&gt;• Enter pending (or resume)&lt;br&gt;• Cancel</td>
</tr>
<tr>
<td>Closed</td>
<td>Successful</td>
<td>Post Implementation Review has been completed and any necessary Closedown Approvals have been granted. No further activities are performed on the change.</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>
For a helpful overview of how task states compare to change states, see “Relation of task states to change states” on page 214.

For state transition diagrams that depict the status flow of change requests, see Appendix B, “Change request status transitions.”

Additional status values for change requests

Table 1-2 describes the additional status values for change requests, for example, if an approval has been rejected.

Table 1-2: Additional change status values

<table>
<thead>
<tr>
<th>Change request status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>Work on the change has been suspended temporarily. The Status Reason field is required to describe the reason for interruption.</td>
</tr>
<tr>
<td>Relate CI</td>
<td>In the Plan &amp; Schedule stage, you can search for configuration items and relate them to the change requests. For more information, see “Working with related configuration items” on page 250.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The change has been rejected by an approver at any Approval Phase.</td>
</tr>
<tr>
<td>Canceled</td>
<td>The change is no longer required or current change plans must be modified.</td>
</tr>
</tbody>
</table>
Requirements for status reasons

Users can identify a requirement for additional status reasons. Table 1-3 displays only the applicable status reasons. You must specify the status reason when the Change Request Status is Pending.

Table 1-3: Change request status reasons

<table>
<thead>
<tr>
<th>Change request status</th>
<th>Status reasons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning in Progress</td>
<td>• Accepted</td>
</tr>
<tr>
<td></td>
<td>• Assigned</td>
</tr>
<tr>
<td></td>
<td>• Built</td>
</tr>
<tr>
<td>Implementation in Progress</td>
<td>• In Rollout</td>
</tr>
<tr>
<td></td>
<td>• In Development</td>
</tr>
<tr>
<td></td>
<td>• In Test</td>
</tr>
<tr>
<td></td>
<td>• In Built</td>
</tr>
<tr>
<td></td>
<td>• In Rollback</td>
</tr>
<tr>
<td></td>
<td>• In Documentation</td>
</tr>
<tr>
<td></td>
<td>• In Verification</td>
</tr>
<tr>
<td>Pending</td>
<td>• Future Enhancement</td>
</tr>
<tr>
<td></td>
<td>• Manager Intervention</td>
</tr>
<tr>
<td></td>
<td>• Miscellaneous</td>
</tr>
<tr>
<td></td>
<td>• Support Group Communication</td>
</tr>
<tr>
<td></td>
<td>• Task Review</td>
</tr>
<tr>
<td></td>
<td>• Vendor Purchase</td>
</tr>
<tr>
<td>Rejected</td>
<td>• Insufficient Task Data</td>
</tr>
<tr>
<td></td>
<td>• Insufficient Change Data</td>
</tr>
<tr>
<td></td>
<td>• Schedule Conflicts</td>
</tr>
<tr>
<td>Completed</td>
<td>• Final Review Required</td>
</tr>
<tr>
<td></td>
<td>• Final Review Complete</td>
</tr>
<tr>
<td></td>
<td>• Additional Coding Required</td>
</tr>
</tbody>
</table>
Sending and receiving notifications

When a change request moves into a new state, for example, Completed, Change Management executes workflow that triggers notifications. Based on your group or role, you might receive notifications during various change states.

For more information, see “Receiving notifications of change request assignments” on page 180. For more information about notification preferences, see the *BMC Remedy IT Service Management 7.0 Configuration Guide*.

<table>
<thead>
<tr>
<th>Change request status</th>
<th>Status reasons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>• Successful</td>
</tr>
<tr>
<td></td>
<td>• Successful with Issues</td>
</tr>
<tr>
<td></td>
<td>• Unsuccessful</td>
</tr>
<tr>
<td></td>
<td>• Backed Out</td>
</tr>
<tr>
<td></td>
<td>• Automatically Canceled</td>
</tr>
<tr>
<td>Canceled</td>
<td>• No Longer Required</td>
</tr>
<tr>
<td></td>
<td>• Resources Not Available</td>
</tr>
<tr>
<td></td>
<td>• To Be Re-Scheduled</td>
</tr>
<tr>
<td></td>
<td>• Funding Not Available</td>
</tr>
</tbody>
</table>
Notifications by groups

The following table lists the change states that trigger notifications and the change management groups they are sent to.

Table 1-4: Change states when notifications are sent to groups

<table>
<thead>
<tr>
<th>Current status</th>
<th>Assignee group</th>
<th>Support group</th>
<th>Task implementer group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request for authorization</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request for Change</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Planning in Progress</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Scheduled For Review</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Scheduled For Approval</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scheduled</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Implementation in Progress</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Completed</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Closed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pending</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rejected</td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Canceled</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Notifications by roles

The following table lists the change states that trigger notifications and the change management roles they are sent to.

**Table 1-5: Change states when notifications are sent to roles**

<table>
<thead>
<tr>
<th>Current Status</th>
<th>Change assignee</th>
<th>Change manager</th>
<th>Requested by</th>
<th>Requested for</th>
<th>Task implementer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td></td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Request for authorization</td>
<td>No</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Planning in Progress</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planning in Progress</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Scheduled For Review</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Scheduled For Approval</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Implementation in Progress</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Completed</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Closed</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pending</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rejected</td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Canceled</td>
<td></td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
Steps in the life cycle of a change request

The next figure illustrates the life cycle of a typical change request. There can be some variation depending on how your organization configures and implements changes. For example, the model shows the use of tasks, but you might choose to only use change requests.

Figure 1-6: Life cycle of a change request

Cost assessment is not shown as part of the life cycle, but this is something you might choose to do in your business process. A change request can also use multilevel approvals and dependencies, where you could choose to use a single approver or bypass the approval process altogether. Lastly, it shows assignments given to multiple change implementers, but in a smaller company, the same person could function as change manager, approver, and task implementer.
The normal life cycle of a change request consists of five major steps:

**Step 1 Request**—The need for a new change request can arise in several ways. Examples include:

- Using the Requester Console, the requester can enter the change request directly, and ask that an application be loaded on their system.
- The discovery process detects that a system does not have the latest patches loaded.
- BMC Remedy Asset Management determines that the company has exceeded the maximum number of installed applications under an existing software license contract.
- A technician needs to make changes to a database server during non-work hours.
- BMC Patrol detects that a mirrored web server has failed and needs to be replaced.

When created, the change request is automatically routed to the appropriate support group or individual. When change requests are assigned to them, support staff members are notified by email, pager, or through BMC Remedy Alert.

**Step 2 Planning**—The change manager plans a forward schedule of changes (FSC). The change request includes planning all the changes approved for implementation, targeting dates, and estimating the risks and costs. If the change request must be divided into several tasks, the change manager can create and schedule these tasks. When changing any CI, planning also involves checking the BMC Atrium CMDB to account for all IT assets under the control of Configuration Management.

**Step 3 Approval**—If the change request requires approval, the change manager initiates the approval process. Each level of approvers must review the request and approve it. For example, the Change Advisory Board (CAB) must approve all significant changes but the change manager can approve a standard change.

When all have granted approval, the change manager can set the change request’s Status to Scheduled. Any tasks are assigned automatically to the appropriate task implementers.
Step 4  **Implementation**—As the change request enters the Implementation stage, the BMC Atrium CMDB is modified by Configuration Discovery, Service Impact Manager (SIM), or other types of discovery tools as task implementers work on the CIs that need improving or altering. They log their progress as they work to implement the change request and the tasks that comprise it. When a task is completed, the implementer for the task with the next number in the sequence is notified of their task assignment. Task implementers can calculate the cost of implementing their tasks.

If a Change and Configuration Management (CCM) solution is in place, task implementers can review the task, initiate a launch into the BMC Configuration Management application suite, make any necessary edits to the deployment or policy, execute the task, and then verify that the task has been completed. All necessary information regarding the task identifier, target, and packages is automatically transferred to Configuration Management.

When all the task implementers have finished their tasks, CCM automatically verifies the status of the task. If the task is successful, CCM marks the task as Closed. The system notifies the requester that the change request has been resolved.

When the requester is notified of the status change, the requester can close the change request by setting the Confirm Resolution to Closed. If the requester does not close the change request, the request closes automatically after a preconfigured time. If the change request is part of a dependent sequence, the change manager for the next change request in the sequence is notified.

Step 5  **Review**—The change request enters the Review stage. Reviewers verify that the change request was indeed completed. They also might analyze key performance indicators (KPIs), for example, whether the change successful, or how many incidents were eliminated by the change request. Reviewers should also analyze the accuracy of the BMC Atrium CMDB.
Chapter 2

Working with the Requester Console

The Requester Console serves as the front end for the BMC Remedy Change Management and BMC Remedy Incident Management applications. It provides an easy, user-friendly interface that allows users to quickly submit requests for change or incidents to IT through the two back-end applications.

The following topics are discussed:

- Requester role (page 48)
- Service Request Management users (page 48)
- Understanding the Requester Console (page 50)
- Working with service requests (page 54)
- Working with service requests as the Request Master (page 65)
- Service Request form (page 72)
- Working with the Solutions database (page 75)
- Viewing broadcast messages (page 76)
Chapter 2—Working with the Requester Console

Requester role

Requesters are usually employees who need assistance from the IT support staff. The requester is typically an employee in the organization who needs to have a change implemented or an incident resolved. Any member of your organization can be a requester.

On the other hand, the user might not be an employee. Non-employees can also be requesters, since non-registered users can also submit a service request.

Traditionally, after a requester made a telephone call to a central help desk, a support staff member logged the request. The BMC Remedy Incident Management and BMC Remedy Change Management applications provide user self-provisioning. Using the Requester Console, requesters can submit, track, and (in some cases) resolve their own requests, and, as a result, improve the overall efficiency. Out of the box, the Change Management and Incident Management applications are preconfigured to work with the Requester Console. However, the Requester Console is not enabled if your organization turns off this option.

The Requester Console is the primary interface from where requesters can create and view their requests. From the Requester Console, you can create a request and submit it to the backend application, view previously created requests, and fill out a survey form after the request has been resolved.

Service Request Management users

There are currently three types of user permissions for accessing the Requester Console to submit service requests:

- **Request Master**—This user is responsible for troubleshooting service requests. The request master can view all the requests submitted by other users and open the Service Request form directly to view the details of a record. This user is more of an administrator, than a support user.

- **Registered user**—This user has a record in the People form, and the user’s AR login information is in the Login/Access Details tab of the People form or in the AR System User form.

- **Unknown user**—All other users are considered to be unknown users even if the user has a record in the People form. If a user’s login information doesn’t exist in the People record, then the user is considered a unknown user.
Important: For unknown users who do not have an AR System login to be able to access the Requester Console, the AR System server option “Allow Guest User” option must be turned on. The Allow Guest User option is available only when the server is set to single-tenancy mode. Also the AR Submitter locked mode must be enabled for users with read-only license to respond to surveys. The Incident Management and Change Management applications must also set up a default People record with a valid AR System login to be used for unknown users. For more information, see the *BMC Remedy IT Service Management 7.0 Configuration Guide*.

If a user meets any of the following conditions, the user type is “unknown user:”

- The user has an entry in the People form and the user has an entry in the AR System User form, but does not have an AR System Login ID in the People form.
- The user has an entry in the People form, but does not have an AR System Login ID, and the user does not have an entry in the AR System User form. This type of user is also an AR System Guest User.
- The user does not have an entry in the People form, but has an entry in the AR System User form.
- The user does not have an entry in the People form and in the AR System User form. This type of user is also an AR System Guest User.

Some other factors that control allowing unknown users access to the Requester Console follow:

- Unknown users are not allowed access if the multi-tenancy option is turned on. Multi-tenancy provides restricted access of data from different companies or business units. This feature makes it possible to host multiple companies and their data on a single server. Multi-tenancy is limited to the company level. Configuration can differ on a per-company basis. Multi-tenancy from the user’s perspective is accessed by selecting the appropriate company from the list next to the Company field.

The Tenancy Mode has to be set by a user with administrator and general access permissions on the System Settings form. For more information about ITSM foundation settings, see the *BMC Remedy IT Service Management 7.0 Configuration Guide*. 
In addition to setting the Tenancy Mode to Single-Tenancy, the Allow Unknown Users option needs to be set to Yes and the login information added. This is set by a user with Request Config permissions on the Application Settings form.

Unknown users are only allowed within the Requester Console framework, which means that if the Change or Incident form is directly accessed, it does not allow unknown users.

Understanding the Requester Console

The Requester Console serves as the front-end to the Change Management and Incident Management applications.

The console is the entry point for users to create, view, update, or cancel their own service requests. For more information about the Requester Console, see the following topics:

- Opening the Requester Console (page 51)
- Functional areas and tasks (page 52)
Opening the Requester Console

You can view the Requester Console through the BMC Remedy User client or through a browser. See the following instructions for information about opening the Requester Console.

► To open the Requester Console from BMC Remedy User

1 Log in to BMC Remedy User using your AR System Login information. Unknown or guest users need to log in using the default set up by their company.

2 From the IT Home page, click Requester Console. The Requester Console appears.

3 Create, view, modify, print, or cancel a request as needed. For more information, see “Working with service requests” on page 54.

► Using a browser to open the Requester Console

1 To open the Requester Console from a browser, type the following URL in to your browser’s address bar:

http://<web_server>:<port>/arsys/apps/<arsystem_server>/Home Page

<web_server> is the fully qualified name of the BMC Remedy Mid Tier system, specified in the format server_name.company.com.

<port> is an optional port number, which is needed if the web server is not on the default port (port 80).

<arsystem_server> is the name of your BMC Remedy AR System server.

For a list of supported browsers, see the compatibility matrix at:


2 Enter your user name and password, then click Login.

3 When the IT Home page opens, click the Requester Console link in the navigation pane.
## Functional areas and tasks

The Requester Console has the following functional areas:

<table>
<thead>
<tr>
<th>Console Area</th>
<th>Function</th>
</tr>
</thead>
</table>
| View Requests     | Use the View Requests links to filter the requests displayed in the Requests table. Requests can be sorted by the following options:  
|                   |   - Open                                                                   |
|                   |   - All                                                                    |
|                   | For more information, see “Filtering your service requests” on page 57.    |
| General Functions | Use the General Functions links to do the following actions:                |
|                   |   - Update the information in your requests, by creating a new work info entry. See “Modifying a service request” on page 59. |
|                   |   - Search for requests by Request ID. See “Searching for service requests by Request ID” on page 60. |
|                   |   - Save the console view.                                                 |
|                   |   - Work on a survey. See “Completing surveys” on page 62.                 |
| Request Errors    | If you have Request Master permissions, the Request Errors function appears in the navigation pane. For more information, see “Viewing requests with errors” on page 64. |
| Refresh button    | Refreshes the Broadcasts and My Requests tables. Click Refresh to refresh the data in the tables. |
| Broadcasts        | Displays broadcasts or bulletin board messages. The View button displays the selected broadcast in a dialog box, from where you can view details about the broadcast.  
|                   |   **Note:** No internal broadcast messages appear in the Requester Console. |
|                   | For more information, see “Broadcasting messages” on page 98.             |
### Console Area | Function
--- | ---
Create a New Request button | Click this button to display the New Request wizard, from where you can create a new service request. For more information, see “Creating a service request” on page 54.
My Requests | Displays the requests submitted by the logged in user. When performing Request form searches, only administrators and users who have Request Master permissions can view other users’ submitted requests.
Request Details | Displays details about the request that is selected from the My Requests table.
View button | Displays the record that is selected from the My Requests table. For more information, see “Viewing a service request record” on page 58.
Print button | Prints the record that is selected from the My Requests table. For more information, see “Printing a service request” on page 60.
Cancel button | Cancels the service request that is selected from the My Requests table. For more information, see “Canceling a service request” on page 61.
Reopen button | Lets you reopen requests that are Completed or Rejected. For more information, see “Reopening a request” on page 61.
Close button | Closes the console window.
Working with service requests

The following section describes how to work with service requests. The following topics are provided:

- “Creating a service request” on page 54
- “Filtering your service requests” on page 57
- “Viewing a service request record” on page 58
- “Modifying a service request” on page 59
- “Printing a service request” on page 60
- “Canceling a service request” on page 61
- “Reopening a request” on page 61
- “Completing surveys” on page 62

Creating a service request

You can create service requests from the New Request wizard, which is the only way to create a service request. The New Request wizard is a simplified user interface for submitting your service requests. You can also create service requests from the Change and Incident forms.

A user with Request Master permissions can directly open the SRM:Request form from the File > Open > Object List menu to view service requests. However, service requests cannot be created from the SRM:Service Request form.

For more information about the Service Request form and the role of the Request Master, see “Working with service requests as the Request Master” on page 65.

To create a service request

1. From the Requester Console, click Create a New Request.

The New Request wizard appears.
Working with service requests

Pay careful attention to the following items for the Requester section:

- If you are a registered user, the fields in the Requester section are populated from the user’s People record. All the fields are read-only, except the Phone and Email fields, which are editable.
- If you are an unknown user, the First Name and Last Name fields are pre-populated with their login information. The Company is pre-populated with the single-tenancy company name. Unknown users must enter information in the Phone and Email.

2 Fill in the required fields:

**Note:** Required field names are in bold with an asterisk. You must enter information in the required fields to be able to successfully submit the request.

- Select a definition from the Summary list that best describes your issue from the Summary list.
If the list does not list the specific request you want to log, enter a summary of the request manually in the Summary field.

**Note:** Manually entering a summary or “ad hoc request” always creates an incident request if Incident Management is installed. If Incident Management is not installed, a change request is created.

If you select a summary definition that is an incident, then related solution database entries appear in the Possible Solutions table, based on the categorization of the summary. Possible solutions do not appear for manually entered summaries.

**Important:** The Possible Solutions table appears only if the Problem Management application is installed.

If a matching solution appears and you choose to use this solution, the solution entry is related your request and the request is resolved automatically. See “Working with the Solutions database” on page 75.

b Select an Urgency level for your request from the list.

c If you don’t have a record in the People form, then the Company, First Name and Last Name fields might not be populated, but these are required fields.

3 (Optional) Click Add Attachment to enter request work information.

You can include a note or an attachment. For more information about the Request Work Info dialog box, see “Modifying a service request” on page 59.

4 Fill in the optional fields:

- **Date Required**—Enter a date by when you require that this request be completed.
- **Phone**—Enter or edit your phone number.
- **Email**—Enter or edit your email address.

**Note:** Unknown users must enter information in the Phone or Email fields.
5 Click Save to save the request.

The New Request wizard closes, and the request you just saved is displayed in the My Requests table.

Service request states

For changes and incidents, the My Request table console lists the status of its underlying service request. Users are notified whenever a service request undergoes a status change, for example, when a service request is moved from In Progress to Completed after an incident or a change request reaches the Completed state.

The notification method is always by email.

Filtering your service requests

When registered and unknown users access the Requester Console, they can see a list of only their own service requests.

To filter your service requests

1 Open the Requester Console, as described in “Opening the Requester Console” on page 51.

2 Filter your service requests by clicking the appropriate link from the View Requests section, located on the left navigation pane of the Requester Console.

The options are:

- **Open**—Displays all your open requests.
  This is the default view. You can choose to change the default view by selecting another sort option, then clicking Save As Default View.

- **All**—Displays all your requests.

The My Requests table displays the requests that fall under the selected status.
Viewing a service request record

From the Requester Console, you can view the service requests that you have submitted. The My Requests table displays only the requests that the logged in user has submitted. Change requests are prefixed with CRQ and Incident requests are prefixed by INC.

To view a service request record

1. Open the Requester Console, as described in “Opening the Requester Console” on page 51.
2. If necessary, sort the service requests to display the ones that you want to view, as described in “Filtering your service requests” on page 57.
3. From the My Requests table, select the service request record that you want to view.
4. View some details of the record in the Request Details section of the console.
5. Click View to display the record.

- To update the service request, see “Modifying a service request” on page 59.
- To print the service request record, see “Printing a service request” on page 60.
- To cancel a submitted service request, see “Canceling a service request” on page 61.
6. Click Close.
Modifying a service request

There are limited updates you can make to your service request after you have submitted it. You can make only the following changes:

- **Cancel the request**—See “Canceling a service request” on page 61.
- **Update the work information**—See “To update the work information of a service request” on page 59.
- **Reopen the request**—You can reopen a service request, but only when it is advanced to a certain state. For information, see “Reopening a request” on page 61.

To update the work information of a service request

1. Open the Requester Console, as described in “Opening the Requester Console” on page 51.
2. From the list of your requests displayed in the My Requests table, select the record that you want to modify.
3. Do one of the following steps:
   - Click the Add Work Info link from the Console Functions section on the left navigation pane.
   - Click View, click the Work Info tab, and then click Add Work Info.

The Request Work Info dialog box appears.

![Request Work Info dialog box](image)

4. Enter a summary of the work log in the Summary field.
5 Optionally, you can do the following steps:
   a Enter additional information in the Notes field.
   b Add an attachment. You are limited to one attachment for each work
      information entry. If you must add multiple attachments, you can add
      multiple work information entries.
6 Click Save.

Searching for service requests by Request ID

You can quickly search for a service request by its Request ID.

▶ To search by Request ID
   1 Open the Requester Console, as described in “Opening the Requester
      Console” on page 51.
   2 Click Search by Request ID.
   3 Enter the complete Request ID or the numeric part of the ID.
      The matching request is displayed in the My Requests table.

Printing a service request

To enable the print functionality, be sure to follow steps 1 through 4.

▶ To print a service request
   1 Log in to BMC Remedy User with your server name in the Preference Server
      field.
   2 Choose Tools > Options.
   3 On the Options dialog box, click the Advanced tab.
   4 Make sure that ODBC Use Underscores is checked.
   5 Open the Requester Console, as described in “Opening the Requester
      Console” on page 51.
   6 Select the record you want to print from the My Requests table.
   7 Click Print.
      The report appears in the Report Preview window.
   8 Review the report, and then click the Print icon on the toolbar.
Canceling a service request

You can only cancel a service request that is open. You cannot reopen a canceled service request until it reaches the Completed or Rejected state.

To cancel a service request

1. Open the Requester Console, as described in “Opening the Requester Console” on page 51.
2. If necessary, sort the displayed requests to show all Open requests, as described in “Filtering your service requests” on page 57.
3. Select the service request record that you want to cancel.
4. Click Cancel.
   You are prompted if you are sure you want to cancel the request.
5. Click Yes.
6. Refresh the My Requests table, if necessary, to view the status of all your service requests.

Reopening a request

You can only reopen requests that are Completed or Rejected.

To reopen a request

1. Open the Requester Console, as described in “Opening the Requester Console” on page 51.
2. If necessary, sort the displayed requests to show all Open requests, as described in “Filtering your service requests” on page 57.
3. Select the service request record that you want to reopen.

Note: The Cancel button changes to Reopen when you select a rejected or completed record.
4 Click Reopen.

**Note:** You can only reopen records that are in completed or rejected state.

The following note appears: The selected request has been reopened.

5 Click OK to dismiss the note.

The request now appears as In Progress or Open. The status shown depends on whether the request is a change or an incident

**Completing surveys**

You are notified through email to respond to a survey after your service request is marked Completed. Each service request generates a separate survey.

**Note:** Surveys must be set up for your company and the option must be turned on. If surveys are not set up and the survey option is not turned on, no surveys are generated.
To complete a survey

1. Open the Requester Console, as described in “Opening the Requester Console” on page 51.

2. Click View Survey.

   The Survey dialog box appears.

   ![Survey dialog box](image)

3. Select a survey, and then click Respond.

4. Type your responses to the questions.

   ![Requester survey](image)

5. Click Save.
Viewing requests with errors

If you have Command Event Master and Request Master permissions, you can view which service requests contain errors, for example, if there is a problem with a backend application.

To view requests with errors

1. Open the Requester Console, as described in “Opening the Requester Console” on page 51.

2. Choose Request Errors > View Requests with Errors, located on the left navigation pane of the Requester Console.

The Service Request form opens. It displays those service requests that contain errors of various types.

3. To view the error status and its possible source, click the Change/Incident Data tab.
4 If you have Command Event Master permissions, click Reset Error to restart the service request.
Users can now continue to work on the service request.

5 If you have Command Event Master permissions, click View Events to review the event log and troubleshoot the service request.
For more information, see “Viewing the event log and troubleshooting” on page 71.

6 Save any changes.

Working with service requests as the Request Master

Only users with Request Master permissions can access the Service Request form directly. All other users need to use the New Request wizard to create service requests.

The Service Request form is accessed by the Request Master users to troubleshoot system errors. See “Opening a Service Request record” on page 66. See also “Service Request form” on page 72 for information about the Service Request form.

Request Masters can do the following actions with the Service Request form:

- Add Work Info entries for service requests—See “To view or add work information” on page 68.
- Use the accelerator links on the navigation pane to reopen a request, cancel a request, and so on—See “Canceling a service request” on page 61 and “Reopening a request” on page 61.
- View the event log if a service request event has failed or is in error state, and either retry the event or ignore the event—“To view the event log” on page 71.

Note: The Request Master user must have Request Master permissions.

Request Masters, however, cannot directly update any other form fields. Only users with AR System Administrator permissions are allowed to delete service request records.

Important: Delete service requests with caution. They cannot be recovered.
Opening a Service Request record

**Note:** Only Request Masters can directly access the Service Request form. This user needs Request Master and Command Event Master permissions.

![Service Requests form](image)

**Figure 2-9: Service Requests form**

**Note:** Request Masters can view records that they have access to, granted by company access in the People form. Request Masters with unrestricted access (that is, they have access to all companies) can view all service requests, as can the AR System administrator.

To open a service request record:

1. Log in to the AR System.
2. Choose File > Open > Object List.
3. Click the Find tab on the Object List dialog box that appears.
4. Enter Service Request in the Search what keywords? field, and then click Find.
5 Select the service request entry, and click Search.

**Note:** New service requests are created from the Service Request console, using the New Request wizard. If you try to select the service request entry and click New, you get an error message.

The Service Requests form appears in Search mode. For more information about the service request form, see “Service Request form” on page 72.

6 Enter search criteria, and then click Search.

7 Select the service request record you want to view or troubleshoot from the search results.

8 Follow these steps as needed:
   - “Reopening a request” on page 67
   - “Viewing or adding Work Info” on page 68
   - “Viewing the event log and troubleshooting” on page 71

9 Click Save.

**Reopening a request**

You can reopen a completed or rejected request. You can cancel a Pending, In Progress, or Staged request.

▶ **To reopen or cancel a request**

1 Complete steps 1 through 7 from the procedure “To open a service request record” on page 66.

2 On the appropriate record, take the appropriate action:
   - Click Reopen Request if you must reopen a completed or rejected request.
   - Click Cancel Request if you must cancel a request.

**Note:** The appropriate action link is enabled, depending on the state of the service request.

The service request shown has a Status of Completed, so the Reopen Request link is enabled.
Click OK to dismiss the confirmation message.

- If you clicked Reopen Request, the Status changes to New, Staged, or In Progress.
- If you clicked Cancel Request, the Status changes to Canceled.

4 Click Save to save your changes.

Viewing or adding Work Info

You can quickly add to the Work Info dialog box of an existing service request by clicking View Work Info or Add Work Info from the left navigation pane.

To view or add work information

1 Do steps 1 through 7 from the procedure “To open a service request record” on page 66.

2 Click the appropriate link:

- **View Work Info**—Displays the Request Work Info dialog box and existing work information. Select the entry in the History table that you want to view, and view its details. (The View Work Info link is enabled only if there is existing information for the selected record.)
Working with service requests as the Request Master

Figure 2-11: Request Work Info dialog box

- **Add Work Info**—Displays the Request Work Info dialog box and allows you to add information.
  
  See “Adding or viewing work information from a service request” on page 69.

3 Click Save to save your changes.

**Adding or viewing work information from a service request**

The Request Work Info dialog box has a different view when the Request Master opens it from the Service Request form than when the user accesses it from the Requester Console.

To add or view work information from the Request Work Info dialog box

1 Complete steps 1 and 2 from the procedure “Viewing or adding Work Info” on page 68.

The Work Info form appears. It looks slightly different, depending on whether you clicked View Work Info or Add Work Info.
2 View or add information to the fields (field names in bold with asterisks are required fields):

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date+</td>
<td>Date and time when work information was created.</td>
</tr>
<tr>
<td>Source</td>
<td>Where work information came from, for example, Email, Web, or some other source.</td>
</tr>
<tr>
<td>Summary</td>
<td>A brief description of the Work Info entry. This character field contains a maximum of 100 characters.</td>
</tr>
<tr>
<td>Notes</td>
<td>A more complete description of the Work Info entry.</td>
</tr>
<tr>
<td>View Access</td>
<td>Sets the View Access to the work information.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Public</strong>—Lets the requester view the work information.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Internal</strong>—Only the request master can view the work information.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Includes any attachments that pertain to the Work Info entry. Only one attachment can be added per Work Info entry.</td>
</tr>
<tr>
<td>Submitter</td>
<td>System-generated field containing the login name of the person who submitted the Work Info entry.</td>
</tr>
<tr>
<td>Submit Date</td>
<td>System-generated field that contains the date the Work Info entry was created.</td>
</tr>
</tbody>
</table>

3 Click Save.
Viewing the event log and troubleshooting

If the service request cannot be completed because of an error from the backend application, you can review the event log and troubleshoot the service request. Overall event status is indicated by the App Event Status on the Change/Incident Data tab.

**Note:** You need Command Event Master permissions in addition to Request Master permissions.

▸ To view the event log

1 Complete steps 1 through 7 from the procedure “To open a service request record” on page 66.

2 Click View Events.

   The Event History dialog box appears.

**Figure 2-13: Event History dialog box**

3 View the event details:
   - Protocol
   - Access Mode
   - Error Code
   - Error Message
4 Take any of the following actions for events that are in error:

- Retry
- Ignore

It is best to retry each event in the order the events are created. By default, the event table is sorted with the recent event on top, in reverse chronological order. Typical events should be retried when the problem indicated by the error message has been fixed.

5 Click Close.

Service Request form

Only users with Request Master permissions can open the Service Request form directly and perform certain actions. For more information, see “Working with service requests as the Request Master” on page 65.

**Note:** You cannot create a service request from this form.

This section describes the form fields for reference.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Summary    | Summary of the request. This is populated from the New Request wizard. Requesters can select a summary definition from the Summary list. This list displays a list of summary definitions that have a status of Active. Selecting a summary value from the Summary list automatically fills in data for the following fields: Category Tiers, Service Type, and Impact. Users can also enter data in the Summary field without making a selection from the Summary list. If summary data is typed in, the following values are set:  
  - Categorization Tiers 1 through 5 = NULL  
  - Impact = 3-Moderate/Limited  
  - Service Type = User Service Request  
  **Note:** Categorization data is mapped in the Operational Catalog Setup form. |
### Field Name Description

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request ID</td>
<td>A unique identifier for the service request. User-defined prefixes are not supported. After a service request is submitted from the New Request wizard and the appropriate backend application entry is created, the service request Request ID is updated with the backend application’s Request ID. This provides consistent IDs for reference across the Requester Console and the backend application.</td>
</tr>
<tr>
<td>Category Tiers</td>
<td>Classification of the request based on the Summary. If the user does not select a summary from the preconfigured summary list, the value is set to NULL.</td>
</tr>
<tr>
<td>Request Type</td>
<td>This value is derived from the selected summary definition (each summary definition has been mapped to an appropriate request type, either change or incident). If the user does not select a summary from the preconfigured summary list, the value is set to Incident. If only Change Management is installed, the value is set to Change.</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact of the request based on the selected summary definition. If the user does not select a summary from the preconfigured summary list, the value is set to 3•Moderate/Limited. This setting indicates the impact to IT operations, not the impact to the user requester.</td>
</tr>
<tr>
<td>Urgency</td>
<td>The importance of the service request to the requester:</td>
</tr>
<tr>
<td>Date Required</td>
<td>The date by which the requester requires the service request be completed.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the service request. This is a system field (Field ID 7). All of the state transition data for SRM:Request is stored in the SYS:Status Transition form. Whenever the service request Status data is changed, SRM:Request Form workflow retrieves the appropriate entry from the SYS:Status Transition Lookup form for the previous state and current state and determines if the transition is valid.</td>
</tr>
</tbody>
</table>

**Note:** This field is for informational purposes; there is no service level workflow related to this field. The only workflow associated with this field is that an error is displayed if the Required Date is set to a date earlier than the current date.
Chapter 2—Working with the Requester Console

BMC Remedy Change Management 7.0

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Reason</td>
<td>A further description of the Status.</td>
</tr>
<tr>
<td>Date Submitted</td>
<td>The date and time the service request was submitted. This is a system-generated field.</td>
</tr>
<tr>
<td>SLA Responded</td>
<td>Service level data pushed from back-end SLM forms. If set to Yes, change request must be responded to. This is particularly important in the case of a response-time goal, where a blank SLA Responded field might indicate that the service target goal has been missed. Not applicable if SLM is not installed.</td>
</tr>
<tr>
<td>Requesters tab</td>
<td>The two tabs, Requested For and Requested By/Service Location, contain the same information, or information of the user who submitted the service request. Requested By/Service Location data is automatically copied to the Requested For fields based on the type of Submitter. If the Submitter is an Unknown User (a user who is not registered in the People form with an AR System Login and People ID), the Submitter’s data is copied to the Requested For fields. The Requested By fields are set to default user data set in Application settings. If the Submitter is not an Unknown User (the user is registered in the People form with an AR System Login and People ID), the Submitter’s data is copied to the Requested For as well as the Requested By fields. Only service requests for individuals are supported, so the Add Request For field is automatically set to Individual.</td>
</tr>
<tr>
<td>SLM tab</td>
<td>Displays the service targets and milestones for the restoration of the unavailability. Service targets and milestones are defined from within the Service Level Management applications. Escalations can be set up to notify the assignment group prior to acknowledgement or resolution breach times.</td>
</tr>
<tr>
<td>Change/Incident Data tab</td>
<td>Provides information from the backend application for the service request record. The actual backend Change or Incident request information is displayed.</td>
</tr>
<tr>
<td>Manager tab</td>
<td>Provides manager information for the service request record. This value is pushed from the change or incident and indicates the owner of the request. This person is notified if the SLA is breached. The service request itself does not populate this field.</td>
</tr>
<tr>
<td>Work Info tab</td>
<td>Displays work information for the service request record.</td>
</tr>
</tbody>
</table>

74 Chapter 2—Working with the Requester Console
Working with the Solutions database

If you are creating a service request that falls into the request type of Incident, you might be able to resolve the request immediately if a valid solution exists in the solution database. After you select a summary, possible solutions appear only if they exist in the solution database under the same category.

**Note:** The Solutions table only appears if Incident Management and Problem Management are installed. If you have only Change Management installed, this table does not display.

To resolve an incident request by using the Solutions database

1. Open the Requester Console, as described in “Opening the Requester Console” on page 51.
2. Click Create a New Request.
   The New Request wizard appears.
3. Select a Summary that can be classified as an incident.

**Figure 2-14: Possible Solutions entry**
If there is a solution database entry that matches the summary definition, it appears in the Possible Solutions table.

4. If the solution entry appears to be valid, select the entry and then click View.

5. Review the solution entry.

6. If the solution entry resolves your request, click Use Solution.

   The following AR Note appears:
   
   Your request has been submitted and will be marked Resolved.

7. Click OK to dismiss the note.

   The request appears in the My Requests table as Resolved.

**Viewing broadcast messages**

Broadcasts (or bulletin board messages) are displayed in the Broadcasts table. Broadcasts are filtered by the logged-in user’s company, based on the following criteria:

- Broadcasts that are defined for the logged in user’s company
- If the logged-in user’s company cannot be determined, then only Global broadcasts are displayed.
- Only broadcasts defined for the Global company are shown to guest users, whose company cannot be determined.
- Only “Public” broadcasts are shown to the requesters.

The View button opens the Broadcasts form in dialog mode, where you can see details of the broadcasts, depending on your permissions. If you have sufficient permissions on this form, you can create, modify, or delete broadcasts.

For more information about working with broadcasts, see “Broadcasting messages” on page 98.

➤ **To view broadcasts from the Requester Console**

1. Log in to the Requester Console.

2. View the broadcasts displayed in the Broadcasts table.

3. To refresh the list of broadcasts, click the Refresh button above the table.

4. Select a broadcast entry, and click View to view more details.
The support staff consists of service desk professionals who create, plan, schedule, monitor, and implement change requests and tasks using Change Management.

The following topics are discussed:

- Working as support staff (page 78)
- Opening a main ITSM application console (page 80)
- Opening the Overview Console (page 82)
- Working with requester records (page 90)
- Viewing application preferences and options (page 94)
- Broadcasting messages (page 98)
- Working with table data (page 103)
Working as support staff

There are four main support roles: change manager, change assignee, change implementer, and task implementer. The change manager is usually responsible for creating and managing the change request; the change assignee is usually responsible for planning and implementing assigned changes; the task implementer is usually responsible for carrying out the tasks that comprise the change request. Change implementers are assigned to work only on taskless change requests.

This section provides an overview of these support roles and describes information that is common to them.

Change manager

A change request can be created by either a requester using the Requester Console application or the change manager using the Change Management application. After the change request is created, the request is automatically assigned to the appropriate change manager (a group or person) based on the organization’s support staff groupings and categorization of the change request. Change managers are notified of changes assigned to them by email, pager, or BMC Remedy Alert.

The change manager is responsible for accepting change request assignments and for planning the change request. Planning activities include identifying, creating, and assigning the tasks that must be performed to accomplish the change, determining the impact by assessing the different kinds of risks, and writing plans.

If approval is required, the change manager must initiate the approval process and, when it is finished, move the change into the implementation phase. The change manager monitors the progress of the change.

For information about the change manager’s specific responsibilities, see “Working as a change manager” on page 296.
Change assignee

Change assignees are support staff members with specialized abilities who handle the actual details of the change request. In large companies, the change manager would be responsible for the overall change such as scheduling, but the change assignee would perform the day-to-day management of the change request process, for example, building and reviewing change plans, managing the change implementer, making sure that the change proceeds in a timely fashion, and so on. The change assignee has permissions and capabilities similar to those of the change manager in managing changes and tasks.

For information about the change assignee’s specific responsibilities, see “Working as a change assignee” on page 144.

Change implementer

Change implementers are support staff members who work only on changes that have no tasks. For more information, see “Assigning changes to change implementers” on page 174.

Task implementer

Task implementers are support staff members who perform the tasks associated with a change request. For example, a change request for ergonomic assessment of an employee’s work space could comprise these tasks:

- Performing the ergonomic assessment
- Ordering a new chair and mouse

Each task can be tracked and monitored separately from the other tasks. For example, different task implementers can be assigned to work on different tasks, and the Task Work Info tab contains information relevant to the task.

When a change manager assigns tasks, the task implementers are notified of tasks assigned to them by email, pager, or BMC Remedy Alert. After a task is assigned, task implementers can log their progress as they complete the task.

When all the tasks of a change request are closed, the change request is automatically marked as Completed.

For information about the task implementer’s specific responsibilities, see “Task implementer role” on page 327.
Opening a main ITSM application console

You start an ITSM application by opening its main console. How you do this depends on whether you want to view the console through the BMC Remedy User client or through a browser. See the following instructions for information about opening the main console.

Using BMC Remedy User client to open a main console

This section describes how to open an application’s main console from the IT Home page, using BMC Remedy User.

To open the application’s main console from BMC Remedy User

   The Login dialog box appears.

2. Follow these steps:
   a. In the User Name field, type your user name.
   b. In the Password field, enter your password.
   c. In the Preference Server field, specify the server name if your administrator set up a preference server for centralized user preferences. For example, if you have report server from which you can access predefined reports, you specify it here.

3. Click OK to log in.
   The Home Page form opens automatically. If it does not, perform these steps in BMC Remedy User:
   a. Choose Tools > Options.
   b. In the Options dialog box, click the Home Page tab.
   c. Select the check box to open the home page automatically.
4 When the IT Home page opens, click the BMC Remedy Change Management console link in the navigation pane.

Figure 3-1: IT Home page

Using a browser to open a main console

This section describes how to open the application’s main console from a browser.

▶ To open the application’s main console from a browser

1 To open the main console from a browser, type the following URL in to your browser’s address bar:

   http://<web_server>:<port>/arsys/apps/<arsystem_server>/Home Page

   <web_server> is the fully qualified name of the BMC Remedy Mid Tier system, specified in the format server_name.company.com.

   <port> is an optional port number, which is needed if the web server is not on the default port (port 80).

   <arsystem_server> is the name of your BMC Remedy AR System server.
For a list of supported browsers, see the compatibility matrix at:

2 Enter your user name and password, then click Login.

3 When the IT Home page opens, click the BMC Remedy Change Management console link in the navigation pane.

Opening the Overview Console

The Overview Console is the primary interface for support staff. It provides quick access to the information you need and to the procedures that you perform most often.

Figure 3-2: BMC Remedy IT Service Management—Overview Console
The Overview Console is useful for looking at different types of requests assigned to the same person. The Overview Console gives you a way to view requests in one console without opening multiple windows.

This section discusses how to use the Overview Console.

To open the Overview Console in Windows
1. Open BMC Remedy User as described in “Using BMC Remedy User client to open a main console” on page 80.
2. On the Home Page form, under the Foundation Elements heading, click the Overview Console link.
   The Overview Console appears.

To open the Overview Console in a browser
1. Launch your browser as described in “Using a browser to open a main console” on page 81.
2. On the Home Page form, under the Foundation Elements heading, click the Overview Console link.
   The Overview Console appears.

Assigned Work table

The Assigned Work table lists different types of requests. The types of requests that you can choose from depend on the BMC Remedy applications that are installed.

Each type of request is identified by a specific prefix:

- **CRQ**—identifies change requests. BMC Remedy Change Management must be installed for you to be able to create and view change requests.
- **TAS**—identifies tasks.
- **SDB**—identifies solution database entries. BMC Remedy Problem Management must be installed for you to be able to create and view solution entries.
- **INC**—identifies incidents. BMC Remedy Incident Management must be installed for you to be able to create and view incidents.
- **PBI**—identifies problems. BMC Remedy Problem Management must be installed for you to be able to create and view problems.
Chapter 3—Introducing the support roles

- **PKE**—Identifies known errors. BMC Remedy Problem Management must be installed for you to be able to create and view known errors.

- **PR**—Identifies purchase requisitions. BMC Remedy Asset Management must be installed for you to be able to create and view purchase requisitions.

You can change the table’s contents by using the Company filter and the Console View fields at the top left corner of the console.

You can use the following fields to filter out which requests you see.

- **Company**—Shows requests for a particular company. This field is especially useful in a multi-tenancy environment.

- **Personal**—Shows all the requests that are assigned to you.

- **Selected Groups**—Shows all the requests that are assigned to your support group.
  - **Show All**—Shows all requests.
  - **Show Unassigned**—Shows all the requests that are unassigned.

- **All My Groups**—Shows all the requests that are assigned to all support groups that you belong to. If you belong to more than one support group, the requests for all those groups are displayed.
  - **Show All**—Shows all requests.
  - **Show Unassigned**—Shows all the requests that are unassigned.

In the Windows environment, if there are more entries than the system can show in the table, you can see the next grouping of entries by placing the pointer in the table and right-clicking, then choosing either Next or Prev. When using a browser, use the arrow keys at the top corner of the table.

You can create new entries by clicking the Create button that appears below the table. For information, see “Creating requests” on page 85.

You can view requests and refresh the Assigned Work table. For more information, see “Working with table data” on page 103.

There are also helpful quick actions you can perform with records that are displayed in the Assigned Work table, for example, printing. For more information, see “Quick Actions” on page 89.
Viewing requests

You can view requests from the Overview Console. The types of requests you can view from the Overview Console vary, depending on the applications you have installed.

To view requests

1 Open the Overview Console.
2 Select a request from the Assigned Work table.
3 Click View.
   The request appears in the application in Search mode. For example, if you selected a change request, the request appears in the Change form.

Creating requests

From the Overview Console, you can create new records for the various ITSM applications installed on your system. The types of requests you can create from the Overview Console depend on the applications you have installed.

To create requests

1 Click Create.
   The Select Request Type dialog box appears.

Figure 3-3: Select Request Type dialog box

Note: The available request types depend on which ITSM applications are installed on your system.

2 Select a request type of Infrastructure Change.
3 Click Select.
   The application appears in New mode.

4 Enter all the required information to create the request.
   For more information about change requests, see “Creating change requests—Basic steps” on page 162.

**Searching for requests**

From the Overview Console, you can search for records from the various ITSM applications installed on your system. The types of records you can search for depend on the applications you have installed.

➢ To search for requests
   1 Click Search.
      The Select Request Type dialog box appears.
   2 Select a request type.
   3 Click Select.
      The application appears in Search mode.
   4 Enter search parameters as needed to search for the request.
      For more information about change requests, see “Viewing, creating, and modifying change requests” on page 160. For more information about tasks, see “Working with tasks” on page 213.

**Resetting data**

After you create or modify a record, click Set to Defaults to see the latest changes in the Assigned Work table. For more information, see “Working with table data” on page 103.

**Broadcast messages**

Use the Broadcast feature, on the lower portion of the console, to view and create messages that can be viewed by the entire organization or by users in the support, approver, management, and administrator groups.
For more information, see “Broadcasting messages” on page 98.

Using the navigation pane

The pane on the left side of the console is the navigation pane.

Using Console View

The links under Console View help you filter records that appear in the Assigned Work table. See “Assigned Work table” on page 83 for more information about using the Console View functions.

Using Console Functions

Console Functions contains links to define which requests you view.

- **Select Status Values**—Lets you display only those records in a certain state, for example, All Open Incidents. For information, see “Selecting Status Values” on page 88.
- **My Profile**—Allows you to set your profile. For information, see “Viewing your profile” on page 88.
- **Application Preferences**—Allows you to set your application preferences and options. See “Viewing application preferences and options” on page 94.

Using other applications

The navigation pane of the Overview Console also contains links to view additional applications that you have access to:

- **Incident Management**—Opens the Incident Management console.
- **Change Management**—Opens the Change Management console.
- **Problem Management**—Opens the Problem Management console.
- **Asset Management**—Opens the Asset Management console.
Approval Console—Opens Approval Central so that you can view all requests pending approval.

CMDB—Opens the CMDB Class Manager Console.

SLM—Opens the SLM Console.

The links that are displayed in the navigation pane are determined by the applications that are installed in addition to BMC Remedy Change Management.

Selecting Status Values

The Select Status Values dialog box lets you filter the requests that appear in the Overview console based on their status. Use the following procedure to open and use the Select Status Values dialog box.

To select status values

1. From the Overview console, click Select Status Values.
   The Select Status Values dialog box appears.

2. Select the status values for each category from the lists.

3. When you finish selecting the values, click Select.
   The dialog box closes.

4. If the Assigned Work table does not refresh with the filtered records, click Reset to reload the table’s contents.

Viewing your profile

You can view and edit your personal profile. When you click My Profile, the People (Search) form appears. In this form, you can:

- Update company information, such as organization, business, and home address, and so on.
- View permissions.
- View non-support staff profiles.

For detailed information about the People form, see the BMC Remedy IT Service Management 7.0 Configuration Guide.
To edit your profile
1 Click My Profile.
   The People (Search) form appears.
2 Update the information at the top of the form, or click the tab corresponding to the area in which you want to change the profile information.
   Make your changes by selecting from the various lists that are available.
3 When you finish making the changes, click Save.
4 Click Close to close the form.

Quick Actions

The Overview Console lets you perform certain quick actions on the records. Select the action and then click Execute.

- Print—Lets you select records and print their contents. For more information, see “Printing change requests” on page 122.
- Home Page—Opens the IT Home Page.

Help

The Help button is located in the top right corner of the console. Click the Help button to access help.

Refreshing record status

The Refresh button is located in the top right corner of the console. Click the Refresh button after making changes to view updated status of records.

Auto-filling fields

As you work with the forms and dialog boxes, you might see a plus sign (+) included in a field label. You can type part of the information in these fields and press ENTER. If an exact match is located, the system automatically completes the field. If a selection list appears, double-click on the item you want to put in the field. Using auto-fill fields and lists is faster, more consistent, and more accurate than typing the information.
Working with requester records

When you create new change requests or monitor existing requests, you frequently work with requester information. For example, you might need to search for a requester in the database. If the requester does not yet exist, you must create a new requester. Or, you might need to change existing requester information.

The People form contains all BMC Remedy Change Management application user records. You can access this form in different ways:

- Select People on the Application Administration Console.
- Select View My Profile on the Overview Console or the Change Management Console. You then can see your own user record.
- Click in the Last Name field on a form or dialog box, enter partial information you might know about the individual you are looking for, and then press ENTER.

Information stored here is used to automatically fill in requester information fields in many forms. For more information, see the BMC Remedy IT Service Management 7.0 Configuration Guide.

Creating a requester record

While creating a new change request or task, you might find that the requester does not yet have a record in the database. If this is the case, you must create a record for the requester. You can do this while you are creating the change request or task.

To create a requester record

1. From the IT Home page, click Application Administration Console.
   
   The Application Administration Console appears.

2. Choose Foundation > People > People.
   
   The People form appears.
Complete all the required fields:

- **First Name**—Enter the requester’s first name.
- **Last Name**—Enter the requester’s last name.
- **Client Type**—Select Operating Company, Customer, or Vendor.
- **Profile Status**—Set the Status to Enabled (or other option, as needed).
- **Client Sensitivity**—Select Standard or Sensitive.
- **VIP**—Select Yes or No to indicate the person’s appropriate status.
- **Support Staff**—Select Yes or No to indicate if the requester is a support staff member.
- **Company**—Select access data for one company but not another, based on the companies to which they are assigned. The Company field controls access when configuring people.
- **Business**—Enter a business phone number. You should also enter an email address.

Optionally, complete the remaining fields, including fields on the other tabs.

Click Save.

A message indicates that the record for that person has been created.
Searching for a requester

If you are not certain whether a requester already has an existing record in the People database, you can perform a search. You can view the requester’s record and, if necessary, modify it. You can perform the following procedure from any form that has a Login Name or Name field.

To search for a requester

1. Open the People form in Search mode.
2. Click in the First Name or Last Name field, and enter partial information you might know about the individual you are looking for.
   For example, if you know the requester only by their first name, you can enter only the first name. You can also enter a letter, for example, A, in the Last Name field.
3. Without moving your cursor from the field, press ENTER.

   Note: The plus sign (+) beside certain fields indicates that there is workflow that acts on the field when you press the ENTER key when you place the cursor in the field.

The People form is displayed. The Search Results table shows the matching records.
Working with requester records

The Search Results table shows the matching records.

4 To view a record, double-click it.
5 To make changes, update the appropriate fields and click Save.
6 Close the People form when you are finished.

Modifying requester information

If the requester’s information changes, you can update it. You can do this in the Person Information form.

To modify requester information

1 Open the Person Information form in one of these ways:

- Enter the requester’s name in the Last Name field on a form, and press ENTER. For example, if you are creating a change request in a New Change form, you can enter the requester’s name in the Last Name field, and press ENTER.

- Search for the requester in the People Search dialog box. Select the requester’s record and click View.

The Person Information form is displayed. It contains the requester’s information.
2 Update the applicable fields.
3 Click Save.
   A message informs you that the record was modified.
4 Click Close to close the form.

Related topics:
- “Creating a requester record” on page 90
- “Searching for a requester” on page 92

Viewing application preferences and options

When you click Application Preferences, you can view and edit the settings that affect the default appearance of Change Management’s main console. Depending on which applications you have installed, you can also view their preferences and options.

Figure 3-7: Application Preferences form
When an application opens, you can determine:

- Default console view.
- Forms that appear.
- Search criteria defaults.
- What happens after a request is saved.
- What is displayed in the Overview Console.
- Change statistics.

**Note:** For the changes to take effect, you must close the application, then log in again.

### Setting Create Request and Search for Request action preferences

You can specify which form appears when you create a new request or start a search.

**To set Create Request and Search for Request action preferences**

1. From the Overview Console, click Application Preferences.
   The Application Preferences dialog box appears.
2. Click Change Management.
3. In the On Form Open area for the console page, define the following options:
   - **Manager Console**—Choose if the manager console appears.
   - **Support Console Main Table**—Choose if changes or tasks appear in the main table on the Support console.
   - **Data Set Name**—Choose a personal preference data set, for example, BMC Asset. For more information about how this data set is used, see “Relating CIs to alternate data sets” on page 256.
4 In the Search Criteria Default area for the console page, define the following options:

- **Change Status**—Choose the status of the changes that appear in the Change Management console.
- **Role**—Choose which role is used to search for changes.
- **Task Status**—Choose the status of the tasks that appear in the Change Management console.

5 In the After New Save area for the form, define what action takes place after you save a new change request.

The options are:

- **No Action**—Leaves the Change form open and it is ready for you to record a new change request.
- **Reopen in New**—Opens the current change in modify mode in a new window. The original window is ready for you to record a new change request.
- **Reopen in Current**—Leaves the Change form open. If this is a new change request, the form changes from New to Modify.

6 For Tab Views, define if you want to show the Approvers or the Financials tabs.

7 In the Overview Console area, define the following options:

- **Show Change**—Choose Yes if you want to show changes.
- **Show Task**—Choose Yes if you want to show tasks.

8 Click Save.

### Setting the view

The Change Management application is already configured by your application administrator. For detailed information about customizing your options to help you quickly process change requests, see BMC Remedy User Help. The following procedure provides information about setting the view.

If you are using the consoles or you are using the Web, the view is already set for you. However, if you do not use the consoles and you access forms directly in BMC Remedy User, you can set your default view in the Options dialog box of the user client.
To set the view in Windows

   The Options dialog box appears.

2. Click the Advanced tab.

Figure 3-8: Default Form View field in the Advanced tab of the Options dialog box

3. In the Default Form View field, type the name of the view that you want to appear when the application is started.

Table 3-1 describes the available views.

Table 3-1: Views in the BMC Remedy Change Management application

<table>
<thead>
<tr>
<th>View Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requester</td>
<td>Used by requesters to create new change requests and to search for existing changes.</td>
</tr>
<tr>
<td>Support</td>
<td>Used by support staff to enter and update change request data.</td>
</tr>
</tbody>
</table>
If you have any BMC Remedy Change Management forms open, close and reopen them.

The Default Form View takes effect after you reopen the form window to which the view applies, or it takes effect at the next login.

Broadcasting messages

This feature lets you send messages to your entire organization, selected groups within the organization, and to external customers as well. You can use this feature to send messages about work in progress, system status, planned work, and so on. You can also use this feature to view messages that were broadcast to you from other groups in your organization.

Broadcasts are filtered by the logged-in user’s company, based on the following criteria:

- Broadcasts that are defined for the logged in user’s company
- If the logged-in user’s company cannot be determined, then only Global broadcasts are displayed.
- Only broadcasts defined for the Global company are shown to guest users, whose company cannot be determined.

You can also broadcast the unavailability of CIs from the Relationships tab. (For information, see “Broadcasting CI unavailability” on page 268.)

Creating broadcast messages

This section describes how to create a broadcast message using the New/Modify Broadcasts dialog box. To create a broadcast, you must have the functional role of Broadcast Submitter. See the BMC Remedy IT Service Management 7.0 Configuration Guide for details.
To create a broadcast message

1 You can open the New/Modify Broadcasts dialog box from two locations, as follows:

- From the Change Management Console, click Create, which appears below the Broadcast table. If you create a broadcast from the main console, it is not related to a specific record.
- From a problem investigation, from the navigation pane, choose Functions > Broadcast Problem. If you create a broadcast from an investigation, a relationship is created between the broadcast and the investigation.

2 Enter information in the required fields.

Required fields appear in bold on the Broadcast Details tab.

- **Company**—Select the company this broadcast pertains. Only users with access to this company see the broadcast. If you select Global from the Company list, the broadcast is sent to everyone.

The Company field is mandatory. If you fill in the other location fields, however, you can indicate a very specific part of the company. For example, you can specify the site, organization, or department.

- **Subject**—A short description of what the broadcast is about.
- **Broadcast Message**—The text of your message.
- **Broadcast Type**—Select a broadcast type from the list.
- **Broadcast Start Date and Broadcast End Date**—To start the broadcast now, click in the Broadcast Start Date field, and press Enter. To select a date from the calendar, click the Browse button next to the field, then use the calendar that appears to select the date on which the broadcast is to start and the date on which you want it to end. You can also specify times of the day using the Time feature at the bottom of the calendar.
- **Broadcast Originated From**—This is filled in by the system. The contents depend on where you are creating the broadcast. If you broadcast from an investigation, this is set to Problem Investigation.
- **Broadcast Originated From ID**—This field is populated by the system, but only when you create a broadcast from within a record. If you create a broadcast from the main console, the field appears disabled.
- **View Access**—Select Internal if you want only the broadcast visible to members of your organization. Select Public if you also want the broadcast visible from the Requester console.
- **Notify**—Select Yes if you want a broadcast notification automatically sent to an individual or group.

  If you select Yes, an Email button and the Notify Support area appears.

  - Use the Manual Email button to manually send an email about the broadcast to a person or group. When the Email System form appears, enter the recipient’s email address in the Internet Email field, then click Send Email Now.

  - Use the Notify Support area to indicate which group you want to notify of the broadcast. You must complete all three fields, Support Company, Support Organization, and Support Group. The notification is sent at the time and on the date specified in the Broadcast Start Date field.

- **Priority**—Select a priority level for the broadcast. The choices are Low, Medium, and High.

  3 If you want to add an attachment to the Broadcast, right-click inside the table and select Add from the menu.

  The Add Attachment dialog box appears. Use this to indicate the file you want to attach. Click Open to attach the indicated file. You are limited to one attachment for each broadcast.
If you want members of another group to be able to modify the message, follow these steps:

a  Click the Authoring Groups tab, then click Manage Authoring Groups. The Authoring Group dialog box appears.
b  Indicate the group that you want to have authoring rights by selecting from the menus. Click Add when you are finished.

**Note:** The support group you belong to appears in the table by default.

You can indicate another group, or click Close to dismiss the dialog box.

5  Click Save to save the broadcast message and close the dialog box.

**Viewing broadcasts**

This section describes how to view broadcast messages. While viewing broadcasts, you can modify the message (if you belong to an authorized authoring group), create a new broadcast message, and under some circumstances (when viewing the message from the current record) relate the broadcast message to the current record.

**To view broadcasts**

1  You can view broadcast messages from two locations, as follows:

   - From the Change Management main console, select the message you want to view from the Broadcast table, then click View.
   - From the current record, in the navigation pane, choose Quick Links > View Broadcasts. The View Broadcasts dialog box appears. Select the message you want to view from the Broadcast table, then click View.

**Note:** When viewing broadcast messages from the current record, you are looking at all of the broadcast messages, not just the ones related to the current record. If the broadcast table contains a large number of messages, use the Broadcast Search Criteria tab to limit the number of messages. See “Limiting the number of messages” on page 102 for information about how to do this.
To view another message, do either of the following steps:

- When viewing from the main console, close the View Broadcasts dialog box, select the broadcast message you want to view from the table, then click View.
- When viewing from the current record, in the broadcast messages table, click the message you want to view. The message details appear.

Creating or modifying a broadcast message

To create or modify a broadcast message from the View Broadcasts dialog box, click either Create or Modify. Both actions open the New/Modify Broadcasts dialog box.

- If you are creating a new message, follow the instructions provided in “Creating broadcast messages” on page 98.
- If you are modifying the message, edit the fields according to the changes you want to make. Click Save when you finish making your changes.

Limiting the number of messages

When viewing broadcast messages from the current record, you can limit the number of messages that appear in the Broadcast table by opening the Broadcast Search Criteria tab and defining a set of criteria that filters out messages that do not match.

To limit the number of messages

1. Click the Broadcast Search Criteria tab.
   - This tab contains search fields where you can specify criteria to reduce the number of broadcast messages displayed in the table.
2. Complete the fields in the tab.
   - To return the smallest number of broadcast messages, complete as many of the fields as possible.
3. When you finish specifying the search criteria, click Search.
Working with table data

The Change Management application contains tables that display data. You can update the data within these tables to show any new information, sort the data, and print it. For example, when you open the Change Management Support Console, the Assigned Requests table displays all the change requests that you have created.

Viewing and updating the table data

- Click the Set to Defaults button.
  This loads the latest data into the table. The administrator can set a limit on how many records are loaded into the table.
- Use the scroll bar on the right to scroll through the entries in the table.
- Select a request and click the View button to display the change request.
  In Windows you can also right-click in the table and select the following from the context menu:
  - Refresh All in Table loads the latest data into the table and overrides any limitations the administrator might have set on how many records can be returned. If a large number of records is returned, your server’s performance might be slower. This option is only available for select tables (for example, it does not apply to tables on the consoles).
  - Clear Table removes the table data. To view new data, click in the table.

To sort the table data

1. Click on the header of the column by which you want to sort the table.
   The list of items is ordered according to that column.
2. To reverse the sort order within that column, click the column header again.
   On the Web, click the arrow in the header.

To print the table data

1. Choose File > Print.
   This prints a graphic of the screen.
2. Enter the printing specifications in the Print dialog box.
3. Click OK.
To print the table data in Windows

1. Right-click on the table.
2. From the context menu that is displayed, choose Print Table.
   This prints a list of all the items in the table, including those that are not in view.
3. Enter the printing specifications in the Print dialog box.
4. Click OK.
This section contains information about using the Change Management Console.

The following topics are discussed:
- Using the Change Management Console (page 106)
- Company and Console View (page 111)
- General Functions (page 112)
- Advanced Functions (page 113)
- Other Applications (page 114)
- Searching for change requests (page 114)
- Search Criteria (page 123)
- Broadcast messages (page 124)
- Assigned Tasks table (page 124)
- Assigned Change table (page 125)
- Quick Actions (page 125)
- Using Reminders (page 126)
- Working with reports (page 130)
- Managing inventory locations (page 135)
- Using the Process Overview (page 139)
- Using the Configuration Manager (page 140)
Using the Change Management Console

The Change Management Console provides a dedicated workspace for managing change requests. This console is designed for change managers and change assignees who deal with Change Management to plan their days more effectively and do not want to view other ITSM applications. The management and support consoles have been specifically re-designed for their unique needs. These consoles optimize your visual work space so that you can track changes quickly and efficiently.

Various functions are available in the left pane of the Change Management Console. These functions provide you with quick ways to navigate to different areas in Change Management and to perform other functions.

Related Topics:
- “Viewing tasks assigned to you” on page 109
- “General Functions” on page 112
- “Other Applications” on page 114
- “Search Criteria” on page 123
- “Broadcast messages” on page 124
- “Assigned Tasks table” on page 124
- “Assigned Change table” on page 125
- “Work Info” on page 125
Using the Manager Console as a change manager

The Manager Console is the primary interface for change managers. It provides quick access to the information you need and to the procedures that you perform most often.

Figure 4-1: Change Management—Manager Console
Using the Support Console as a change assignee

The Support Console is the primary interface for change assignees. It provides a dedicated workspace for working on change requests. It is designed to give you quick access to the information and procedures that you need daily so that you do not have to open other ITSM applications. The Support Console lets you see the most important details associated with changes requests, for example, tasks associated with changes, work information, and important broadcasts.

Figure 4-2: Change Management—Support Console
Opening the Change Management console

The following instructions describe how to open the Change Management console.

► To open the Change Management Console in Windows

1. Open BMC Remedy User as described in “Using BMC Remedy User client to open a main console” on page 80.


► To open the Change Management Console in a browser

1. Launch your browser as described in “Using a browser to open a main console” on page 81.

2. On the Home Page form, under the Change Management heading, click the Change Management Console link.

The Change Management Console appears.

Viewing tasks assigned to you

When you are viewing your assigned change requests, you can also view any tasks related to the change which are assigned to you.

► To view tasks assigned to you

1. Open the Change Management Support Console.

2. In the Change Management Console, click the Tasks tab. The tasks assigned to you are displayed.

Figure 4-3: Tasks tab
3. Select a task and then click View.
   The task is displayed.

**Figure 4-4: Viewing assigned Task form**

4. Edit details, as needed.

5. Click Close when you are finished.

Related topics:
- “Assigned Tasks table” on page 124
- “Assigned Change table” on page 125
Company and Console View

The Company and Console View allows you to display changes that are assigned to you or to one or all of the support groups you belong to. You can change the table display by using the Company and Console Views at the top left corner of the console. Select the following options to filter out which requests you see.

- **Company**: Shows requests for a particular company. This field is especially useful in a multi-tenancy environment.
- **Personal**: Shows all the requests that are assigned to you.
- **Selected Groups**: Shows all the requests that are assigned to your support group.
- **Show All**: Shows all requests.
- **Show Unassigned**: Shows all the requests that are unassigned.
- **All My Groups**: Shows all the requests that are assigned to all support groups that you belong to. If you belong to more than one support group, the requests for all those groups are displayed.
- **Show All**: Shows all requests.
- **Show Unassigned**: Shows all the requests that are unassigned.

You can view requests and refresh the items displayed in the table. For more information about viewing and refreshing requests, see “Working with table data” on page 103.

You can also create new requests by clicking Create under the Assigned Change table. For more information, see “Creating requests” on page 85.

**Viewing changes assigned to selected groups**

Console View lets you display changes that are either assigned to you or to the support groups to which you belong. If you select All My Groups or Selected Groups, the Show Unassigned option is available. When selected, it limits your search to changes that are not assigned.

If you select either Show All or Show Unassigned from Selected Groups, the My Group Selection dialog box appears.
This dialog box contains a listing of all of your groups. You can select the needed group or groups you wish to query against by selecting the check box under View Group and then clicking Update.

### General Functions

The General Functions section lets you easily select important features.

- **New Change**: Opens the Change form in New mode. For information, see “Creating change requests—Basic steps” on page 162.

- **Search Change**: Opens the Change form in Search mode. For information, see “Viewing, creating, and modifying change requests” on page 160.

- **My Profile**: Allows you to set your profile. For information, see “Viewing your profile” on page 88.

- **Application Preferences**: Allows you to set your application preferences and options. For information, see “Viewing application preferences and options” on page 94.

- **Reminders**: Opens the Reminders dialog box. For information, see “Using Reminders” on page 126.

- **Reports**: Opens the Report Console. For information, see “Working with reports” on page 130.

- **Flashboard**: Opens Change Management Flashboard. For information, see “Flashboards” on page 300.

- **Process Overview**: Opens the Process Overview window. For more information, see “Using the Process Overview” on page 139.
Advanced Functions

The Advanced Functions section lets you select specialized features.

**Manage CIs**
Creates or searches for CIs. For information, see “Managing configuration items” on page 309. But for detailed information, see the *BMC Remedy Asset Management 7.0 User’s Guide*.

**Manage Inventory**
Creates and searches for bulk items, non-bulk CIs, or CIs in inventory. For information, see “Managing inventory locations” on page 135. But for detailed information, see the *BMC Remedy Asset Management 7.0 User’s Guide*.

**View Calendar**
Opens the calendar. For information, see “Viewing the CCM Change Calendar” on page 318.

**Modify Business Events**
Lets you search for, select, modify, and delete business events. For information, see “Modifying time segments for business events and categorizations” on page 188.

**Modify Operational Category Location**
Lets you search for, select, modify, and delete operational category locations. For information, see “Modifying time segments for business events and categorizations” on page 188.

**Time Segments**
Lets you search for, select, and create the following time segments:
- Business Event
- Operational Category Location
- Configuration Item (CI)
For information, see “Registering time segments” on page 183.

**Configuration Manager**
On the Manager Console only, opens BMC Configuration Manager console (if the integration is enabled). For more information, see “Using the Configuration Manager” on page 140.
Other Applications

The navigation pane of the Change Management Console also contains links to view additional applications that you have access to:

- **Overview**: Opens the Overview Console.
- **Incident Management**: Opens the Incident Management Console.
- **Problem Management**: Opens the Problem Management Console.
- **Asset Management**: Opens the Asset Management Console.
- **Approval Console**: Opens Approval Central so that you can view all requests pending approval.
- **CMDB**: Opens the CMDB Class Manager Console.
- **SLM**: Opens the SLM Console.

The links that are displayed in the navigation pane are determined by the applications that are installed in addition to BMC Remedy Change Management.

Searching for change requests

Two types of searches are available from the main console. One type of search only looks through changes that are in some way associated with you through your login ID or group ID (for example, changes created by you, assigned to you or to your support group, and so on) and that meet your specific search criteria. You execute this type of search from the Search area near the top of the console. See “Searching your requests” on page 115 for a description of how to run this type of search.

**Note:** You can view the support groups you belong to by clicking the My Profile link in the navigation pane, then opening the Support Groups tab. See “Viewing your profile” on page 88 for more information about this link.
The other type of search looks through all of the changes that meet your search criteria, regardless of their associations to people or groups. You run this type of search by using the Search Change link in the navigation pane. See “Searching all change requests” on page 117 for a description of how to run this type of search.

**Searching your requests**

You can use the Change Management console to search the database for change requests associated with you or your group and that meet your specific search criteria. Use this type of search when you are looking for a record that you know is associated with your ID or with your group’s ID.

1. **To search for change requests associated with your login ID**

   1. From the Search Criteria area in the Change Management console, select your search criteria from the various selection boxes.

   ![Search Criteria area](image)

   In some cases, you are able to type text into the Search Criteria fields. Where this is the case, click Search to update the contents of the search results table.

   **Note:** The most commonly searched-upon record fields appear in the Search Criteria area of the console. See “Search Criteria” on page 123.

   2. Click Search.

      When you make changes in the Search Criteria on the console, you must click Search to update the Assigned Change or Assigned Tasks table.

   3. Scroll through the search results table to find the specific request you want.
Chapter 4—Using the Change Management Console

BMC Remedy Change Management 7.0

**Note:** If the search returns a large number of requests, you can narrow the results by using the Advanced Search feature. More record fields are available as search criteria under the Advanced Search option. See “Using the Advanced Search function.”

You can also search for another request from within an open record by using the standard BMC Remedy User search function.

**Using the Advanced Search function**

If your search returns too broad a range of requests, you can perform an advanced search to narrow the results.

**To use the advanced search function**

1. In the Change Management main console, click Advanced Search.
   The Advanced Qualification Builder dialog box appears.

2. From the Keywords or Fields selection boxes, select the keywords or record fields on which you want to search.
   To insert operators (,+,-,>,<, and so on), click the appropriate operator button. Do not forget to place literal values between quotation marks. For example, to search for a record that has a change ID of CRQ0000069, you would construct the following search:
   ‘Infrastructure Change ID’ = “CRQ0000069”

**Note:** You can also type directly into the Qualification field.

3. Click Select
   The dialog box closes and you return to the main console.

4. Click Search.
   The search results table updates with the results of your search.
Searching all change requests

This procedure describes how to search all changes. Use this type of search when you are looking for a change that is not associated with your ID or your group’s ID, or anytime you must search all changes.

To search all change requests

1 In the navigation pane, click Search Change.

   The Change form appears in search mode.

   The Change form in search mode is laid out in a similar way to the Change form in modify or new modes, and contains the same tabs and fields. You can use any of the tabs and fields in the search form to specify your search criteria.

2 Using the tabs and fields, build your search condition.

   To reduce the number of records found by the search, enter as much information into the search form as you can.

3 When you finish entering your search criteria, click Search.

   When the search finishes, the Change form appears along with a search results table that contains all of the records that match the search criteria.

4 Scroll through the table to find the specific record you want.

5 When you find the record, open it in the Change form in Modify mode by clicking it in the search results table.

Searching for change requests assigned to groups

You can see a list of your assigned change requests or a list of change requests assigned to your group in the Change Management Support Console.

If you want to view change requests according to specific criteria, you can search for them according to these criteria as well.

To see a list of open change requests assigned to you

1 Open the Change Management Support Console.

2 Click Console View.

3 Click Personal.

   Your open change requests are displayed in the Assigned Change table.
4 To view the details of a request, select the item in the list and click View.
The request is displayed.

To see a list of open change requests assigned to your group
1 Open the Change Management Support Console.
2 Click Console View.
3 Click All My Groups.
4 Select Show All.
   My Group Selection opens.
5 Select a group and click Update.
   All the open change requests assigned to your group are displayed in the
   Assigned Change table. If you belong to more than one group, the requests
   assigned to all those groups are listed.
6 To view the details of a request, select the item in the list and click View.
The request is displayed.

To search for a change request using specific criteria
1 In the navigation pane of the Change Management Support Console, click
   Search Change.
   The Change form appears in search mode.
2 Enter criteria in the appropriate fields to define your search.

3 To perform an advanced search, do one of the following:
   - On the Web, click Advanced Search.
   - In Windows, choose View > Advanced Search Bar.

   The Advanced Search bar consists of a row of buttons, a Search Criteria field, and a Fields list. You can use this bar to specify complex search criteria. For detailed information about using the Advanced Search bar, see BMC Remedy User Help.

4 Click Search.

   The change requests matching the criteria are displayed.
5 Scroll through the table entries to find the change request you want to view.

6 To view the details of a change request, select the change request.

The change request is displayed.

Related topics:
- “Working with requester records” on page 90
- “Modifying existing change requests” on page 168

**Searching for users in the Change form**

If you are not certain whether a user already has an existing record in the People database, you can perform a search. You can view the requester’s record and, if necessary, modify it. You can perform the following procedure from any form that has a Login Name or Name field.
To search for a requester

1. Open a form or dialog box, for example, the Change form, containing the Last Name field.

2. Click in the Last Name field, and enter partial information you might know about the individual you are looking for.

For example, if you know the user only by their first name, you can enter only the first name.

3. Without moving your cursor from the field, press ENTER.

**Note:** The plus sign (+) beside certain fields indicates that there is workflow that acts on the field when you press the ENTER key when you place the cursor in the field.

The People Search dialog box appears.

**Figure 4-9: People Search dialog box**

4. (Optional) If you need to narrow down the list, enter search criteria in the appropriate fields and then click Search.

The Search Results table shows the matching records.
To view a record, select it and click View. The People form is displayed.

**Figure 4-10: People form**

To make changes, update the appropriate fields and click Save.

Click Close to close the People form.

Click Select to choose a person and close the People Search dialog box. The fields are populated with the information relating to the person for whom you searched.

**Printing change requests**

You can preview change requests that are displayed in the Change Management console, and then export or print them to keep for filing purposes or to share with someone who does not have access to the application.

**To print or export the request**

1. From the Change Management console, select the change request you want to print.
Note: If you already have the request open and want to print it, click Print at the bottom of the form to open the Business Objects Report Preview dialog box, then go to step 4.

2 At the bottom of the console, open the Quick Actions selection box.
3 Select Print, then click Execute.

The Business Objects Report Preview dialog box appears, allowing you to view the record before you print it.

4 Click the print icon on the menu bar at the top of the dialog box.

When the print confirmation dialog box appears, click Print, to send the record to your local printer.

5 Close the Business Objects dialog box.

Tip: If you already have the record open, you can click Print at the bottom of the form. This opens the Business Objects preview dialog box as described earlier in step 3, from which you can print as described in steps 4 and 5.

Search Criteria

The Search Criteria area lets you filter out the change requests you see in the Assigned Change table.

You have the following options:

- **Status**—Lets you view changes based on their current status, for example, All Open Changes.

- **Dates**—Lets you view changes based on the Submit date field. You can choose to display changes created the last 24 hours, the last 48 hours, and so on.

- **Escalated**—Lets you display changes that are escalated or not.

- **Role**—Lets you view changes based on predefined roles, for example, Change Assignee or Requester (default). You must have the functional role of Change Manager, Change Assignee, or Change Implementer within the application to have access to certain options. For example, selecting Change Assignee lists only those changes for which you are the assigned Change Assignee.

Search Criteria ▶ 123
You can click Advanced Search to view the advanced qualification builder.

**Tip:** When you make changes in the Search Criteria on the console, you must click Search to update the Assigned Change or Assigned Tasks table.

### Broadcast messages

The Broadcast messages on the upper-right portion of the console enables you to view and create broadcasts that can be viewed by the entire organization or by users in the support, approver, management, and administrator groups.

For information, see “Broadcasting messages” on page 98.

### Assigned Tasks table

The Assigned Tasks table lists the tasks that are assigned to change managers or assignees. The table list includes a column that shows the assignee of the task. The TAS prefix identifies the change requests. You can filter the tasks in the table by using the Company and Console View fields at the top left corner of the console. For more information, see “Viewing tasks assigned to you” on page 109.

You do not have to view change requests in the Change form. The Assigned Tasks table displays the following important information about tasks:

- **Task Details**—Shows basic read-only information about the task. You can view additional details about the person who created the request and the person it is assigned to.

- **Change Details**—Shows basic read-only information about the change request associated with the task. You can view additional details about the person who created the request and the person it is assigned to.

- **Work Info**—Shows activity associated with the task. (Managers only)
Assigned Change table

The Assigned Change table lists the change requests that are assigned to change managers or assignees. The CRQ prefix identifies the change requests. You can filter the requests in the table by using the Company and Console View fields at the top left corner of the console. For more information, see “Viewing tasks assigned to you” on page 109.

You do not have to view change requests in the Change form. The Assigned Change table in the Support Console displays the following important information about change requests:

- **Change Details**—Shows basic read-only information about the change request. You can view additional details about the person who created the request and the person it is assigned to.

- **Tasks**—Shows tasks associated with the change.

- **Work Info**—Shows activity associated with the change. (Managers only)

**Work Info**

The Work Info area lets change assignees view or create the actions performed or information gathered about a change request. For example, you can create a work information entry that documents the installation and back-out procedures for a change. For more information, see “Modifying existing change requests” on page 168.

**Quick Actions**

The Change Management Console lets you perform certain quick actions. Select the action and then click Execute.

- **Display Selected**—Opens the change or task.

- **Home Page**—Opens the IT Home Page.

- **Print**—Lets you select records and print their contents. For more information, see “Printing change requests” on page 122.

- **Set Change as Primary table**—Displays requests in console.

- **Set Task as Primary table**—Displays tasks in console.

- **View Calendar**—Opens the change calendar. For information, see “Viewing the CCM Change Calendar” on page 318.
Using Reminders

Reminders enable you to create notes for yourself and others. You can send them by email or through BMC Remedy Alert, and you can specify when they are sent.

You can create generic reminders, or you can create reminders that are associated with a specific change request or task. For example, you can send yourself a note about a specific change request to remind yourself to follow up on it.

Whether you access reminders from the console or from within a change request determines which reminders you are able to view:

- When you open the Reminders dialog box from the console, you can view all reminders that you have created.
- When you open reminders from within a change request, you can view all reminders associated with that request. This includes reminders created by other users of Change Management.

You can modify or delete only the reminders that you have created.

Creating Reminders

If you create a reminder from the console, the reminder is generic. If you create a reminder from within a change request, the reminder is specific to that request.

To create a reminder

1. In the Change Management Console, or from within a change request or task, choose General Functions > Reminders.
   The Reminders dialog box appears.
2. Click the Create Reminder tab.
3 From the Notify list, select either Individual or Group, depending on whether you are sending the reminder to a single person or a group of people.

4 In the Recipient field, type the name of the person or group that you want to notify.

   If you type a name in the Recipient field and press ENTER, the AR Login field is automatically populated. If you leave the field empty and press ENTER, the People Search dialog box appears. You can search for a name and select it from a list. The Recipient and AR Login fields are automatically populated.

5 In the Time field, enter the time that you want the system to send the reminder.

   You can type the information, or you can click the button next to the field and select the time from the calendar that is displayed. By default, the Time field contains the current date and time.

6 In the Subject field, enter information about the reminder.

   The information in this field is displayed in the subject line if the reminder is sent by email.

7 Type the reminder message in the Message field.

8 Click Save.

9 Click Close to close the Reminders dialog box.

   The reminder is sent at the time you specified.
Chapter 4—Using the Change Management Console

BMC Remedy Change Management 7.0

Viewing, modifying, and deleting reminders

If you open the Reminders dialog box from the Change Management Console, all reminders that you created are displayed. If you open the Reminders dialog box from within a change request, only the reminders associated with that request are displayed.

To view and modify existing reminders

1 In the Change Management Console, or from within a change request, choose General Functions > Reminders.

The Reminders dialog box is displayed. If you opened the dialog box from the Change Management Console, all reminders that you created are displayed. If you opened the dialog box from within a change request or a task, only the reminders associated with that request or task are displayed.

Figure 4-12: Reminders dialog box—Show Reminders tab

2 In the Show Reminders field, select the set of reminders that you want to view. The choices are All, Pending, and Sent.

The reminders are displayed in the table.

3 Select a reminder, and click View.

4 The Reminder Details dialog box is displayed.
5 Make your changes to the reminder, and click Save.
   A message reports that the reminder has been modified.

6 Click Close to close the Reminder Details dialog box.

7 Click Close to close the Reminders dialog box.

To delete existing reminders

1 From the Change Management Console or from within a change request or task, choose General Functions > Reminders.
   The Reminders dialog box is displayed. If you opened the dialog box from the Change Management Console, all reminders are displayed. If you opened the dialog box from within a request or a task, only the reminders associated with that request or task are displayed.

2 In the Show Reminders field, select the set of reminders that you want to view. The choices are All, Pending, and Sent.
   The reminders appear in the table.

3 Select the reminder that you want to delete.

4 Click Delete.
   A message reports that the reminder has been deleted.

5 Click Close to close the Reminders dialog box.
Working with reports

Change Management provides a variety of predefined reports to give you quick and easy access to information about your system. You use the Report Console to generate these reports. If the predefined reports return more information than you need, you can manage the scope of the report using qualifications. See “Using qualifications to generate a report” on page 131 for information about using qualifications.

Important: If you use Crystal Reports software to modify the prepared reports supplied with BMC Remedy Change Management, Customer Support can only provide limited assistance if you should have a reporting problem. In addition, there is no guarantee that problems resulting from these modifications can be solved. The standard reports included with Change Management are designed to be used without modification.

Generating a report

Use this procedure to generate a standard report, without using qualifications (see “Using qualifications to generate a report” on page 131 for information about generating reports with qualifications).

To generate a report

1. From the Change Management Console, in the navigation pane under Quick Links, choose General Functions > Reports.

   The Report Console appears.
2 From the Report Name list, select the report you want to generate.

3 If you select a report that requires a date range, the date range field appears. Select a start date and end date for the report.

4 From the Destination list, select one of the following output destinations:
   - **Screen**—Your report appears in a separate dialog box.
   - **Printer**—The report is sent to the printer you specified in the Print Setup dialog box.
   - **File**—The report is saved to the path and file you specify.

5 Click Run Report.

**Using qualifications to generate a report**

You can manage the scope of a report by adding qualifications to the criteria used by the report engine to generate the report content. You can tell the report to search only certain specified fields for particular values, or build advanced qualifications using field names, keywords, and operators. By saving the qualifications, you can rerun the qualified report without having to re-specify the qualifications.
This procedure describes how to create basic report qualifications from the Define Report Qualification area of the Report Console. To create a report using advanced qualifications, see “Using advanced qualifications to generate a report” on page 133.

To use qualifications to generate a report

1. From the Change Management Console, choose General Functions > Reports.

   The Report Console appears.

2. From the Report Name list, select the name of the report you want to generate.

3. In the Define Report Qualification area, create your qualifications from the lists. For example, if you want to create the qualification, “Cost Center = 001”, select “Cost Center” from the list in the left column, select “=” from the operand list (middle column), then type “001” in the right column.

   You can use all five rows in the area to define qualifications.

4. To save the qualification, click Save Qualification.

   The Qualification Name dialog box appears.

   ![Figure 4-15: Qualification Name dialog box](image)

   **Note:** By saving the qualification, you can rerun this report without defining the qualification again. See “Generating a report using saved qualifications” on page 134.

5. In the Qualification Name field, enter a name for your qualification, and click OK.

   A message appears stating that your qualification is saved.
6 Click OK.
   The Report Console reappears.

7 From the Destination list, select one of the following output destinations:
   - **Screen**—Your report appears in a separate dialog box.
   - **Printer**—The report is sent to the printer you specified in the Print Setup dialog box.
   - **File**—The report is saved to the path and file you specify.

8 Click Run Report.

**Using advanced qualifications to generate a report**

This procedure describes how to generate a report using advanced qualifications.

To generate a report using advanced qualifications

1 From the Change Management Console, choose General Functions > Reports.
   The Report Console appears.

2 From the Report Name list, select the name of the report you want to generate.

3 Click Advanced Qualification.
   The Advanced Qualification Builder dialog box appears.

   ![Figure 4-16: Advanced Qualification Builder dialog box]

4 Using the buttons in the qualification builder, construct your qualification.
5 Click Save.

The Report Console reappears.

**Note:** By saving the qualification, you can rerun this report without defining the qualification again. See “Generating a report using saved qualifications” on page 134.

6 From the Destination list, select one of the following output destinations:

- **Screen**—Your report appears in a separate dialog box.
- **Printer**—The report is sent to the printer you specified in the Print Setup dialog box.
- **File**—The report is saved to the path and file you specify.

7 Click Run Report.

**Generating a report using saved qualifications**

You can generate a report using qualifications that you created and saved previously.

▲ **To generate a report using a saved qualification**

1 From the Change Management Console, choose General Functions > Reports.

2 The Report Console appears.

3 Click Select Saved Qualification.

The Saved Qualifications dialog box appears.

*Figure 4-17: Saved Qualifications dialog box*
4 Select the qualification from the table, and click Return Selected.
   The Report Console reappears.

5 From the Destination list, select one of the following output destinations:
   - Screen—Your report appears in a separate dialog box.
   - Printer—The report is sent to the printer you specified in the Print Setup dialog box.
   - File—The report is saved to the path and file you specify.

6 Click Run Report.

Managing inventory locations

If you have Asset Admin permissions, you can use the Manage Inventory dialog box to view inventory locations, relocate configuration items (CIs), and reserve and use CIs and bulk inventory items. For detailed information, see the BMC Remedy Asset Management 7.0 User’s Guide.

Viewing inventory locations

You can view the location of all your CIs from the Manage Inventory dialog box.

To view inventory locations

1 In the Change Management Console, choose Advanced > Manage Inventory.
   The Manage Inventory dialog box appears.
Enter your search criteria, and click Search.

Results matching your search criteria appear in the table.

Select a CI or bulk inventory item from the table, and click View Location.

The Inventory Location form appears.
View the CIs in the inventory, and then click Close.

**Relocating CIs**

You can relocate CIs or bulk inventory items from one location to another.

▲ To relocate CIs

1. In the Change Management Console, choose Advanced > Manage Inventory. The Manage Inventory dialog box appears.
2. Select the CI or bulk inventory item you want to relocate, and click Relocate CIs. The Search Inventory Locations dialog box appears.
From the Location list, select the location where you want to relocate the CI, and click Search.

Results matching your search criteria appear in the table.

4 Select the location where you want to relocate your CI.

5 In the Quantity field, enter the number of CIs you want to relocate.

6 Click Relocate.

Reserving and using inventory

You can reserve and use the CIs and bulk inventory items that are in inventory.

To reserve and use inventory

1 In the Change Management Console, choose Advanced > Manage Inventory.

The Manage Inventory dialog box appears.

2 Select the CI or bulk inventory item you want to reserve and use.

3 Click in the Transaction Qty column and enter the number of CIs or bulk inventory items you want to use.
4 Click Reserve/Use Inventory.

5 The number of CIs or bulk inventory items in the Qty in Stock column is reduced by the number reserved and used.

Using the Process Overview

ITIL describes various “processes” as a common framework for all IT activities. This framework provides best practices to make IT service management much simpler to implement. The Process Viewer provides you a helpful overview of the entire BMC Remedy ITSM process, from the perspective of the Change Management process.

To open the Process Overview

1 From the Change Management Console, choose General Functions > Process Overview.

The Process Viewer appears.
Chapter 4—Using the Change Management Console

BMC Remedy Change Management 7.0

Figure 4-22: Process Viewer

The window illustrates how Change Management is connected to other ITSM processes, for example, Approvals and Asset Management.

2 Close the window when you are finished.

Using the Configuration Manager

If the integration between Change Management and BMC Configuration Management is configured, you can open BMC Configuration Manager from the Change Management Console.

For more information, see “Change and Configuration Management (CCM)” on page 355.

To use the Configuration Manager

1 From the Change Management Console, choose Advanced > Configuration Manager.

The BMC Configuration Management console appears. This console provides a foundation on which BMC Configuration Management browser-based applications, such as Report Center and Policy Manager, run. It provides the browser-based interface, or console, through which you use the applications. It also allows you to configure system settings, which apply to all the browser-based applications.
2 Configure the system settings through the console, as needed.

   For more information, see the *BMC Configuration Management Infrastructure 7.0 Administrator's Guide*.

3 Close the console when you are finished.
Chapter 5 Change assignee role

This section contains information about using the Change Management application as a change assignee, and describes how to create, plan, schedule, and track change requests and related tasks.

The following topics are discussed:
- Working as a change assignee (page 144)
- Using the Change form (page 145)
- Viewing, creating, and modifying change requests (page 160)
- Working with change request assignments (page 171)
- Planning the change request (page 181)
- Understanding the approval process (page 208)
- Working with tasks (page 213)
- Working with relationships and dependent change requests (page 233)
- Monitoring the progress of a change request (page 279)
- Working with costs (page 283)
- Completing change requests (page 292)
- Identifying change requests as rollbacks (page 293)
Working as a change assignee

The change assignee is usually a person with specialized abilities within the support department of larger organizations. Many companies have numerous support staff who specialize, for example, in database management, desktop support, routers, or servers. Frequently, change assignees exercise “lead” responsibilities based upon factors like location, skill set, troubleshooting skills, difficulty of the change request, company (if you are a service provider), and so on.

The responsibilities of a change assignee include the following tasks:

- Gathering appropriate information based on the type of change being investigated.
- Associating related CIs, incidents, and services to the change request.
- Providing status updates to requesters.
- Reviewing change plans and schedules—Planning activities include scheduling the change request, assessing risk and impact, creating plans, creating and sequencing the tasks that must be performed to accomplish the change request, and scheduling people and resources for each task.
- Reviewing all completed tasks.
- Conducting post-implementation reviews to validate the results of the change request.
- Determining requester satisfaction with change request.

For more information about procedures frequently used by change assignees, see the following links:

- “Tracking efforts” on page 176
- “Working with tasks” on page 213
- “Working with relationships and dependent change requests” on page 233.
Using the Change form

The Change form is used to request a change and track the progress from initiation to completion. This form also shows the impact that the change has to the organization. The Change form is used to assign tasks to different support groups, and you can associate the change to configuration items that are being modified.

Figure 5-1: Change form

Before you begin searching, creating, or modifying information in the Change form, you must understand the information relationships involved in the different areas of this form.

First, you must create assignment mappings to assign a change to a Change Management support group, to an individual, or to both. An individual in the Change Management group must assume the role of Infrastructure Change Manager. Assignment mappings can be created for Change Manager, Change Assignee, and Change Implementer. For information about functional roles and assignment mappings, see the BMC Remedy IT Service Providers 7.0 Configuration Guide.
The Change form provides an excellent example of the level of integration that can occur between the various modules available among the ITSM application suite as a change request can occur due to an incident, a change to a configuration item, or a known error correction as a result of problem investigation.

**Using Quick Links**

You can access important functions from the Quick Links tab in the left navigation bar of the Change form. These functions let you navigate quickly to different areas of the form.

- **CI Search** opens the CI Relationships Search form if you select a Record Type in the Relationships tab. You can relate CIs to your current change.
- **Select Operational** opens the Operational Catalog Listing dialog box. You can search for an operational categorization to populate the Operational Categorization fields of the change (in the Classification tab).
- **Select Product** opens the Product Selection dialog box. You can search for a product categorization to populate the Product Categorization fields of the change (in the Classification tab).
- **Select Template** lets you select any templates made available for your support group. For information, see “Selecting change templates” on page 156.
- **View Broadcasts** opens the View Broadcasts dialog box. For information, see “Viewing broadcasts” on page 101.
- **View Calendar** opens the Change Calendar. For information, see “Viewing the CCM Change Calendar” on page 318.

**Using the Functions tab**

You can perform important functions from the Functions tab in the left navigation bar of the Change form.

- **Broadcast Change** to broadcast the current change, you must have the functional role of Broadcast Submitter. For information, see “Creating broadcast messages” on page 98.
- **Copy Change** activated only in Modify mode. For information, see “Copying change requests” on page 158.
Using Advanced features

You can access advanced features from the Advanced tab in the left navigation bar of the Change form. These features let you navigate quickly to different areas of the form.

**Modify Business Events**

Lets you search for, select, modify, and delete business events. For information, see “Modifying time segments for business events and categorizations” on page 188.

**Modify Operational Category Location**

Lets you search for, select, modify, and delete operational category locations. For information, see “Modifying time segments for business events and categorizations” on page 188.

**Time Segments**

Lets you search for, select, and create the following time segments:
- Business Event
- Operational Category Location
- Configuration Item (CI)

For information, see “Registering time segments” on page 183.

**Impacted Areas**

Opens Impacted Areas Update dialog box. For information, see “Viewing impacted areas” on page 153.
Depending which ITSM applications you have installed, the navigation pane of the console contains links to create other types of requests in addition to change requests.

- **Create Incident**: Incident form appears. The relevant details from the change are copied to the incident.
- **Create Problem**: Problem form appears. The relevant details from the change are copied to the problem.
- **Create Known Error**: Known Error form appears. The relevant details from the change are copied to the known error.

### Creating other requests

### Using other ITSM consoles

The navigation pane of the console also contains links to view additional applications that you have access to:

- **Overview**: Opens the Overview Console. For information, see “Opening the Overview Console” on page 82.
- **Change Management**: Opens the Change Management console. For information, see “Using the Change Management Console” on page 106.
- **Reports**: Opens the Report console. For information, see “Working with reports” on page 130.

Any other links that are displayed in the navigation pane are determined by the applications that are installed in addition to Change Management.
Sending pages and email messages

Change Management gives you two methods of sending messages to either individuals or organizations:

- Paging
- Email

This section describes how to send both types of messages.

**Paging a person or on-call group**

You can page individuals or the on-call member of a group about the current record using the Change Management Paging System feature.

To page a person or an on-call group

1. Open the change from which you want to send the page.
2. From the navigation pane on the left side of the form, choose Functions > Paging System.
   The Paging System dialog box appears.
3. Select either:
   - Page By Person—To page an individual.
   - Page By On-Call Group—To page the on-call member of a specified group.
4. Select the recipient.
   To do this, complete the fields in the Search Criteria area, then click Search. When the search finishes, click the recipient’s name in the search results table, then click Select.
   If you are sending a page to a person (instead of an on-call group) and need help deciding which is the correct person, you can see more information about an individual by selecting their name from the list, then clicking View. This opens the People form, which contains detailed information about the recipient.
Complete the fields in the Paging Information area, as follows, then click Send Page Now.

- **Pager Service Provider**—Select the recipient’s pager service provider from the list.

  If you are sending a page to a person, you can find this information by selecting the person’s name from the search results list, then clicking View (as described in step 4). When the People form appears, click the Notifications tab and look for the Pager Service Provider field.

  **Note:** If you need more information about the service provider, click the button with the globe icon beside the field to open a link that takes you to the service provider’s website.

- **Pager Type**—The system populates this field automatically, using information about the recipient already in the system.

- **Pager Number**—The system auto-populates this field with the pager’s telephone number, when possible. If the pager number is unavailable to the system, you must enter the pager number manually. See Manual Pager Number.

- **Pager Email**—If the pager has an email address, type it here. If you are sending the page to a person, this information is available on the Notifications tab, as described previously.

- **Manual Pager Number**—If the pager’s telephone number is not available automatically from the paging system, type the pager’s telephone number here.

- **Alphanumeric Pager Message** or **Numeric Pager Message**—Type your message in this field. Note, only one of these fields is enabled, depending on the type of pager the recipient carries.

**Sending email**

You can send messages about the current record using the Change Management Email System.
To send an email message

1 Open the change from which you want to send the email.

2 From the navigation pane on the left side of the form, choose Functions > Email System.

   The Email System dialog box appears.

3 Indicate the recipient by selecting either:

   - **Current Contact**—When you open the Email System form, if there is a current contact assigned to the record, the contact’s name and contact information appears in the table and is the default recipient.

   - **Current Assignee**—To select the current assignee, click Select Current Assignee. The current assignee’s name and contact information appears in the table.

   **Note:** Only perform the next step if you are sending the email to more than one recipient.

4 To select another recipient, complete the following steps:

   a Complete the fields in the People Search Criteria area.

   b Click Search.

   c When the search finishes, select the recipient’s name in the search results table. If you need help deciding which is the correct name in the list, you can see more information about an individual by selecting their name from the list, then clicking View. This opens the People form, which contains detailed information about the recipient.

5 Complete the email information fields as described in the following list:

   - **Internet Email**—Type the recipient’s email address here.

     You can find this information by selecting the person’s name from the search results list, then clicking View (as described in step 3). When the People form appears, look for the Internet Email field on the General tab.

   - **Email Subject Line**—By default, the subject line contains the change request ID number, which you can append text to or over-type.
Email Message Body—Type the message text here. A series of buttons, to the right of the Email Message Body field, let you automatically insert text from the record into the message text. You can insert the following values:

- Status
- Summary
- Details
- Resolution

Note: If one or more of these buttons appear disabled, it means the corresponding field in the record contains no information.

Email Attachment—You can attach a file to the email message (you are limited to just one attachment). To do this, right-click inside the Email Attachment table, then click Add. The Add Attachment dialog box appears. Navigate to, then select the file you want to attach. Click Open. Details of the attached file appear in the table.

6 Click Send Email Now.

Viewing audit log

Viewing audit logs allows you to view field and notification audits against the change request. When certain fields are changed or when system notifications are sent, an audit entry is created to track the change. The individual’s Login ID making the change appears next to the audit entry.
To filter the information displayed, you can select the Audit Type that you want to view, for example, All, Change Assignee, or Priority.

To view audit logs
1. Open the change from which you want to view the log.
2. From the navigation pane on the left side of the form, choose Functions > View Audit Log.
3. (Optional) Use the Audit Type list to filter out audit log entries.
4. Click the Notification Audit tab to view notification audit entries against the change.
5. Select a notification audit entry and click View.

Viewing impacted areas

The Impacted Areas dialog box displays which companies, sites, and organizations are affected by the change. By default, the information entered in the Change Location of the Requester tab is automatically entered as one of the Impacted Areas. You use the Impacted Areas dialog box to create approvals for the change request.
To view impacted areas

1. Open a change request.

2. From the navigation pane on the left side of the form, choose Advanced > Impacted Areas.

   The Impacted Areas dialog box appears.

   ![Impacted Areas dialog box]

3. Complete the required fields and any other information, as needed.

4. Click Add to add each area to the Impacted Areas table.

   You can add as many impacted areas for a particular change as necessary. You can also delete impacted areas that you have previously chosen in this form.

5. Click Close.

   The additional impacted areas are added to the change request.

Using advanced search

The Advanced Search option allows you to search for change requests using specific criteria. You can use the following searches:

- Search by associated Work Info
- Search by associated Relationships
To search for changes against associated work information

1. Open the change from which you want to view the log.
2. From the navigation pane on the left side of the form, choose Advanced > Advanced Search.
   The Advanced Search Selection dialog box appears.

![Advanced Search Selection dialog box](image)

3. Select the search by Work Info option.
   The Search Work Info form appears.
4. Enter search parameters into the form.
5. Click Search.

To search for changes against associated Relationships

1. Open the change from which you want to view the log.
2. From the navigation pane on the left side of the form, choose Advanced > Advanced Search.
   The Advanced Search Selection dialog box appears.
3. Select the search by Relationships option.
   The Search Relationships form appears.
4. Enter search parameters into the form.
5. Click Search.
Selecting change templates

The Change Template function allows you to select any templates that can be made available for your support group. You use change templates to quickly and efficiently create “standard” changes with a minimum of mouse clicks and keyboard entry. Change templates are useful in any change request that follows well-defined methods for specific and repeated requirements, for example, Installs, Moves, Add Changes (IMAC). New and occasional users to Change Management should find change templates very helpful.

To select templates

1. Create or open a change request.
   
   You can apply a change template to a request in any change state up to Scheduled to Approval, as long as the request is not waiting for approval. Also, you can only select a change template once for each change request.

2. From the navigation pane on the left side of the form, choose Quick Links > Select Template.
   
   The Change Template Selection dialog box appears.

   ![Change Template Selection dialog box]

3. Click View to examine the contents of a change template.
   
   The template appears in read-only mode. Viewing a template lets you see its relationship, its task and task group templates, and other important features.
Figure 5-6: Viewing a change template

![Change Template](image)

**Note:** You cannot create, modify, or delete change templates in the Change Management application; you can only view them. You must use the Application Administration Console to create, modify, or delete change templates instead. Besides change managers, users with Change Master and Change Config permissions can create, modify, or delete change templates. Any member of your support group can modify change templates for that group. For more information, see the *BMC Remedy IT Service Management 7.0 Configuration Guide*.

4 Select a template and click OK.

The contents of the template are applied to the change request. The change template overwrites any field values that are already present in the change request. If the change request already includes relationships or tasks, these are not overwritten. Any additional tasks from the template are added as peers, and additional relationships, for example, CIs, are included with the change request.
Copying change requests

The Copy Change function is available only on the Change form, not the console. This function lets you copy an existing change into a new change request. When using the copy function, you have options to include different sections of the original change request, for example, Requested For Customer, Impacted Areas, CI/Component Relationships, Tasks, Related Changes, Work Logs, or Attachments.

The following fields are pre-populated with information from the change from which you are copying: Description, Change Type, Timing, Timing Reason, Impact, Urgency, Priority, Risk Level, Lead Time, Change Environment, Reason For Change and Detailed Description. You can change the information in these fields to reflect the new change. You are also presented with different sections of the change that you can copy.

To copy a change request

1. From the navigation pane on the left side of the form, choose Functions > Copy Change.

   The Copy Infrastructure Change dialog box appears.

   Figure 5-7: Copy Infrastructure Change dialog box

   2. Click the sections that you want to include in the copy.
**Note:** If you select Copy Activities and do not select Copy Attachments, all attachments associated with work logs are copied. But attachments originally generated from the change are not copied. If you select sections, such as Impacted Areas, CI Relationships, Activities, and Attachment to be copied but *not* the Tasks, the sections on the tasks are copied (with the corresponding sections on the parent change) as if they were originally created from the parent change.

3 Make any modifications to the new change you are creating, for example, changing its priority or timing.

4 Click Start Copy.

   The copy function can take several minutes to process.

   After the change is copied, the Change form opens in a New mode with the newly copied change information in a Request for Authorization state. Any tasks that are copied are in Draft state. You now can modify and submit the new Change.

5 Save the new copy of the change.

   A copied change request is *not* automatically submitted.

**Viewing risk reports**

You can view and print a report of the total impact of your risk changes.

▸ To view risk reports

1 From the navigation pane on the left side of the form, choose Advanced > View Risk Report.

   The Change Risk Report dialog box appears.
Chapter 5—Change assignee role

2 Click Close.

Viewing, creating, and modifying change requests

Change requests are used to track the progress of a change through its entire life cycle, from initiation to close.

The following sections show you how to view, create, search, and modify change requests.
Viewing change requests

1. In the Change Management Support Console, select the change request that you want to view from the Assigned Change table. Change requests are prefixed with CRQ.

2. Click View.

The change request is displayed. The tabs vary according to which other BMC Remedy applications are installed.

3. Click Close when you are finished.
Creating change requests—Basic steps

Most change requests are generated from an existing incident, problem investigation, an RFC proposed by Problem Management, or a known error. When a change request is generated from an existing incident, the Description, Impact and Urgency, and the Product and Service Categorization fields are copied over. The Requester Information defaults to the user initiating the change request.

In addition, BMC Remedy Change Management enables any user with Change Submit permissions to enter change requests into the system. Change assignees and change managers can enter and resolve change requests quickly with the option to create and relate items before saving a new change request.

The following section describes the basic steps for creating a change request.

To create a new change request—basic steps

1. On the Change Management Support Console, click Create.
   You can also choose General Functions > New Change.

   The Change form is displayed. The tabs you see vary according to which other BMC Remedy applications are installed.

   The change request initially appears in Draft status. To enable the change request from Draft status to be moved to its next state, enter information into the following required fields.

2. (Optional) Use a change template to fill out the contents of the change request.

   Change templates are especially useful in any change request that follows well-defined methods for specific and repeated requirements. Change templates do more than simply fill out fields for you; they can also include CIs and tasks with the change request. For more information, see “Selecting change templates” on page 156.
3 Select the Change Type for the change request.

Use this field to further categorize the request according to your organization’s change type definitions.

- Change usually refers to a simple stand-alone change activity.
- Project and Release see change requests that are part of larger scale changes, and usually consist of multiple change requests related to each other.

Depending on which ITSM applications are installed, you might see other options as well.

4 In the Summary field, enter a brief description of the change.

5 Select the Risk Level to indicate the relative risk associated with the change, from 5 (highest risk) to 1 (lowest risk).

The default value is Risk Level 1. The Risk Level is used as a criterion to determine required approvals. You can also click the Compute Level icon to open the Risk Assessment Questions dialog box. For more information, see “Assessing risk and impact” on page 203.

6 Select Impact to reflect the extent to which the change affects the business.

The default value is 4-Minor/Localized. Impact is often directly related to the extent to which the service has degraded from agreed service levels. Impact can be measured by the number of people affected, the criticality of the system affected, and the loss of revenue as a result of the service degradation or disruption.

7 Select the Urgency to indicate the importance the requester assigns to the change request.

Urgency reflects how quickly a change must be implemented, or the time available to reduce the impact of the change on the business. The default value of the Urgency field is Low.

The following factors can be used to determine Impact and Urgency:

- Number of customers affected by associated Incidents
- Duration and scope of the service disruption
- Availability of a solution or work-around
- The type of service being disrupted, usually based on the CI involved
- Awareness of the future impact on the business
Chapter 5—Change assignee role

8 Modify information as needed in the required fields on the Requester tab, for example, Support Company, First Name, and Last Name.

This information is auto-filled, based on your login. The Support Company is the organization or group that the change request is assigned to.

Tip: If you type a letter or name into any of these fields and press ENTER, the field becomes auto-populated. If multiple choices exist, a selection list or dialog box appears, to help you enter a name. Otherwise, you are prompted if no such letter or person exists in the system.

9 Enter information into the required Change Location Company field.

The Change Location Company field is especially important in a multi-tenancy environment. In this field, you can specify that company, department, or other group that controls access to the change request.

10 Click the Classification tab.

Figure 5-11: Change form—Classification tab
The Classification tab is used to describe the change and show which products and services are affected by the change. The Timing of the change request is required before it can be submitted.

11 Select the timing.

Timing specifies the relative urgency of the change, so that the approvers can assess its magnitude:

- **Emergency**—Resolves an incident or problem deemed critical to the business continuity where a work-around is not sufficient. Emergency changes require approval by the CAB.

- **Expedited**—Enterprise-wide impact with an associated risk. Expedited changes require approval by the CAB.

- **Latent**—Change that has already been performed (for example, if a task implementer is assigned to replace the hard drive on a PC and then decides to upgrade the memory while the box open is open) and requires approval after the fact. Latent timing automatically sets the request status to **Completed** after you save the change request.

- **Normal**—Standard change (for example, a PC upgrade) that is typically pre-approved and requires only approval by the Change Manager. The default value is Normal.

- **No Impact**—Has no impact on the infrastructure and requires no approval.

12 Click Save to create the change request.

**Entering additional details when creating change requests**

You can enter additional information into the remaining fields of the Change form as needed.

**To fill in additional details when creating change requests**

1 In the Notes field, enter a more complete description of the change request.

2 Select the Priority to identify the importance you (as support staff) assign to the change request.
Priority indicates the relative order in which changes should be addressed. It is influenced by considerations of risk and resource availability, but is primarily driven by a combination of urgency and impact. The default value of the Priority field is Low.

3 In the Classification tab, enter a Lead Time to indicate the number of hours of preparation required before a change can be scheduled for implementation.

4 Lead Time is used to compute the Earliest Start Date and uses the business hours and holidays configured for the Change Manager’s support group. For more information, see the BMC Remedy IT Service Management 7.0 Configuration Guide for instructions on creating business hours.

5 Select a Change Reason to indicate the business reason for implementing the change request.

   Change reason information can be helpful if the request needs to go through the approval process.

   The Change ID field is automatically populated with the ID number of the change request when you save the request.

6 If you have not selected a predefined summary, categorize the change request by filling in the categorization fields.

   The application automatically assigns the change request when the request is saved. Assignments are determined by the rules configured by the application administrator.

7 Enter a sequence number in the Sequence field if you want the change request to take place in a particular order relative to other change requests.

   For more information, see “Planning dependencies for change requests” on page 206.

8 Do not enter information into the Performance Rating field when you are creating a change request.

   Usually, the manager of the support staff assigned to the change request fills in this rating after the change request reaches the Completed state.

9 If you want to include tasks with the change request, click the Tasks tab.
You can create ad hoc tasks with the new change request before the change request is saved. You can also add task group and task templates to the change. For more information, see “Relating ad hoc tasks to change requests” on page 218 and “Relating predefined task group or task templates to a change request” on page 221.

**Note:** If you close the new change request before saving it, the tasks you created do not exist since there is no parent change request.

10 If you want to create or relate other items to the change request, click the Relationships tab.

You can create and relate change requests to your current change request before it is saved. You can also create and relate configuration items to the change request.

**Note:** If you close the new change request before saving, the new items you created still exist. There is no relationship between these new items and the change request since the change request was not created.

For more information on:

- Relating change requests, see “Working with relationships and dependent change requests” on page 233
- Relating configuration items, see “Working with related configuration items” on page 250

11 Click Save to save your changes.

Depending on the settings configured by your application administrator, you might see the Change form in Modify mode. You might also have to open the Change form in Search mode and query for your request.

12 (Optional) Click the Requester Contacted icon after you responded to the change requester using email, fax, BMC Remedy Alert, and so on.

The Requester Contacted icon is used to record if the requester has been contacted regarding the change request. This data is useful when service providers are organizing their work queue. If you click the Requester Contacted icon, the Requester Contacted (hidden) field is set to Yes when you save your changes. The Requester Contacted icon is now displayed in “Yes” mode.
If the change was generated from a service request, workflow in the Change Management application sets the SLA Responded field on the Service Requests form to Yes.

Modifying existing change requests

As you track and supervise a change request, you move it from one state to another, for example, from Draft to Request for Authorization. If you have simple change requests or change requests that are already underway, you might see that the status is set to Draft or some other status. For change requests that require approval, do not set the status to any stage later than Request for Authorization. For information relating to the Approval Status field, see “Approving or rejecting change requests” on page 209.

The request should still follow the stages in the recommended life cycle of a change request, as described in “Steps in the life cycle of a change request” on page 44. Setting the status to a value other than Draft disrupts the change life cycle in which you enter and resolve the change request. The application directs you with messages if there are fields that must be filled in when you choose different status values.

You sometimes need to modify the change request with work history entries that you can create during its life cycle to document activities performed or information gathered.

Figure 5-12: Change form—Work Info tab
The Work Info tab is a new feature that replaces the Notes and Notes log fields from ITSM 6.0. You access this feature from the Work Info tab of the current record. Use this feature to add work information regarding tasks performed on the current change request. For example, you can track a change request’s progress by recording the steps you took to implement it in the work history.

You might want to add work information about the following activities:

- **General Information**—Notes about the record, for example, you might want to add a note that a particular CI was deployed, and include the date.
- **Planning**—Notes about a plan to implement a global change throughout your organization.
- **Implementation**—Installation and back out procedures for the change.
- **Costing and Charging**—Additional information about the cost of the current CI, incident, change, or so on. For example, you might want to add a note that the cost of maintaining a CI was split between two cost centers, or that the cost to implement a change came under budget.

### To modify a change request

1. Locate the change request that you want to modify:
   - On the Change Management Support Console, select the change request from the Assigned Change table, and click View.
   - Search for the change request, as described in “Searching for change requests” on page 114.

   The request is displayed in the Change form.

2. Make the appropriate changes.

3. To move the Status of the change request from its current setting, you can use the following methods:
   - Use the Process Status Flow area to move from one state to the next. Beginners to Change Management find that using the accelerators in the Process Flow Status area help them learn and understand the underlying status transitions.
Select menu options from the Status field. Support staff who are only making simple changes or power users who are familiar with the status transitions should only use this method.

If you want to set the status to Pending, select the value from the Process Flow Status menu. Otherwise, the Pending field should be filled in at the time the request is dependent upon an external action.

4 Click the Work Info tab and take the following steps:
   a From the Work Info Type list, select the type of work information you want to add.
   b From the Source list, select the source of this information.
      Information sources can include, for example, email, system assignment, or the Web.
   c Enter the details of your work information record in the Summary and Details fields.
   d To add an attachment to the record, right-click in the attachment table and select Add from the menu that appears. With browsers, click the Add button.
   e From the Locked list, select Yes or No to lock the log.

**WARNING:** If you select Yes, you cannot modify the work log after you save it.

f From the View Access list, select Internal or Public.
   - **Internal**—If you want only users within your organization to see the entry.
   - **Public**—If you want everyone with access to the system to see the entry, including requesters.
When you have finished updating the change request, click Save.

The Save operation adds your entry to the work history. The Show field allows you to filter out specific work entries based on the type of activity displayed in the table.

To see a report of the activities you performed against this change, click Report.

To display all existing entries for work information history, click View.

Note: When you return to the Change Management Support Console, you might need to refresh the Assigned Change table to display all the modified records.

Save your changes.

Related topics:
- “Working with requester records” on page 90
- “Searching for change requests assigned to groups” on page 117

Working with change request assignments

One responsibility for change assignees is accepting the change requests assigned to them. It can be assigned manually or automatically. If an assignment definition has not been created for the Change Management application, you must assign the change manually. (For information, see “Automatically assigning changes” on page 172.)

The change assignee is then notified of change request assignments by email, pager, or BMC Remedy Alert. Assigned change requests can also be listed in the Assigned Change table in the console.

Change requests are assigned automatically on creation by the BMC Remedy Change Management application. The assignment is based on the change request's categorization. The Assignment tab displays information about people assigned to a change as the Change Manager, Change Assignee, and Change Implementer.
Note: You must define at least one individual with the functional role of Infrastructure Change Manager before you can make any assignments to a Change Manager Support Group.

During configuration, the application administrator determines to whom the change requests are assigned. This decision is based on criteria such as the change request’s categorization. For example, all change requests that are categorized as hardware issues might be assigned to the Support-Hardware group. All change requests that are categorized as software upgrades and originate from California might be assigned to Sonya Software in Santa Clara. The criteria of the change request together with the application administrator’s configuration determines to whom each change is assigned.

The change assignee must make sure that the assignment is correct and accept the change request. If the assignment is not correct, the change manager can reassign the request.

### Automatically assigning changes

You can automatically assign the change using the Auto Assign option from the Set Assignment using or Set Implementer using menus. Assigning the change assignee using Auto Assign uses the requester’s information, the Change Location information, and the Operational and Product Categorization information about the form to determine an assignment match.
These assignments are based on routing information stored in CFG:Assignment form. The CFG:Assignment form assigns the groups and then Auto Assign assigns the individual. For more information, see the BMC Remedy IT Service Management 7.0 Configuration Guide.

Assigning change requests

A change must be assigned to a change assignee or a Change Management Support Group. However, the change manager is typically responsible for the overall change process.

To assign change requests

1. Open the change request.
2. Click the Assignment tab.

Based on the default configuration and requester information in the change request, certain fields are already filled. For example, the Change Manager field already has an assignment.

3. To assign a change assignee if none is assigned, select Auto Assign from the Set Assignment Using field and then click Set.
To assign a change assignee, use one of the following options and then click Set:

- **My Default Group**—Assigns the change to you and your default group.
- **My Group List**—Opens a list of all groups to which you belong. Select the appropriate group from this list.
- **Favorite Groups**—Assigns the change to the typical groups to which your support group assigns requests.
- **Auto Assign**—Automatically assigns the request based on predefined mapping.
- **Change Manager**—When the Change Manager and the Change Assignee are the same group or person.

To be eligible as the Change Assignee, a user must have the functional role of Change Assignee or Change Manager. Groups that do not have a user with one of these roles are not available for selection in the Change Assignee fields.

5 Save the change request.

The change manager and the change assignee are automatically notified of their assignments.

### Assigning changes to change implementers

You can assign changes to a change implementer. Assignments are similar for a change assignee, except for the Set Implementer using Change Assignee option. You use this option to define the change implementer as the change assignee, which is often the case.

**Note:** If a change request includes one or more related tasks, the Change Implementer fields do not appear on the Assignment tab.

**To assign changes to change implementers**

1 Open the change request.
2 Click the Assignment tab.
To assign a change implementer, use one of the following options in the Set Implementer using field and then click Set:

- **My Default Group**—Assigns the change to you and your default group.
- **My Group List**—Opens a list of all groups to which you belong. Select the appropriate group from this list.
- **Favorite Groups**—Assigns the change to the typical groups to which your support group assigns requests.
- **Auto Assign**—Automatically assigns the request based on predefined mapping.
- **Change Assignee**—Manually assigns the change to the change implementer.

4. Save the change request.

The change implementer is automatically notified of their assignment.
Tracking efforts

The Effort log displays a list of all individuals who have worked on the change during its life cycle.

Figure 5-17: Creating entries in the effort log

Entries in the effort log are not system-generated, so you must enter them manually. The list is not in chronological order.

To track efforts

1. Open the change request.
2. Choose Functions > Effort Log.

The Update Effort Log dialog box appears.
3 Fill in the Select an Assignee fields.

This information is required to select the individual for whom the effort log is being created.

You can fill them in using the drop-down menus, or by using the Search button or Set To Me button to select the appropriate individual.

4 Fill in the Select Effort Classification fields.

This information is required to show what kind of effort is being logged, for example, actual implementation activity.

5 Fill in the Enter Effort Time Spent fields.

This information records where the time was spent.

Note: As needed, you can adjust the time spent in the Update Assignee Effort Duration section. For information, see “Updating assignee effort duration” on page 179.

6 Click Add.

The effort log is now be displayed in the table.
Chapter 5—Change assignee role

Click Close to return to the change request.

The effort log is displayed in the change request.

Modifying the effort log

You can modify effort logs if you have the proper permissions. You must be the change manager or the change assignee on the selected effort log entry to modify the effort time.

To modify the effort log

1. Choose Functions > Effort Log to open the Update Effort Log dialog box.
2. To modify an effort log entry, select the entry in the table and click View. The Modify Effort Log dialog box appears, which allows you to edit specific information.

Figure 5-19: Modify Effort Log dialog box

3. Update any of the assessment type information and the time spent.
4. Click Save.

A note appears, informing you the effort log has been updated. The dialog box then closes, and the updated information entry is displayed in the effort log table.
5. Close the Update Effort Log dialog box.
Deleting the effort log

You can delete effort logs as needed.

➤ To delete the effort log

1 Open the Update Effort Log dialog box.
2 To delete an effort log entry, select the entry in the table and click delete.
   A note appears, warning you the effort log that the effort log is deleted.
3 Click Yes.
   The dialog box then closes, and the effort log entry is removed from the effort log table.
4 Close the Update Effort Log dialog box.

Updating assignee effort duration

Change managers of a change request or its assignee can adjust the time spent in an effort log.

➤ To update assignee effort duration

1 Open the Update Effort Log dialog box.
2 To adjust the time spent, select the entry in the table.
3 Enter the time spent in hours or minutes.
4 Use the + or - buttons to add or subtract from the existing time duration.
5 Close the dialog box.
Receiving notifications of change request assignments

Change assignees are notified of new change requests based on their notification method preferences defined in their personal record. For more information, see “Sending and receiving notifications” on page 41.

The available notifications follow:

- **Individual Notification**—An individual change assignee is notified according to the notification method specified in their personal record.
  
  For example, if Bob Backline has a notification method of BMC Remedy Alert, he receives a notification from BMC Remedy Alert for each change request that is assigned to him.

- **Group Notification**—A change manager group is notified according to the notification method specified by each group member’s entry in their personal record.
  
  For example, if a change request is assigned to the Support-Software group, each group member is notified through the notification method specified in their personal record. If Sarah Software has Email specified as the notification method in her personal record, the notification is sent to her by email. If Bob Backline has BMC Remedy Alert specified, he is notified accordingly.

► To receive notification of change assignment by Remedy Alert

1. Log in to BMC Remedy Alert as a Support staff member.

   When you or your group receives a notification that you or your group has been assigned to a change request, the information is displayed in the BMC Remedy Alert window.

2. To evaluate a change, select the change request listed in the BMC Remedy Alert window.

3. Choose Alerts > Details.

   The change request is displayed in the Change form. For more information, see “Setting Create Request and Search for Request action preferences” on page 95.
Reassigning change requests

If you cannot accept or resolve an assigned change request, you can reassign the change request to another change assignee, or you can ask your manager to reassign the change request.

If the change request was categorized incorrectly, it can also be reassigned.

To reassign a change request yourself

1 Open the change request so that it is displayed in the Change form.
2 In the Assignment tab, select the manager or assignee to whom you want to assign the change request.
3 Click Save.

The manager or assignee is notified of the reassigned change request.

Planning the change request

After accepting the change request, the change manager or the change assignee must plan the details associated with the change.

Figure 5-21: Planning change requests
Plan for the following important details:

- Set the change request’s status to Planning, and specify the planned dates.
- Estimate the time the project will take.
- Estimate any applicable downtime associated with the change request.
- Register an available or unavailable time segment to perform the change.
- Assess the risks and impact of the change request.
- Specify the business justification for the change (if this was not already done when the change request was created).
- Create the tasks.
- Create your plans.
- Calculate the costs associated with the change request.
- Submit the change request for approval.

Approvers require this information to be able to decide whether to approve or reject the change request.

To plan the change request
1. Open the change request, and set the Status field to Planning in Progress.
2. Click the Dates tab.

![Figure 5-22: Change form—Dates tab](image)

When planning a change request, you use the Dates tab to track the requested, scheduled, and actual start and end dates of changes.
The Earliest Start Date is determined by the Lead Time field (in the Classification tab) for the change request. The Requested Start Date is automatically set to the Earliest Start Date if it is not already specified. If the Requested Start Date is earlier than the Earliest Start Date and the change status is not Draft, the Timing (in the Classification Tab) is automatically set to Expedited, and you are prompted to select a Timing Reason.

The Task Dates table displays the task dates and times that you can use to populate the start and end dates of the change request. The dates and times for tasks are populated within the tasks themselves.

3 In the Change Dates region of the screen, provide dates for the Scheduled Start Date and Scheduled End Date fields.

Changes to the Scheduled Dates (both Start and End) can result in notifications being sent to task implementers if the new dates fall outside of the range of the task’s Scheduled Dates.

**Note:** The Scheduled Start Date and Scheduled End Date fields are required when moving a change status beyond Planning in Progress.

4 Click Save.

Related topics:
- “Assessing risk and impact” on page 203
- “Reassigning change requests” on page 181
- “Relating ad hoc tasks to change requests” on page 218

**Registering time segments**

Registering time segments in Change Management works like a calendering system—if you schedule a meeting in a certain conference room, nobody else can reserve the conference room at the same time. Similarly, you can block out time segments around business events (like company holidays), categorizations (Operational Category 1, 2, or 3, and location of the change), or CIs. Time segments allow you to create windows of time that you can designate as unavailable or unavailable when working on a change request. An available time segment could specify that a CI is available for use, while an unavailable time segment could be used to schedule planned maintenance.
When you create a change request that modifies a CI—for example, you must replace a mission-critical server—you can schedule a time segment for the CI that makes it unavailable to the rest of the support staff. If another member of the support staff wants to modify that CI, they must schedule their own change in a different time segment.

Time segments let you perform the following tasks:

- Search available time segments to schedule the change request.
- Connect the selected time segments to the change request’s operational categorization or to a business event based on location.
- Create or use existing time segments around the associated CIs.
- Select unavailable time segments from the associated CIs to help you plan the Scheduled Start or End Date and time for the change request.
- Select from available time segments from the associated CIs to help schedule work to be done.

For more information about business time and time segments, see the Action Request System 7.0 Configuring guide.

**Registering unique business events and operational categorizations**

You must register business events and operational categorizations that are unique, based on their given attributes.

Business event uniqueness is based upon its title *plus* all of the given attributes. For example, you could create a business event with the title (Fall All-Hands Meeting) and Company (ABC Company), another business event with title (Fall All-Hands Meeting - West) and Company (ABC Company), and yet another with the title (Fall All-Hands Meeting) and Company (Acme Corp), but none of them with the same title at the same exact location. The title is only unique within a given location. If you specify a different location, you can use the same title.

In much the same way, you are only allowed to create a single categorization based upon all of its attributes. The title should be descriptive that tells you what particular categorization you are looking at, for example, ABC - Hardware. You must also enter a minimum of Company and Category 1 fields to save the categorization.
For example, if you create a categorization that has the attributes Company (ABC Company) and Category 1 (Hardware), you cannot create another categorization with the same attributes of Company (ABC Company) and Category 1 (Hardware). You can create another entity where the Company is ABC Company, Region is North, and Category 1 is Hardware. Or you could create a categorization where Company is ABC Company and Category 1 is Software. You can create any attribute you want as long as no other categorization exists where all of the attributes are an exact match of another categorization. The purpose here is to prevent the creation of duplicate categorizations.

▶ To create a time segment

1 In the console, choose Advanced > Time Segments in the navigation pane.

2 Click one of the following options:
   - Business Event
   - Op. Category Location

3 The Search Business Event/Location Definition dialog box or Search Operational Categorization/Location Definition dialog box appears.

**Figure 5-23: Search Business Event/Location Definition dialog box**

4 Click New.

The Business Event/Location Definition dialog box appears.
Enter the minimum information required to create a *unique* time segment for the business event or categorization, for example, a time segment with a title of ABC-Hardware, ABC Company as the company, and Hardware as the category.

6. Save your changes.

The time segment you created appears in the table list.

**To select and register time segments**

1. In the console, choose Advanced > Time Segments in the navigation pane.

2. Click one of the following options:
   - Business Event
   - Op. Category Location

   The Search Business Event/Location Definition form or Search Operational Categorization/Location Definition form appears. These forms function in much the same way. You use them like a wizard. Here you must search for and select an existing time segment.

3. Click Select to choose an existing time segment.

   You can also enter parameters in the form to search for existing time segments.

   The Registration for Shared Time Segment form appears.
4 Use the following buttons to register the time segment.

**Add**  
Opens the Business Time Segment dialog box that allows you to create a new time segment and associate it to the entity. For information, see “Adding time segments” on page 188.

**View**  
After selecting a schedule time, this opens the Business Time Segment dialog box that allows you to modify the details of a time segment. For information, see “Viewing time segments” on page 191.

**Search**  
Brings up a Search dialog box that allows you to search an existing business event or categorization. For information, see “Searching time segments to relate” on page 192.

**Remove**  
Removes the associated link to the time segment but does not actually delete the time segment or entity, since there is a many-to-many relationship between entities and time segments. One time segment can be related to many entities. After clicking Remove, the Time Segment and the Entity still exist but do not appear in the table. For information, see “Removing time segments” on page 193.

5 Click Finish to save your changes.
Modifying time segments for business events and categorizations

Use the following steps to modify time segments for business events and categorizations.

To modify time segments for business events and categorizations

1. In the console, choose Advanced > Modify Business Events, or Advanced > Modify Op. Category Location in the navigation pane.
   The search form appears.

2. (Optional) Enter search parameters to filter the time segments displayed and then click Search.

3. Pick a time segment from the list and then click Select.
   The Business Event/Location Definition dialog box appears.

Figure 5-26: Business Event/Location Definition Search dialog box

4. Modify the time segment as needed, for example, change its location.

5. Save your changes.

Adding time segments

Use the following steps to add time segments to business events, categorizations, or CIs. You must create entries in the Time Segment form for use with time segment functionality.
When adding time segments, if your client is in the same time zone as the server, then you will not notice any difference between client and the server. If the client and server are in different time zones, then all dates and times for the Business Time Segments appear in the adjusted server time. That is, the Start Date, Start Time, End Date, and End Time on the Business Time Segment form, as well as the time segments date and times that are shown using a table field, are displayed in the adjusted server time. All other dates and times on the rest of the form are in the client’s time.

For example, say that your server is in EST and your client is in PST. If you create a Time Segment from the Schedule Assist form for 8:00:00 a.m. PST, the system adjusts the time to 11:00:00 a.m. EST. As a result, you might want to add to the description the time and time zone that the Business Time Segment was actually created in. For example, if the Time Segment was 8:00:00 a.m. to 9:00:00 a.m. PST, you might want to add the following description on to the end of the description (8AM-9AM PST). Otherwise, the actual time segment would be converted to EST, which would be displayed as 11:00:00 a.m. to 12:00:00 p.m.

Also, all time segments need to adjusted into the time zone of the client. For example, if the ticket was created in PST, the details would need to be adjusted into PST. If a Time Segment for a server is created in CST, it would need to be adjusted into PST when creating the time segment for the client.

For more information about adjusting for the time zone differences between the client and the server, see the *BMC Remedy Action Request System 7.0 Configuring* guide.

---

**To add time segments**

1. Search for and select a business event, categorization, or CI.
2. Click Add.
   
The Business Time Segment dialog box appears.
3 In the Description field, enter a description for the time segment.

4 In the Availability field, select Available or Unavailable.

   You use the availability function to block periods of time.

   - Select Available if you want to create a time segment open for regular use, for example, routine scheduled maintenance.
   - Select Unavailable if you want to create a time segment that is not available for any other use, for example, a CI outage when you shut down a server to add more memory.

5 In the Level field, select a level 10 or higher.

   Change Management activities start with a default level of 10, but this level can be changed to a number from 11 through 1000. Level 1 is Workday activities and Level 2 is Holiday activities.

   If the schedules for two activities conflict, the event with the highest number takes priority. For more information, see the Action Request System 7.0 Configuring guide.

6 In the Duration Type field, select One time (which creates a single occurrence of the time segment) or Recurring (which cannot span multiple days; it must be scheduled within a 24-hour period).
If you select Recurring, you must specify the recurrence, for example, daily as dictated by the tab that appears when you select the option. (All the options accept a start date and return the next date.)

**Figure 5-28: Recurrence Definition tab**

7 Enter the starting and ending dates and times for the duration of the time segment.

**Tip:** To create an all-day event, select 12:00:00 a.m. of the first day for the start time, and select 12:00:00 a.m. of the following day for the end time.

8 (Optional) For a one-day event, use the same start and end day and then select End of Day.

This action sets the End Time to 11:59:59 p.m. However, the field is then disabled when the calculation is performed: the end of day is actually considered the whole day and not missing the one second.

9 Save your changes.

A message appears, alerting you that a business time segment has been created. The time segment is displayed in the Schedule Time table.

10 Click Finish.

**Viewing time segments**

Use the following steps to view time segments for business events, categorizations, or CIs.
To view time segments

1. Search for and select a business event, categorization, or CI.
2. Click View.
   The Business Time Segment dialog box appears.
3. Close the dialog box when you are finished viewing the information.
4. Click Finish.

Searching time segments to relate

Use the following steps to search time segments and relate them to business events, categorizations, or CIs.

To search time segments to relate

1. Search for and select a business event, categorization, or CI.
2. Click Search.
   The Search Time Segment dialog box appears. All published time segments are displayed in the table. You can enter different search parameters, for example, a different duration type or status, and then click Search to view a different list of time segments.
3. Click Search.
   When searching, the Date, Time, and Level fields must be filled in. If they are not, they are auto-populated. When searching, the system looks at the level specified or higher.
4. Select as many time segments as needed.
5. Click Relate.
   The Search Time Segment dialog box closes and the time segments are added to the business events or categorization.
6. Click Finish.
Removing time segments

Use the following steps to remove time segments from business events, categorizations, or CIs.

Note: Removing time segments does not physically delete them or the business event. Instead, you are merely removing the link between the business event and the time segment.

To remove time segments
1. Search for and select a business event, categorization, or CI.
2. Click Remove.
   The time segment is removed from the list of scheduled times.
3. Click Finish.

Working with CIs

Important: If you have Asset Management installed, use the Outage and Maintenance Schedule to create time segments for CIs. You should only use this interface if you have only the Asset Inventory piece of the Change Management application, which does not have the same interface as Asset Management.

Creating or modifying time segments for CIs is a two-step process:

Step 1 Search for a specific CI.

Step 2 Add, view, search, or remove the time segments.

To create time segments for CIs
1. In the console, choose Advanced > Time Segments > Configuration Item (CI) in the navigation pane.
   The CI Advanced Search dialog box appears.
Enter the information necessary to search for a CI and then click Search. The available CIs based on your search criteria are listed in the results table.

(Optional) Click CI Relationship Viewer to view a CI and its relationship in a tree structure. For information, see “Viewing CI relationships” on page 195.

Choose a CI and then click Select. The search window closes and the CI becomes registered in the Registration for Shared Time Segment form.

Use the following buttons to add, view, search, or remove time segments for CIs.

- **Add**: Opens the Business Time Segment dialog box that allows you to create a new time segment and associate it to the entity. For information, see “Adding time segments” on page 188.
- **View**: After selecting a schedule time, opens the Business Time Segment dialog box that allows you to view the details of a time segment. For information, see “Viewing time segments” on page 191.
- **Search**: Brings up a Search dialog box which allows you to search for an existing time segment. For information, see “Searching time segments to relate” on page 192.
After you have associated the time segment to the CI, click Finish.

**Viewing CI relationships**

The CI Relationship Viewer displays CIs and their relationships to other CIs within the BMC Atrium CMDB. The CI Viewer is an important tool you can use to improve the accuracy of change planning—you no longer have to hunt and guess where the CI is. For more information, see the *BMC Remedy Asset Management 7.0 User’s Guide* and the *BMC Atrium CMDB 2.0 User’s Guide*.

**Figure 5-30: BMC Atrium CMDB—CI Relationship Viewer window**

To use the CI Relationship Viewer

1. In the CI Advanced Search dialog box, click the CI Relationship Viewer button.

   The CI Relationship Viewer appears.
2 From the Template menu, select the filter you want to use to limit the data displayed in the relationship viewer.

A filter template specifies a criteria for the relationship information that is displayed in the relationship viewer.

3 Click Refresh to apply the selected filter template.

The relationship image is reloaded with the selected data. The Legend on the right pane displays the relationship types.

**Searching for available times for change requests**

The Time Segment Analysis window assists you in creating schedules. You can search available time segments that a change request can be scheduled around. Your search takes into account the selected time segments tied to the change request’s categorization. You can create or use existing time segments around the associated CIs. Finally, you can include the associated CI’s unavailable time segments to find a Scheduled Start or Scheduled End Date and Time for the change request.

Items displayed in the Global Time Segments table are based upon the following criteria:

- Start Search Date Range
- End Search Date Range

The table displays Business Events and Operational Categorization Location time segments that match the Operational Categorization and the Change Location of the current change and any items that are global.

It also displays items that are *exact* match of the Categorization and Location and those above it. For example, suppose that the Location of the change request uses the following parameters:

- Company = ABC
- Region = West
- Site Group = California
- Site = Sunnyvale

Then the search would match any business event records that match all four parameters or less. If a business event existed for Company = ABC, this time segment would match also.
The date range also influences which time segments are displayed. This criterion affects all of the tables showing time segments. The table displays any items that intersect the Start Date and End Date search range. For example, suppose that the Start Date range is 3/1/06 and the End Date Range is 3/15/06, examples of what it could include are the following business time segments:

- Business time segment 1/1/06 to 3/8/06
- Business time segment 3/10/06 to 3/31/06
- Business time segment 1/1/06 to 7/1/06

To search available times for change requests

1. To search for available times, make sure the Operational Category and Change Location information is entered.

2. In the Dates tab, click the time segment icon.

The Time Segment Analysis window appears.

Figure 5-31: Time Segment Analysis window—Searching for available times
You use this window to analyze the time segments and search for available times. The following fields are available.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start Search Date</strong> Range</td>
<td>Set by default to current date.</td>
</tr>
<tr>
<td><strong>End Search Date</strong> Range</td>
<td>Set by default to current date plus 30 days. Use these dates to filter the information in the table fields.</td>
</tr>
<tr>
<td><strong>Global Time Segments</strong></td>
<td>Displays all time segments tied to the change. By default, all Time Segments are selected. You can clear specific time segments if you do not want to include it in the calculation. Clear the Include All field to select individual time segments.</td>
</tr>
<tr>
<td><strong>Associated CI’s</strong></td>
<td>Displays a list of all of the CIs that are tied to the change, and that have an entity tied to CI.</td>
</tr>
<tr>
<td><strong>CI’s Available/Unavailable Times</strong></td>
<td>Displays available or unavailable times that are tied to the selected CI. If one CI is selected from the CI’s Available/Unavailable Times table and then you press =&gt;, only the Time segment tied to that CI is displayed. For each additional CI selected on the Associated CIs table, all the associated time segments to each of the selected CIs when you click =&gt; are displayed. If you select Available times as a type, the Use Available button is enabled. Clicking Use Available populates the Available Start Date/Time+ and Available End Date/Time+ fields from the selected record. If more than one record is selected, only the first selected record is used to populate the fields. If more than one CI is selected when you click the Use Available button, only the first selected record is used. If there are unavailable times, all the times that are selected from the unavailable table plus the selected global blackouts on the top plus the Duration and Level fields are used in the calculation when the Find Next Avail Time button or Create Next Free Time button is used (except for those times created using the Create Next Free button).</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>Lets you define the length and level of the time segment. For example, you can create a level 10 time segment of 2 hours.</td>
</tr>
</tbody>
</table>
Planning the change request

3 Create any time segments needed for the CIs.

This allows you to create new time segments for CIs based on selected time segments and unavailable times of other CIs. Change Management only allows for the creation of time segments with a duration type of One Time.

After all of the time segments are created, the Change Assignee or the Change Manager can schedule the change request based on all of the selected unavailable items or based on an Available schedule.

4 Click the Find Next Available Time button.

Based on all the selected time segments in the tables on the Time Segment Analysis form, the time segment is entered into the Available Start Date/Time+ and Available End Date/Time+ fields.

5 Click Schedule Time Segment.

The Associate Time Segment to CIs dialog box appears.
Figure 5-32: Associate CIs to Time Segments dialog box

6. Use the following steps to associate CIs to time segments.
   a. Select which CI you want to associate the time segment to.
   b. Enter a description of the time segment.
      If your server is located in a different time than the client, make sure you include this in your description. For more information, see "Adding time segments" on page 188.
   c. Click Create Time Segment.
   d. Close the dialog box.

The time segment is then created and associated to the CI.

The actual date and time might not be exactly what you specified, if the same time segment has already been selected. If so, the first available time is returned for the given CIs. This functionality is similar to a calendar system. If you try to reserve a conference room, and you do not book it immediately, someone else could have taken the room before you booked it.

7. Click Next.

The Time Segment Analysis window helps the support person pick a scheduled start and end date of the change request. From looking at all the existing time segments, you can try to plan your change around the given time segment.
The Time Segment Analysis window redisplays to let you schedule dates. The scheduled start and end date of the change request does not always have to match the unavailable time segments. For example, if you have a time segment from 1/30/06 from 2:00 p.m. to 3:00 p.m., your scheduled change does not have to be 1/30/06 from 2:00 p.m. to 3:00 p.m. The actual change process can be much longer. For example, your scheduled change might go from 1/25/06 8:00 a.m. to 2/2/06 8:00 a.m. You might need to perform additional duties to prepare for the change and then allot additional time afterwards to verify that the change took place successfully.

Figure 5-33: Time Segment Analysis window—Scheduling dates

The CI’s Available/Unavailable Time table displays all time segments associated to all of the CIs.

The following fields are available to set the Schedule Start and Scheduled End Date/Time of the change request.

- **Start Search Date Range**: Set by default to current date.
- **End Search Date Range**: Set by default to current date plus 30 days. You use these dates to filter what shows up in the table fields.
- **Global Time Segments**: Displays all of the global time segments to the change request.
Enter the scheduled start and end date.

Click Next.

The Time Segment Analysis window closes. The change request appears, with the time segment values returned.

Save the change request.
Assessing risk and impact

When you are planning a change request, you use the Change form to describe the change and to show which products and services are affected by the change. You are required to define the Change Type, Impact, Risk Level, and Urgency before you can submit a change. You also must use the Classification tab to specify the Timing of the change. Selecting these values automatically determines the Risk Level and Lead Time for the change.

Risk assessment helps you achieve greater productivity by combining qualitative and quantitative criteria for assessing the risk level associated with a change. You can raise the accuracy of the changes by assessing risks with a consistent and standard process. The end output is a Change Risk Report which can provide a key decision in change planning.

When approvers review a proposed change request, they want to see an analysis of potential risks and the impact of the change request.
During the planning phase, you should assess the risk of your change request. Risk information is useful for approvers who need to approve the change request. Risks can include (but are not limited to) the number of people affected, financial concerns, loss of productivity due to system or network downtime, resource allocation, and seasonal considerations, such as vacations, holidays, and weather. Impact analysis should be based on how many people are affected by the proposed change, and where those people are located. Here you can select the anticipated risk that this proposed change has—from 1 (highest risk) to 5 (lowest risk).

You can also compute the risk of a change request. Risk factors can include a set of questions that allow a risk value to be calculated. During configuration, your application administrator determines a set of questions, as well as a weight for each question, that apply to a specific company or globally to all change requests. The support staff assigned to each change then provides the risk value and probability for the question as it pertains to their specific change request. The total risk is calculated by the system, and saved in the Risk Level field of the Change form.

Finally, you can view a report of the total impact of your risk changes.

The Change form includes the following fields for risk management:

- **Risk**—Enter the anticipated risk that this proposed change has—from 5 (highest risk) to 1 (lowest risk).
- **Impact**—You can determine the impact this change has based on the number of users who are affected.
- **Lead Time**—In the Classification tab, enter the number of business hours. Lead time is used to compute the Earliest Start Date and uses the business hours and holidays configured for the Change Manager’s support group.
- **Performance Rating**—In the Classification tab, rate the work done by support staff or the manager in completing the change request. Usually, the manager of the support staff assigned to the change request fills in this rating after the change request is closed.

**Note:** To configure the risk levels, see the *BMC Remedy IT Service Management 7.0 Configuration Guide.*
To assess the risk of the change request

1. Open your change request in the Change form.
2. In the Risk Level field, select the appropriate level of risk for the change request.
   The range of risk runs from Risk Level 5, the highest risk, to Risk Level 1, the lowest risk. You can also select a computed risk value, based on your answers to a series of predefined questions. The system then calculates and saves the risk level.
3. Click Save.

To compute risk levels

1. Open your change request in the Change form.
2. Click the compute risk icon.
   The Risk Assessment Questions dialog box appears.

   Figure 5-35: Risk Assessment Questions dialog box

3. Answer the questions of the different risks.
4. Save your changes.
5. To view and print a report of the total impact of your risk changes, click View Risk Report in the navigation pane.
   The Change Risk Report dialog box appears.
Planning dependencies for change requests

When planning how to implement a series of change requests, determine in what order, if any, they must be completed. You can create a sequence of change requests that are dependent on one another.

To set dependencies among change requests, you assign a sequence number to each change request. Change requests with lower sequence numbers must be completed before those with higher numbers can be completed; otherwise, you are notified by a warning message (by default). More than one change can have the same sequence number; changes with the same sequence number are considered peers. You define the sequence numbers in the Classification tab of the Change form.
When sequence numbers are assigned to change requests, the change requests must be completed in numerical order. For example, a change with the sequence number 3 can be completed only after all changes with sequence numbers 1 and 2 are completed.

When a change request is scheduled, the first task is activated and set to Assigned. When the last task is completed and its status is set to Closed, the change request is Completed.

Related topics:
- “Relation of task states to change states” on page 214
- “Specifying sequences with dependent change requests” on page 247
Understanding the approval process

**Important:** The Change Management application has defined the approval processes for you, out of the box. Most companies should not have to define additional approval mappings. However, you can use the Approval Process Configuration form to create additional approval mappings for your company.

The change manager or change assignee controls the overall progression of a change request, and have the opportunity to perform approvals at several points in the change life cycle. For change requests in the Request for Change status with no approvers, the change manager and the change assignee have the opportunity to move the change forward to Planning In Progress, cancel it, or send it back to the requester by assigning it a status of Draft. For more information about approval phases, see “Steps in the life cycle of a change request” on page 44.

Figure 5-38: Change request going through approval process

After a change is planned and built, the change request is set to a status of Scheduled for Review. Once again, the Change Manager or Change Assignee have the opportunity to review change plans, schedules, and so on, before moving the change to the Implementation Approval phase.

Impacted Areas, which automatically defaults to the change location, must be specified to generate automatic approval requests. For more information, see “Viewing impacted areas” on page 153.
Figure 5-39 shows the Approvers tab.

**Figure 5-39: Change form—Approvers tab**

The following buttons control functions involving Approvers:

- **View Notifications**—Opens the APR:Non-ApprovalNotifications form so that you can view notifications in either Pending or Notified status. For more information, see “Viewing non-approver notifications” on page 353.

- **Add**—Creates a new individual or group to approve the change. For more information, see “Adding approvers” on page 352.

- **Approve**—Allows a Change Manager or Change Assignee to approve the change on behalf of the selected approver.

- **Reject**—Allows a Change Manager or Change Assignee to reject the change on behalf of the selected approver.

The read-only Current Approval Phase field displays what approval phase the change is in during its life cycle. For more information, see “Approval phases” on page 348 and “Change request status transitions” on page 367.

### Approving or rejecting change requests

When an approval is required to move the change request to the next state, the Process Status Flow area prompts you to approve, cancel, or reject the approval. You cannot move the change request to the next state unless you first receive an approval.
When a change requires an approval, its approvers are notified. Notifications are sent according to the method specified in the approver’s record in the People form.

**Note:** You use the Approval Process Configuration form to configure the sequence when a change request is approved or rejected, or how the system should respond if no approvers are available. For more information, see the *BMC Remedy IT Service Management 7.0 Configuration Guide*.

When you have finished planning the change request, and have supplied all the information that the approvers require to review the change request, you can submit the change request to the approval process.

1. **To approve the change request**
   1. Open the change request.
   2. Step through the states of your change request until you reach an approval stage.

![Figure 5-40: Approving the change request](image)

3. Do one of the following tasks:
   - Click the accelerator in the Process Flow Status area and then approve, cancel, or reject the change request.
   - Click the Approvers tab and then approve or reject the change request.

   If the change is configured for the change level approval process, all approvers on the first level are notified that they must review the request.

   If the change is configured for the change management chain (parent-child) approval process, the requester’s manager is notified.
The signature of the last approver completes the approval process, and automatically moves the change request to the next state.

4 Save your changes.

For more information, see “Approving or rejecting change requests” on page 349.

Handling approvals for emergency change requests

If you determine that the timing of a change request is an emergency, you must first relate it to an incident.

But depending on how the application administrator has configured the application, change requests that have been designated as emergencies can be allowed to bypass the approval process even if they normally require approval.

These are possible configurations:

- The application administrator can configure emergency change requests to bypass the normal change states and approval process. To configure a new approval process for emergency changes, the application administrator must create a new approval process for your company. As a result, when a change manager or change assignee creates a change and selects Emergency in the Timing field, the new approval process phase is then used. For more information, see the BMC Remedy IT Service Management 7.0 Configuration Guide.

- The change manager or the change assignee can choose to add approvers to the process. The Approval Status field is set to Approval Required.
  - If the change manager assigns approvers, the approval process proceeds as usual. The change manager is automatically assigned to be an approver.
  - If the change manager does not assign approvers, the Approval Status is set to Approved, and the change request can be implemented.

If the change request is designated as an emergency and your organization uses the supervisor choice approval process, the change manager must define who (if anyone) must approve the request. Change managers can also review the list of defined approvers and add more approvers if appropriate. They cannot delete approvers.
Resubmitting a rejected change request

If an approver rejects a proposed change request, the approval process is stopped. The Status field is set to Pending; the Status Reason field is set to Manager Intervention. You can resubmit the request for approval.

1. Open the change request.
2. In the Status field, select Draft.
3. Click the Work Info tab and explain in the Details field why you are resubmitting the request for approval.
4. Save your changes.

Implementing the change request

You can move the change request into the Implementation Approval Phase by changing the Status to Scheduled for Approval. If the change request includes tasks, the task implementers are then notified of their task assignments.

1. Open the change request.
2. In the Status field, select Scheduled for Approval.
3. Save your changes.
Working with tasks

When you plan a change request, determine whether you can divide it into separate tasks. Tasks are the individual components of a change request and are assigned to task implementers who complete the tasks.

The Tasks tab displays the tasks that are required to be performed to complete the change. You can use task groups to manage changes with many tasks, each having its own schedule, task implementer, and plan. For less complex changes, tasks are optional. Tasks are created and modified within the change and are stored separately within the Tasks form. A single change can have an unlimited number of tasks.

After a task is assigned to a support group or an individual, the assignee receives notifications to perform the various task activities based on the change process.

For more information:

- “Relating ad hoc tasks to change requests” on page 218
- “Relating predefined task group or task templates to a change request” on page 221
Relation of task states to change states

Tasks, like change requests, go through many state transitions as they progress. The status in which a task is created depends upon the status of the parent change request.

Figure 5-42: Overview of change and task states with approval phases

Changes, approval, task groups, and tasks follow the flow described in Figure 5-42.
Step 1a Change manager or change assignee is notified when a request is moved from Canceled to Draft (Rescheduled Notification). The change requester is notified of the rescheduled change. Any task groups or tasks are in the Staged state.

- If a change request is canceled, all the task groups and tasks associated with the change are canceled as well.
- If a task group is canceled, all its tasks are canceled as well.

Step 1 The change request moves into the Request For Authorization state and the approval group or approvers are notified that the change request requires approval for the Review phase. Any task groups or tasks are in the Staged state. Tasks are marked as Staging in Progress in the Status Reason field.

Step 2 Change manager or change assignee is notified when the change request is moved into Request for Change state. Change manager or change assignee are also notified when the request is moved from Canceled to Request for Change (Rescheduled Notification).

Step 3 Approval group or approvers are notified that the change request requires approval for the Business Approval phase.

Step 4 Change manager or change assignee is notified when the change request is ready for planning. For taskless changes only, the change implementer is notified.

When the status reason of all the tasks have been marked as Staging Complete, the change moves to the Schedule for Review state.

Step 5 Task implementers are notified that the task group or tasks are set to Staged.

Step 6 Change manager or change assignee is notified when the change request is scheduled for review.

Step 7 Approval group or approvers are notified that the change request requires approval for the Implementation Approval phase.

Step 8 Change manager, change assignee, and change requester are notified when the change request has been scheduled as a change with no impact. For taskless changes only, the change implementer is notified. Tasks can be set to the Assigned state.
Step 9  When change request is moved into the Implementation in Progress state, the task group is set to Work in Progress and the first task is set to Pending or Assigned.

The task implementers are notified to start working on tasks. They set the task to Work in Progress when actual work begins. Task implementers can now update the task information and start implementing the task.

Step 10  After last task is marked as Closed, the task group is set to Closed. The change manager, change assignee, and change requester are notified that the change request is completed. Workflow enters required information into the Actual Start Date, Actual End Date, and Performance Rating fields.

Step 11  Approval group or approvers are notified that the change request requires approval for the Close Down phase.

Step 12  Change manager or change assignee is notified when the final review is completed.

Step 13  If change request is canceled, requester is notified.

Viewing task groups and tasks

Your assigned tasks and task groups are listed in the Assigned Tasks table on the Change Management Support Console. Tasks are prefixed with TAS and task groups with TGR.

You can also view tasks and task groups related to a change request from within the Tasks tab of the Change form.

Figure 5-43: Change form—Tasks tab
Important: You can click the View Flow button to see a read-only view of the task flow in the task group. For more information on using the View Flow button, see “Using CCM tasks” on page 336.

To view task groups and tasks

1 In the Assigned Tasks table on the Change Management Support Console, or from within the Tasks tab of a change request, select the task group or the task that you want to view.

2 Click View.

Tasks are displayed in the Task form, while task groups are displayed in their Task Group form.

Figure 5-44: Task form
Relating ad hoc tasks to change requests

You can relate an ad hoc task to the change request, as appropriate. The status of these tasks in Change Management can be Staged, Assigned, Pending, Work in Progress, or Closed. You can manually set the assignment for any task. Finally, if you close the task, you must select whether you are canceling the task or completing it as a success or failure.

To relate an ad hoc task to a change request

1. Open the change request.
2. Click the Tasks tab.
3. In the Type field, select Ad hoc.
4. Click Relate.
The Task form appears. Certain fields in the form are already populated with the data for the change request.

You can click the Open link next to the Request ID field to open the parent change request.

5 In the upper region of the form, fill in the following required fields:
   - **Name**—Enter a descriptive name of the task.
   - **Summary**—Enter a brief description of the task.

The Type field is set by default to Manual when you create an ad hoc task.

6 In the General tab, fill in information about the company.

   The Company field defaults to the contents of the Change Location field in the Change form. Your task can be assigned to a different department or company.

7 In the Requester tab, fill in information about the person creating the task (Requester) and the intended target of the task (Requested For).

   Some information is set by default from the Requested By information of the change request.

8 In the Classification tab, fill in information about the product and operational categorizations.
In the Assignment/Dates tab, fill in the following fields to assign the task:

- **Assignee Group**—Optionally, select a task implementer group from the list.
- **Assignee**—Optionally, select a task implementer from the list.

The assignment engine automatically assigns the task when the task is created according to how the administrator has configured the application, but you can override this if needed. For more information about assignment configuration, see the *BMC Remedy IT Service Management 7.0 Configuration Guide*.

- **Scheduled Start Date**—Optionally, enter an estimated start date.
- **Scheduled End Date**—Optionally, enter an estimated end date.

You might want to set the Start Date and End Date to be different from the dates of the parent change request.

In the Relationships tab, search for and then relate configuration items, LDAP objects, and software library items that are needed with this task.

- You can select and relate various record types, for example, a configuration item.
- You can execute any quick actions that are connected with the task, for example, get related relationships.

When you have finished creating the task, click Save. The task information form closes and you return to the Change form. The task management subsystem enforces the dependencies between tasks. These relate to any Sequence order you might have specified in the Change form.

Related topics:

- “Relating predefined task group or task templates to a change request” on page 221
- “Assigning a sequence number to task groups and tasks” on page 224
- “Modifying tasks” on page 226
Relating predefined task group or task templates to a change request

You can relate a predefined task or task group template to the change request. Change Management comes installed with the following predefined “best practice” task group and task templates that you can use out of the box for installing or deploying software and verifying task completion. These templates were specially created for the integration with BMC Configuration Management.

Other templates might have been added by your application administrator.

**Create and Modify Policy with Closed Loop Verification**
- Task group that includes the following tasks:
  - Create and Modify Policy
  - Closed Loop Verification (automatically)
- You use this task group template when creating or modifying a BMC CM based policy. This template automatically performs a closed-loop verification to make sure that the task was executed properly.

**Closed Loop Verification (automatic)**
- Automatic task that calls BMC Configuration Management Policy Manager to set up compliance parameters for Closed Loop Verification. It verifies the task automatically against compliance status.

**Create and Modify Policy**
- Manual task that creates or modifies a policy using Policy Manager. It adds the CI and SLI using the Relationships feature on task.

**Deploy Package**
- Manual task that deploys a package using BMC Configuration Management Deployment Manager. It adds the CI and SLI using the Relationships feature on task. Verification of a Deployment Manager task is based on the exit status of the Deployment Manager job itself.

**Execute Remote Command**
- Manual task that executes a remote command using BMC Configuration Management Deployment Manager. Verification of a Deployment Manager task is based on the exit status of the Deployment Manager job itself.
To add predefined task group and task templates to a change

1. Open the change request.
2. Click the Tasks tab.

3. Select Task Group Template or Task Template from the Request Type list and then click Relate.

   The Select Template dialog box appears.

   - **Execute Remote Script**
     Manual task that executes a remote script using BMC Configuration Management Deployment Manager. You use the Task Attachments table to define the remote scripts to be used. Verification of a Deployment Manager task is based on the exit status of the Deployment Manager job itself.

   - **Verify Target Status**
     Manual task for manually verifying the status of a target against BMC Configuration Management. You use this task to verify that a specified target is in compliance with the policies to which the target has been assigned.
All template types for all categories are listed. But you can filter the list by selecting the type and category of template.

4 (Optional) Filter the templates by taking the following steps:

a Select the type of template:
   - With task group templates, select Task Template or Task Group Template.
   - With task templates, select Manual, Automatic, or ALL.

b (Optional) From the Category menu, select which application the task belongs to, for example, Change Management System.

The available task groups or tasks for that selection are displayed in the list. The categorization of the change request determines which list items appear.

5 (Optional) Click View to see more details about the task group or task template.

6 If a relevant task set is displayed on the list that you want to include with the change request, select it, and click Relate.

The dialog box closes and you are returned to the change request.
7 Repeat steps 3 through 6 for all templates you want to add to the change.
   The templates you selected are displayed in the Tasks and Task Groups list. If there are no templates listed, refresh the table.

Figure 5-49: Task groups and tasks included in a change request

8 Define a numerical sequence of the tasks, as described in “Assigning a sequence number to task groups and tasks” on page 224.
   The task management subsystem enforces the dependencies between tasks. These relate to any Sequence order you might have specified in the Change form.

9 When you are finished adding templates, save the change request.

Related topics:
- “Relating ad hoc tasks to change requests” on page 218
- “Modifying tasks” on page 226
- For additional information about searching for tasks assigned to you or your group, see “Searching for assigned tasks” on page 333.

Assigning a sequence number to task groups and tasks

When you include task group templates, task templates, or ad hoc tasks in a change request, they are automatically assigned a sequence number in the order in which you add them to the change request. Their sequence is strictly enforced inside the change.

To renumber a task group or task, you can use the arrow buttons next to the Tasks and Task Groups table. Tasks with lower sequence numbers, for example 1, must be completed before those with higher numbers, for example, 2, 3, or 4. More than one task group or task can have the same sequence number; task groups and tasks with the same sequence number are considered peers. Peer tasks can be completed in any order among themselves.
To assign a sequence to task groups and tasks

1. Open the change request.
2. Click the Tasks tab.
3. Add task group and task templates to the change, or create ad hoc tasks.
   Your task groups and tasks appear in the Task and Task Groups table.

4. Renumber the tasks by clicking the arrow buttons.
   To move it a task up or down in the sequence, select it and click the arrows. When you move a task up in the sequence, it becomes a peer of any task of already at the level you move it to. For example, if you move the Upgrade OS task up one level, there are now two peer tasks with sequence number 4, Upgrade OS and Provide login id. You can work on these two tasks in any order.

5. To make the Provide login id task dependent on the Upgrade OS task and follow task 4, select it and click the down arrow once.
   The sequence number is changed to 5 in the table.
When the change request’s status is set to Scheduled, the first task in the list is activated and its status is set to Assigned. The status of the other tasks is set to Pending. When the last task is completed, the change request is closed.

6 Save your work.

Modifying tasks

You can access the task from either the Change Management Support Console, or from within the change request.

To modify tasks

1 In the Change form, click the Tasks tab.
2 Select the task you want to modify.
3 Click View.

The task opens in the Task form in a modify window.
4 Modify the task details as needed.
5 Save and close the form.

Related topics:

- “Relating ad hoc tasks to change requests” on page 218
- “Relating predefined task group or task templates to a change request” on page 221

Assigning tasks

You can assign a single task to a task implementer, or you can assign all the tasks listed in the Change form to a single task implementer.
To assign a single task

1. In the Change form, click the Tasks tab.
2. Select the parent task or child task that is already related to the change request.
3. Click View.
   The task opens in the Task form.
4. Select the Assignment tab.

   Figure 5-53: Task form—Assignment tab

5. If necessary, select the group or person who will work on the task from the Assignee Group or Assignee lists.
6. Save and close the form.
   The implementer for that task is notified of the task assignment.
   When all tasks related to a change request have been set to Scheduled, the change request’s Status is automatically moved to Scheduled.

To assign all tasks in a change request

1. Open the change request in the Change form.
2. Set the Status field to Scheduled.
   The status of the first task is set to Assigned.
3. Save your changes.
   The change request is set to Scheduled. All implementers for the related tasks are notified of their task assignments.
Planning the time for tasks

You can plan the time for individual tasks. The Dates tab in the Task form includes fields where you can enter scheduling information. You can create the time segments required to complete individual tasks.

Figure 5-54: Task form—Dates tab

To plan the time for tasks

1. Open the task.
2. Click the Dates tab.
3. In the Dates/Time region of the form, provide dates for the Scheduled Start Date and Scheduled End Date fields.
4. In the Time Segment Action field, select the following options:
   - Analyze Time Segments
   - Create Business Event Time Segment
   - Modify Business Event Time Segment
   - Create Categorizational Time Segment
   - Modify Categorizational Time Segment
   - Create/Modify CI Time Segment
   For more information, see “Registering time segments” on page 183.
5. Save and close the form.
Tracking the time spent working on tasks

You can track the time spent working on a task at any time after it is created. Most likely, you want to use this feature between the time the task status is in Implementation In Progress and Closed. There are three ways to track the time spent working on a task:

- **Use the start and stop clock buttons**—The time is automatically calculated based on when you click the start and stop clock buttons.
- **Manually enter in the time**—You can enter a time into the Time Spent field directly.
- **Enter work into the effort log**—You can create an effort log entry.

**Figure 5-55: Task form—Assignment tab**

> **To track the time spent working on a task using the start and stop buttons**

1. Open the task.
2. Click the Assignment tab.
3. Click the Start Clock button.

   The current date and time are displayed in the read-only Start Time field.
4. Click Save.
5. When you have finished working on the task and want to stop tracking the time, click the Stop Clock button. You must repeat steps 1 and 2 first if you closed the task after saving it in step 4.
A message reports the number of minutes spent working on the task. The 
time spent is also added to the value in the read-only Total Time Spent field.

6 Save and close the form.

You can use the start and stop clock buttons as many times as you like. Each 
successive time, the new time is added to the value already in the Total Time 
Spent field.

**To track the time spent working on a task manually**

1 Open the task.
2 Click the Assignment tab.
3 Enter a number of hours or minutes manually in the editable Time Spent 
fields.
4 Click Save.

The time you entered is automatically added to the value already in the Total 
Time Hours and Minutes fields.

**To track the time spent working on a task in the Task Effort log**

1 Open the task.
2 Click the Assignment tab.
3 Click the Effort Log button.

The Task Effort Log window appears.

**Figure 5-56: Task Effort Log window**
4 Enter information into the effort log. For example, you can enter time spent in hours and minutes as well as other details.

5 Click Add to Effort Log. An entry is added to the effort log. You can view the entry or delete it as needed.

6 Save your changes.

7 Close the task effort log to return to the task.

Adding work information to a task

You can add work information to each task included in the change request. The work information for each task is displayed in the Work Info of Selected Task table on the Change form.

To add work information to a task

1 Open the task.

2 Click the Work Info tab.

To add work information to a task

1 Open the task.

2 Click the Work Info tab.

3 Modify the work information type, if needed.
4 From the Source list, select the source of this information. Information sources can include, for example, email, system assignment, or the Web.

5 Enter the details of your work information record in the Date, Summary, and Work Info Notes fields.

6 To add attachments to the record, right-click in the attachment table and select Add from the menu that appears.

7 From the Locked list, select Yes or No to lock the log.

8 Select the view access:
   - **Internal**—If you want only users within your organization to see the entry.
   - **External**—If you want everyone with access to the system to see the entry.

9 When you have finished updating, save your changes. The Save operation adds your entry to the task’s work history. The Show field allows you to filter out specific work entries based on the type of activity displayed in the table.

10 To see a report of the activities you performed against this task, click Report.

11 To display all existing entries for work information history, click View.

12 Close the Task form when you are finished with it.

---

**Note:** When you return to the Change form, you might need to refresh the Work Info of Assigned Task table to display all the entries.

---

### Canceling tasks

You can cancel tasks by accessing them through the Change form. This action does not delete the task; it sets the status of the task to Closed and the closure code to Canceled.

**To cancel tasks**

1. Open the change request in the Change form.
2. Click the Tasks tab.
3. If necessary, click the Refresh button under the table to refresh it.
Working with relationships and dependent change requests

Change requests can affect and can be affected by other change requests and configuration items. By defining relationships between change requests, you can create a more sophisticated overview of the connections and interdependencies between the current change and other service issues being tracked by your system.

- **Relating change requests to other change requests**—When you work with a change request, you might need to create related requests that address similar issues. For example, a set of related requests could result from many change requests sent to the service desk by one requester. A set of related requests can also result from a single request that encompasses several other requests.

  You can choose to create a series of dependent change requests, where one must be completed before another request can be started. For more information, see “Creating related change requests” on page 244.

- **Relating change requests to configuration items**—When you work with a change request, you might need to view a related configuration item (CI). For example, you might be working with a desktop system that consists of a laptop, mouse, keyboard, and docking station. The CI has information about the specific type of these CIs. For more information, see “Working with related configuration items” on page 250 and “Creating CI unavailability” on page 259.
Relating change requests to LDAP objects—When you work with a change request, you might need to view related LDAP objects. For example, you might want to relate a change request to an LDAP server where all the permission rights are stored that would enable seamless authentication with Policy Manager. For more information, see “Working with related LDAP objects” on page 271.

Relating change requests to software library items—When you work with a change request, you might need to view related software library items (SLI), for example, different versions of Norton Antivirus along with their license contracts. For more information, see “Working with related software library items” on page 273.

Change requests can also be affected by incidents, problems, and so on. Change Management enables you to create relationships between change requests and other types of requests if the appropriate BMC Remedy application has been installed:

Relating change requests to asset configuration—When you work with a change request, you might need to work with a related asset configuration. For example, if you are working on a change request involving a monitor, you should relate the change to the monitor. You might also want to temporarily assign another monitor to the requester because work is being done to the original monitor. In this case, you can relate the change request to both monitor asset records. BMC Remedy Asset Management must be installed and integrated to enable this procedure.

Relating change requests to incidents and problems—When you work with a change request, you might need to relate incidents and problems. For example, if a change request for a server upgrade results in connection problems for the people affected by the change, you can relate their incident to the server upgrade change request as you open the cases. This relationship can provide helpful information to the support staff working on resolving the incident. BMC Remedy Incident Management must be installed and integrated to enable this procedure. For more information, see “Working with incidents related to change requests” on page 277. For problem and known error investigation, BMC Remedy Problem Management must be installed.
Defining relationships

The Relationships tab displays the relationships between the current change request to CIs and other modules inside Change Management.

Figure 5-58: Change form—Relationships tab

You use request types to define these relationships. Table 5-1 displays a list of request types to which you can relate changes, along with their start and end dates. The list varies depending on the other BMC Remedy ITSM applications you have installed with BMC Remedy Change Management.

Table 5-1: Related request types to Change Management modules

<table>
<thead>
<tr>
<th>Request type</th>
<th>Start date</th>
<th>End date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Configuration</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>(Asset Management)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CI Unavailability</td>
<td>Scheduled Start Date</td>
<td>Scheduled End Date</td>
</tr>
<tr>
<td>(Asset Management)</td>
<td>Actual Start Date</td>
<td>Actual End Date</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>Not applicable</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Incident (Incident Management)</td>
<td>Reported Date</td>
<td>Resolved Date</td>
</tr>
<tr>
<td>Infrastructure Change</td>
<td>Scheduled Start Date</td>
<td>Scheduled End Date</td>
</tr>
<tr>
<td></td>
<td>Actual Start Date</td>
<td>Actual End Date</td>
</tr>
</tbody>
</table>
To define relationships

1. Open the change request from which you want to define the relationship.
2. Click the Relationships tab.

The Relationships tab shows the record types that you can relate to the change.

3. (Optional) In the Alternate Data Set field, select a data set to relate with CIs. For more information, see “Relating CIs to alternate data sets” on page 256.

Table 5-1: Related request types to Change Management modules

<table>
<thead>
<tr>
<th>Request type</th>
<th>Start date</th>
<th>End date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Known Error (Problem Management)</td>
<td>Problem Reported On</td>
<td>Correction Action Determined Workaround Determined On</td>
</tr>
<tr>
<td>Problem Investigation (Problem Management)</td>
<td>Problem Reported On</td>
<td>Known Error Created Solution Created</td>
</tr>
<tr>
<td>Software Library Item</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

Figure 5-59: Change form—Relationships tab
4 From the Request Type list at the bottom of the Relationships tab, select the type of record to which you want to relate the current record.

You can relate a change to any of the options listed in the Request Type field, for example, Infrastructure Change. For specific instructions on CIs, see “Relating configuration items to change requests” on page 251.

5 Click Relate.

A search window for the record type appears.

**Note:** The contents of the search form depend on the type of record you chose in the Request Type list.

6 Complete the search criteria tabs with the relevant information, then click Search.

Try to supply as much information as possible in the search dialog box to reduce the overall number of records returned by the search.

Matching results are displayed in a search results table.

7 From the search results table, select the change request with which you want to create the relationship.

8 From the Relationship Type list at the bottom of the search dialog box, select the type of relationship you want to create.

9 Click Relate.

An information message dialog box confirms that the request type has been related to the change request.

10 Click OK to dismiss the dialog box.

11 Repeat step 3 through step 10 for all the request types that you want related to the change request.

12 Close the search window.

The original change request and the related request types are displayed in the Relationships table.
If the request types do not yet appear in the Relationships table, refresh the table (right-click in the table and select Refresh All in Table).

**Using Quick Actions on existing relationships**

The Quick Actions field, located in the Relationships Tab, let you perform advanced actions on existing relationships. Not all actions are available with all request types. Table 5-1 shows the relationship between request types and the available actions you can perform on them.

**Table 5-2: Matrix of request types and quick actions**

<table>
<thead>
<tr>
<th>Request Type</th>
<th>Relationship Quick Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Unavailability</td>
<td>• Get Related Relationships</td>
</tr>
<tr>
<td></td>
<td>• Modify Relationship Type</td>
</tr>
<tr>
<td></td>
<td>• Broadcast CI Unavailability</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>• CI Viewer</td>
</tr>
<tr>
<td></td>
<td>• Get CI Impact/Urgency</td>
</tr>
<tr>
<td></td>
<td>• Get CI Product Categorization</td>
</tr>
<tr>
<td></td>
<td>• Get Contact for Approval</td>
</tr>
<tr>
<td></td>
<td>• Get Impacted Areas</td>
</tr>
<tr>
<td></td>
<td>• Get Maintenance Dates</td>
</tr>
<tr>
<td></td>
<td>• Get Related Relationships</td>
</tr>
<tr>
<td></td>
<td>• Modify Relationship Type</td>
</tr>
</tbody>
</table>

---

238 Chapter 5—Change assignee role
To use quick actions

1. Select the entry from the Relationships table.
2. In the Quick Actions field, select an action.

For example, you can copy relationships from a CI already related to the change request. Table 5-3 lists all the quick actions you can use.

**Table 5-3: Effect of using Relationship Actions**

<table>
<thead>
<tr>
<th>Relationship Action</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>CI Viewer</td>
<td>Opens a graphical CI relationship viewer that displays the selected CI's relationship to other CIs.</td>
</tr>
<tr>
<td>Create New CI Unavailability</td>
<td>Creates a new CI Unavailability record for the selected CI. Note: This option is available only if Asset Management is installed.</td>
</tr>
<tr>
<td></td>
<td>For more information, see:</td>
</tr>
<tr>
<td></td>
<td>“To create CI unavailability where CI unavailability already exists” on page 262</td>
</tr>
<tr>
<td></td>
<td>“To create CI unavailability from CIs already associated with a change” on page 264</td>
</tr>
</tbody>
</table>
Table 5-3: Effect of using Relationship Actions

<table>
<thead>
<tr>
<th>Relationship Action</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get CI Impact/Urgency</td>
<td>Sets the current change request’s Impact and Urgency to the corresponding values of the selected CI.</td>
</tr>
<tr>
<td>Get CI Product Categorization</td>
<td>Sets the current change request’s Product Categorization to that defined in the selected CI.</td>
</tr>
<tr>
<td>Get Contact for Approval</td>
<td>Creates a Change Approver from the contacts that are associated with the selected CI.</td>
</tr>
<tr>
<td>Get Impacted Areas</td>
<td>Copies the impacted areas, as defined in the selected CI, into the current request’s impacted areas.</td>
</tr>
<tr>
<td>Get Maintenance Dates</td>
<td>Sets the current change record’s Scheduled Start or End date, Actual Start or End date, or both dates, to the Maintenance window defined in the selected CI.</td>
</tr>
<tr>
<td>Get Related Relationships</td>
<td>Copies the relationships of the selected record to the change request’s relationships. For more information, see “Copying relationships” on page 240.</td>
</tr>
<tr>
<td>Modify Relationship Type</td>
<td>Modifies the relationship type and enter a new description for the related item.</td>
</tr>
</tbody>
</table>

3 Click Execute.

Copying relationships

When you define a relationship between the current change and another change, the other change request might also have one or more changes related to it. Using the Copy Related Relationships form, which you open from the Relationships tab, you can look at the related change’s other relationships. If you determine that any of these other relationships should be related to the current change, you can define the relationship from this form.

By doing this, you can more thoroughly document all of the change relationships.
To copy relationships

1 From the Relationships table of the Relationships tab, select a change related to the current change.

2 From the Quick Actions list, select Get Related Relationships, then click Execute.

   The Copy Related Relationships form appears. This form contains a table of all other records related to the record you selected in step 1.

3 From the table of related items, select the other items that you want to relate to the current change.

   **Note:** If you want to see a detailed description of the items on the table, select it, then click View. A form appears with detailed information about the selected item. Use this feature to help you determine whether or not you want to relate the other item to the current change.

4 Click inside the Relationship Type field.

   A list of relationship types appears.

   **Note:** The contents of the Relationship Type list depends on the type of change you are trying to create the relationship with.

5 Select the type of relationship you want to create, then click Select.

   A note appears confirming the relationship creation. Click OK to dismiss the note.

6 Close the Copy Related Relationships form.

   The newly created relationship appears in the Relationships table. For more information, see “To copy relationships to another CI already related to the change” on page 254.

Modifying relationships

After you define a relationship, you can change the relationship type and update the relationship description.
To modify a relationship
1. Open the change that has the relationship you want to modify.
2. Click the Relationships tab.
3. Select the relationship from the Relationships table.
4. Choose Modify Relationship Type from the Quick Actions menu.
5. Click Execute.
   The Modify Relationship dialog box appears.

Figure 5-62: Modify Relationship dialog box

6. Modify the Relationship Type or Relationship Description.
7. Click Save.

Viewing relationships

You can limit which relationships are displayed with the current change record. You can also limit the list of associated relationships by selecting Show Related <option>, for example, if you only want to see Known Errors.

To view relationships
1. Select the entry from the Relationships table.
2. To view a specific request type, click the list on the Show Related field, and choose the type of request that you want to view.
The list varies depending on the other BMC Remedy ITSM applications you have installed with BMC Remedy Change Management:

- **ALL**—Shows all related assets, change requests, incidents, CIs, and so on (if you have the corresponding application installed).
- **Asset Configuration**—Shows the related asset records, not including services and configurations. This option is only visible if you have BMC Remedy Asset Management installed.
- **CI Unavailability**—Shows the related CI unavailability tied to the change entry. This option is visible only when Asset Management is installed.
- **Configuration Item**—Shows the related CIs.
- **Incident**—Shows the related incidents. This option is only visible if you have BMC Remedy Incident Management installed.
- **Infrastructure Change**—Shows the related change records.
- **LDAP Object**—Shows the related LDAP objects.
- **Known Error**—Shows the related known errors. This option is only visible if you have BMC Remedy Problem Management installed.
- **Problem Investigation**—Shows the related problems. This option is only visible if you have BMC Remedy Problem Management installed.
- **Software Library Item**—Shows the related software library items (that is, the location where the master copy of the software application and its version are stored).

The related items are listed in the table.

1. Click View.

You can now view the details of the relationship.

For example, if you selected an Incident relationship and clicked View, the Incident Request form opens, letting you view information about the Incident.

**Note:** If you double-click a relationship entry, the associated form opens. You then can modify the record, depending on your configuration.

For relationships external to change management (such as an incident or a problem), the user must have the proper view permissions to view the record details.
Removing relationships

This section describes how to remove relationships from the change request.

► To remove a relationship
1 Open the change request that contains the relationship you want to remove.
2 Select a relationship from the Relationship table.
3 Click Remove.
   A warning appears, verifying that you wish to delete the selected record.
4 Click Yes to delete the selected relationship.
   The relationship is removed from the table.

Creating related change requests

When you work with a change request, you might need to create a related change request. For example, you might need to create related change requests that address similar issues. A set of related change requests can result from many changes needed by one requester at the same time.

► To create a change request related to another change request, with no dependency
1 Select the entry from the Relationships table.

Figure 5-63: Relationships table on the Change form
In the Request Type field, select Infrastructure Change.

Click Create.

A new Change form is displayed.

Fill in the details on the Change form as described in “Creating change requests—Basic steps” on page 162.

When you are finished creating the change request, click Save.

Return to the original change request.

You might need to refresh the Relationships table to see the new related change request you created.

For more information, see “Working with table data” on page 103.

Click Save to save the original change request.

**Relating existing change requests**

When you work with a change request, you might also need to relate an existing change request to it. Relating change requests enables the support staff to work with multiple change requests for the same requester at once. With related change requests, you can optionally designate if the current change request exists in a dependent relationship to an existing change request.

**To relate an existing change request to another change request**

1. Select the entry from the Relationships table.
2. In the Request Type field, select Infrastructure Change.
3. Click Search.

The Change Relationship Search dialog box is displayed.
4 Use the various tabs to choose the appropriate search criteria.

5 To use more specific search criteria, click the Advanced Search tab and enter the appropriate search criteria.

6 Click Search.

If any records match the search criteria, they are displayed in the Change Results table. A message indicates if no records match the criteria.

7 Select the item that you want to relate.

8 In the Relationship Type field, select how you want to relate the current request to the selected change request.

The options are:

- Related To—Indicates the two changes are related to each other.

- Dependent—Indicates the current change request is dependent on the original change. For more information about dependencies, see the next procedure “Specifying sequences with dependent change requests” on page 247.
9 Click Relate.
A message confirms that the selected change has been related to the current change.

10 Click OK.

11 When you finish relating change requests, click Close to close the Infrastructure Change Relationship Search dialog box.

12 Enter the sequences that you want for the original and the related requests on the Change form for the relevant change request.

13 Save the change request.

**Specifying sequences with dependent change requests**

If necessary, you can create dependencies between change requests. When you create dependencies, you must specify the sequence in which change requests are to be completed. For example, a change request with the sequence number 2 must be completed before a change request with the sequence number 3 can be started. If several change requests have the same sequence number, they can be started in any order.

▶ To create a dependent change request

1 Select the appropriate entry from the Relationships table.

2 In the Request Type field, select Infrastructure Change.

3 Click Create.
A new Change form opens. The details needed to create a change request are already filled in.

4 Click the Classification tab.

5 Enter a number in the Sequence field.
The sequence number indicates the order in which the dependent new change request must be completed relative to the original change request.
Chapter 5—Change assignee role

Figure 5-65: Entering a sequence number when creating a change request

6 If necessary, add any additional information about the Change form to finish creating the change request.

7 Click Save.

8 Close the change request.

9 In the Relationship tab of the original change request, select Infrastructure Change in the Request Type field and then click Search.

10 In the Infrastructure Change Relationship Search dialog box, search for the change request that you just created and select it.

For more information, see “Relating existing change requests” on page 245.

11 In the Relationship Type field, select Dependent.

Figure 5-66: Creating dependent changes requests

12 Click Relate.

A message confirms that the selected change request has been related to the original change request.
The Infrastructure Change Relationship Search dialog box closes and the original change request is displayed. You might need to refresh the Relationships table to see the related change request. For instructions, see “Working with table data” on page 103.

13 Enter a number in the Sequence field of the original change request. The sequence number indicates the order in which the original request must be completed relative to the new request.

14 Save the original change request.

To view change dependencies

1 Open the change request so that it is displayed in the Change form.
2 Click the Relationships tab.
3 In the Show Related field, select Infrastructure Change from the list.

A list of change requests is displayed in the table. Changes with a dependent relationship to the current request are shown as Dependent under the Relationship Type column. The table shows the status of each request and enables you to monitor the progress of the change request implementation. To view a request, select it and click View.
Removing a related change request

This procedure removes the change request from the relationship with another change request; it does not delete any change requests.

To remove a related request from a change request

1. Open the change request so that it is displayed in the Change form.
2. Click the Related Items tab.
3. In the table, select the request that you want to unrelate.
4. Click Remove Relationship.
   A message prompts you to confirm that you want to remove the relationship.
5. Click Yes.
   The item has been removed from the Related Items list.
6. Save your original change request.

Working with related configuration items

When you work with a change request or a task, you might need to work with related CIs. For example, if you are working on a change request to upgrade memory for a department, you work with the asset records for the department members, configuration information for desktop systems, and information about the memory in inventory.

Working with configuration items related to change requests

You can view configuration items related to a change request, relate existing configuration items to change requests, create new configuration items to relate to change requests, and unrelate configuration items from change requests.

Viewing configuration items related to change requests

When a configuration is created and the approval status is set to Pending Approval, a related change request is automatically generated. You can view the configuration information from within the Change Management application in the change request form.
Note: You cannot create a new configuration item from within the Relationships tab. You can, however, use the Manage CIs link in the Manager Console to create new CIs. For more information, see “Managing configuration items” on page 309. You can also do these tasks from the BMC Remedy Asset Management application.

To view a configuration item related to a change request
1 Open the change request so that it is displayed in the Change form.
2 Click the Relationships tab.
3 Select Configuration Item from the Show Related list.

The related configuration items are displayed in the table.
4 Select the configuration item in the table.
5 Click View.
6 Select the configuration item in the table and click View.

The Configuration Information form of the BMC Remedy Asset Management application appears showing details of the configuration.

Relating configuration items to change requests
The following section provides detailed instructions on searching for configuration items and relating them to change requests. For more information, see “Defining relationships” on page 235.
To relate configuration items to change requests

1. Open a change request.
2. Click the Relationships tab.

Figure 5-69: Change form—Relationships tab

The Relationships tab shows the requests that you can relate to the change.
3. Select Configuration Item from the Request Type field.
4. Click Search.
   The CI Relationships Search form appears.
5 Complete the search criteria tabs with the relevant information, and then click Search.

Matching results are displayed in the CIs table.

6 In the Relationship Type field, select the type to relate with the change request, for example, Installs.

7 Click Relate.

When you are finished creating the configuration item, a message confirms that the new configuration item you created has been related to the existing change request.

8 Repeat steps 5 through 7 for all the CIs that you want related to the change request.

9 Close the CI Relationship Search form.

The original change request and the related configuration item are displayed in the Relationships tab. If items do not yet appear in the Relationships list, refresh the table.
Note: When you relate a CI to a change, the CI’s Impacted Areas can be automatically copied into the change’s Impacted Areas, based upon the Relationship Type. This allows for impact analysis within the change record and ensures that Change Approvers can be generated based on any Impacted Area Approval mappings related to moves, upgrades, impact, or repairs. In the SYS:Association Types form, Remedy administrators can define whether a particular Relationship Type copies the CI’s Impacted Area to the change.

To copy relationships to another CI already related to the change

1. Open the change request.
2. Click the Relationships tab.
3. Select the corresponding CI relationship entry from the Relationships table.
4. Choose Get Related Relationships from the Quick Actions menu.

For more information, see “Using Quick Actions on existing relationships” on page 238.
5. Click Execute.

The Relationships for Configuration Item dialog box appears.

Figure 5-71: Relationships for Configuration Item dialog box
This dialog box displays a list of all items related to the CI.

6 Select the item that you wish to relate to the current change.

7 Select a Relationship Type.

8 Click Select to perform the relationship.

9 To associate any other items, repeat steps 6 through 8.

10 Click Close.

To unrelate a CI from a change request

1 Open the change request.

2 Click the Relationships tab.

3 In the Show Related field, select Configuration Item from the list.

   The table lists all the related configuration items.

4 Select the configuration item record that you want to unrelate.

5 Click Remove.

   A message requests confirmation that you want to remove the relationship.

6 Click Yes.

   The item has been removed from the Relationships list.

7 Click Save.
Relating CIs to alternate data sets

When the Change form is opened, different data sets are available when relating CIs to a change request:

- **Personal Preference Change Data Set (CDS)** — When you open the Change form, the personal preference data set is loaded as a global setting from your application preference settings. If this setting is blank, the production data set is loaded from the AST:AppSettings form.

  For more information, see “Setting Create Request and Search for Request action preferences” on page 95.

- **Production Data Set (PDS)** — If there is no CDS, the PDS is loaded as the global setting. The PDS value is taken from the data set field on the AST:AppSettings form.

- **Alternate Data Set (ADS)** — Field on Change form on the Relationships tab that allows you to select a different data set than the CDS or PDS.

But you **must** understand the following important restrictions if you use an alternate data set when relating CIs:

<table>
<thead>
<tr>
<th>Configuration items</th>
<th>Alternate Data Set field</th>
<th>Data set preference</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>If there are no CIs related to the change...</td>
<td>Empty</td>
<td>CDS</td>
<td>You can select the ADS as needed. After you start working on the change request, the setting of the ADS is the data set that you last selected.</td>
</tr>
<tr>
<td>If there are no CIs related to the change...</td>
<td>Empty</td>
<td>PDS</td>
<td>PDS is used.</td>
</tr>
</tbody>
</table>

**Note:** An empty Alternate Data Set field is equivalent here to using the PDS.
<table>
<thead>
<tr>
<th>Configuration items</th>
<th>Alternate Data Set field</th>
<th>Data set preference</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>If CIs are related to the change...</td>
<td>Selected</td>
<td>Not applicable</td>
<td>Alternate Data Set field is locked. If you relate a CI with the ADS, you must save the change to save the ADS.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note: There is no database rollback on the relationships.</td>
</tr>
<tr>
<td>If all related CIs are removed...</td>
<td>Editable</td>
<td>Whatever the last value is</td>
<td>When all related CIs are removed, the Alternate Data Set field becomes editable. If you clear the Alternate Data Set field when it is editable, the data set is PDS.</td>
</tr>
</tbody>
</table>

**Note:** The CDS serves as a default value. CDS is only used if the ADS is set to CDS when you relate a CI. If you choose the PDS, you must clear the Alternate Data Set field.

**Note:** When the status of the change reaches the Closed state, the change is locked down for everyone except the Change Master. *Only* the Change Master can still make modifications to a change request in the Closed state, including adding and removing relationships. For the Change Master, the Alternate Data Set field behaves the same way as when the relationship is not locked.
To relate CIs from alternate data sets

1. In the Relationships tab, choose a data set, for example, BMC Asset, from the Alternate Data Set list.

   Depending on the applications installed, you might see the following options:
   - BMC Asset
   - BMC Configuration Import
   - BMC Sample Dataset
   - BMC.ASSET.SANDBOX

2. Relate CIs from the alternate data set as needed.

   The CI Relationships Search dialog box lets you search and relate CIs from the alternate data set. After you select a CI from the alternate data set, the Alternate Data Set becomes locked.

   ![Alternate data set locked](image)

3. To unlock the data set, remove all the CIs.

   The Alternate Data Set field becomes unlocked.

4. Select another data set as needed.

5. To return to the PDS, click Clear.
Creating CI unavailability

CI Unavailability entries track actual down time of an outage against a CI. For example, CI unavailability can be an outage due to scheduled maintenance, usually through a scheduled change. Also, CI unavailability can occur due to an unexpected circumstance, usually related to an incident.

**Important**: You can create CI Unavailability entries only if you have the BMC Remedy Asset Management application installed.

There are two ways to create CI Unavailability entries for a related CI:

- **Directly**—By clicking the Relate with Unavailability button from the CI Relationships Search form, when you are creating the actual relationship with the CI.
- **Indirectly**—By creating the unavailability after the CI has been associated with the change. For more information, see “Creating new CI unavailability for an existing record—alternative method” on page 263.

The actual CI Unavailability relationship entry is created when you save the CI Unavailability entry. A CI Unavailability relationship entry is then displayed within the Relationships tab.

**Note**: CI Unavailability cannot be tracked directly against CI Components.

Relating unavailable CIs to changes

Typically, change requests occur because a CI needs to be upgraded (like an operating system) or needs repair (like a server). Using Change Management, you can relate unavailable CIs (also known as outage records) to their related change request. By relating an unavailable CI record to a change request, you can track its history, and the costs related to changes to the CI.

---

**To relate an unavailable CI to a change request**

1. Open a change request.
2. Click the Relationships tab.

   If unavailable CIs are already related to the change request, they appear in the Relationships table.
3. From the Request Type list, select CI Unavailability.

4. Click Search.

The CI Unavailability Search dialog box appears. You use this dialog box to search for unavailable CIs you want to relate to the change request.

**Figure 5-75: CI Unavailability Search dialog box**
5 Enter search parameters to filter the CI relationships displayed and then click Search.

The quick search buttons let you easily filter CI unavailability with different criteria:
- All unavailability
- All scheduled unavailability
- All unscheduled unavailability

The unavailability records are displayed in the table.

6 Select an unavailable record from the list.

7 From the Relationship Type list, select Related to, and then click Relate.

The following actions occur:
- Messages appear, alerting you that the CI has been automatically related to the change.
- The CI Relationships Search dialog box closes.
- The unavailable CI and its related CI record appear in the Relationships table.

8 If needed, you can broadcast the CI unavailability.

For more information, see “Broadcasting CI unavailability” on page 268.

To relate a change request to a CI with unavailability

1 Open a change request.

2 Click the Relationships tab.

The Relationships tab shows the requests that you can relate to the change.

3 Select Configuration Item from the Request Type field.

4 Click Search.

The CI Relationships Search form appears.
5 Complete the search criteria tabs with the relevant information, and then click Search. Matching results are displayed in the CIs table.

6 In the Relationship Type field, select the type to relate with the change request, for example, Related to.

7 (Optional) Click CI Relationship Viewer to view a CI and its relationship in the CI Viewer.

   For information, see “Viewing CI relationships” on page 195.

8 Click Relate with Unavailability.

   A message appears that confirms that the configuration item has been related to the existing change request.

   If the CI already has open unavailability entries already created against it, the CI Unavailability Exist dialog box appears. For information, see “To create CI unavailability where CI unavailability already exists” on page 262.

   ➤ To create CI unavailability where CI unavailability already exists

   1 Select the associated Configuration Item from the Relationships table.

   2 Select Create New CI Unavailability from the Quick Actions menu.
3 Click Execute.

If the CI already has open unavailability entries already created against it, the following Existing Configuration Item Unavailability dialog box appears.

Figure 5-77: Existing Configuration Item Unavailability dialog box

4 Do one of the following actions:

- Create a new unavailability entry by clicking Create New. You then are prompted to define the configuration item unavailability, for example, unscheduled full unavailability type, start and end dates, and so on.

- Relate the change directly against the existing CI unavailability entry by selecting an entry from the table and then clicking Relate to Current Request. You are then prompted to specify the relationship type between the current request and the selected CI unavailability.

Creating new CI unavailability for an existing record—alternative method

You can also create CI unavailability entries after the CI has been associated with the change.

Note: You can perform these steps only if Asset Management is installed on your system.
To create CI unavailability from CIs already associated with a change

1. Select the associated CI from the Relationships table.
2. Select Create New CI Unavailability from the Quick Actions menu.
3. Click Execute.

   The Configuration Item Unavailability dialog box appears.

![Figure 5-78: Configuration Item Unavailability dialog box](image)

The Unavailability Class defaults to change. Here you enter specific details in the dialog box, for example, unscheduled full unavailability type, the actual start date, or the assignment status.

4. Select the unavailability type that best describes the down time.

   The options are:
   - **Scheduled Full**—Creates high priority.
   - **Scheduled Partial**—Creates medium priority.
   - **Unscheduled Full**—Creates critical priority.
   - **Unscheduled Partial**—Creates high priority.

**Note:** After the Unavailability Class and Type field are selected, the Priority is auto-populated based on a configurable CI Unavailability Prioritization mapping.
After you select the class and type, the priority field is automatically filled in.

5 (Optional) Modify the description identifying the reason why this unavailability is being created.

6 Enter the appropriate Scheduled Start and Schedule End dates.
   After you enter the dates into these fields, the system automatically calculates the Estimated Duration.

   **Note:** When a Scheduled Start Date is entered without an Actual Start Date, the Unavailability Status is automatically set to Scheduled.

7 Enter the appropriate Actual Start and End dates, as needed.
   The system automatically calculates the Actual Duration, based on the actual dates.

   **Note:** When an Actual Start Date is entered without an Actual End Date, the Unavailability Status is automatically set to Current Unavailability. The Unavailability Status is automatically set to Restored when the Actual End date is filled in. After the Actual End Date is set, you can only modify it; it cannot be blanked out.

8 Select where the assignment is set from.
   The Assignment is set from field determines where the assignment is based.

   - **Configuration Item**—Assigns automatically the CI Unavailability entry if an assignment record has been created for unavailability from within the Configuration Item Contact relationship.

   **Note:** This type of assignment can be configured to be locked or open. Locked means that the system selects the Assignment Group from the Configuration Item Contact relationship and then locks the fields so that they cannot be re-assigned or overridden manually. Open means that the system selects the Assignment Group from the Configuration Item Contact Association and then allows you to select another assignment method.

---

Working with relationships and dependent change requests 265
Chapter 5—Change assignee role

- **Cross-Referenced Request**—Assigns the CI Unavailability entry when the CI Unavailability is created from either an Infrastructure Change or an Incident. This setting keeps the CI Unavailability assignment synchronized with either the Change or Incident record assignment.

- **Manual**—Lets you assign the CI Unavailability entry manually to any group defined within the application.

  Setting the Assignment Status to Completed marks the CI Unavailability record as closed. Only users with Asset Admin or Asset User permissions can modify a closed unavailability record.

- **Automated Routing**—Assigns the CI Unavailability entry automatically to a support group if you do not assign a support group from the People tab. Automated Routing is set up using the CFG:Assignment configuration form.

  For more information about configuring your applications, see the *Remedy IT Service Management 7.0 Configuration Guide*.

9 If you selected Manual assignment, set the assignment.

The individual or group assigned to this unavailability record must set the status to Completed after recording the actual start and end times.

10 Set the Assignment Status to Assigned.

**Note:** The Assignment Status governs whether the CI Unavailability entry is considered Open or Closed. Setting the Assignment Status to Completed marks the CI Unavailability entry Closed. A closed CI Unavailability entry can only be modified by an individual with Asset Admin or Asset User permissions.

Additional windows can also help you with CI maintenance:

11 (Optional) Click the Set From Change Schedule button to retrieve the change request’s Scheduled Start and End dates and times.

You use this button to populate the Schedule Start and End date and times on the CI Unavailability record. This feature is available only for CI Unavailability records that were created from the Change request.

12 (Optional) Click the CI Status Information tab to change the status of the CI, for example, In Repair.
13 (Optional) Click the Relationships tab to see possible relationships against the unavailability that might exist, for example, relationships to incidents, changes, or problems. You can also create relationships to these respective modules.

14 (Optional) Click the Financials tab to create cost entries against the unavailability. This allows you to track costs associated to the down time.

**Note:** You must save the CI Unavailability record before you can create Relationships and Financials.

15 (Optional) Click the References tab to display the record identification numbers for any incidents or changes that might have created the unavailability entry.

16 (Optional) Click the SLM tab to display the service targets and milestones for the restoration of the unavailability. Service targets and milestones are defined from within the Service Level Management application. Escalations can be set up to notify the assignment group prior to acknowledgement or resolution breach times.

17 Click Save to create the new CI unavailability for the existing record.

A message prompts you that the CI unavailability is related to the change request and you are returned to the change request.

### Modifying CI unavailability

The following procedure describes how to modify CI unavailability.

**To modify CI unavailability**

1 Select the related CI unavailability from the Relationships table.

2 Select the appropriate unavailability entry.

3 Click View.

**Note:** The CI unavailability entry displayed represents the actual entry as seen within the CI Unavailability form. The CI unavailability entry displayed within the Relationships tab represents the relationship between the Unavailability and the Change.
Chapter 5—Change assignee role

BMC Remedy Change Management 7.0

The Configuration Item Unavailability form appears.

4 Modify information as needed.

5 Click Save.

6 To create a financial cost for the unavailability, click Add in the Financials tab of the Configuration Item Unavailability form. The Costs dialog box appears:

Figure 5-79: Costs dialog box

7 Enter required information as needed.

For information, see “Working with costs” on page 283.

8 Click Save.

Broadcasting CI unavailability

The following procedure describes how to broadcast CI unavailability.

To broadcast CI unavailability

Note: You must have the functional role of Broadcast Submitter to broadcast the current change.

1 Select the appropriate unavailability entry from the Relationships tab.
2 Select Broadcast CI Unavailability from the Quick Actions menu and then click Execute.

The following New/Modify Broadcasts dialog box appears:

**Figure 5-80: New/Modify Broadcasts dialog box**

![New/Modify Broadcasts dialog box]

3 Complete the required fields and any other information, as needed.

4 Click Save.

The View Access field is used to make the Broadcast available on the web (if your Broadcast form is web-enabled and the View Access is set to Public). If you set View Access to Internal, the CI is not broadcast on the web.

**Deleting CI unavailability**

The following procedure describes how to delete CI unavailability.

- **To delete a CI unavailability**
  1 Select the unavailability entry from the table.
  2 Click Remove.
    
    A warning appears, verifying that you want to delete the selected record.
  3 Click Yes.
Note: Deleting a CI Unavailability entry also deletes all related relationships and cost entries against the unavailability. The CI Unavailability is deleted if the cross-referenced ID is the change ID.

Displaying the outage list

After you create a CI Unavailability for the change request, you can display an outage list that you can use to track the actual down time of a CI. CI unavailability is the actual down time of a CI. Unavailability might be due to scheduled maintenance (created from a change request).

For more information, see the BMC Remedy Asset Management 7.0 User’s Guide.

To display the outage list

1. Open a change request.
2. Click the Relationships tab.
3. Follow the steps in “Creating CI unavailability” on page 259.

You can use either the direct or indirect method to create (not simply relate) a CI unavailability. The Created Relationship Type is displayed in the Relationships table when you have finished.

Figure 5-81: CI unavailability request type—Created relationship type

4. From the Change form, choose Functions > Outage List.

270 Chapter 5—Change assignee role
The CI Unavailability form opens.

Figure 5-82: CI Unavailability form

5 Modify data, as needed.

You can add information about the CI unavailability, or outage, life cycle example, if the CI is planned to be taken the CI out of service, its scheduled start and end dates, and so on.

6 Save your changes and close the CI Unavailability form.

Working with related LDAP objects

When you work with a change request, you might need to create a related LDAP object. For example, you might want to relate a change request to an LDAP server where all the permission rights are stored that would enable seamless authentication with Policy Manager.

To work with related LDAP objects

1 Open the change request.

2 Select the entry from the Relationships table.
3 In the Record Type field, select LDAP Objects.

4 Click Search.

The LDAP Search dialog box appears.

**Figure 5-83: LDAP Search dialog box**

5 Complete the search criteria with the relevant information, for example, an LDAP type and the LDAP name, and then click Search.

Matching items are displayed in the LDAP Item table.

6 Select the LDAP item to relate with the change request.

7 Click Relate.

A message confirms that the LDAP item has been related to the change request.

8 Repeat steps 5 through 7 for all the LDAP items that you want related to the change request.

9 Close the LDAP Search dialog box.

The original change request and the related LDAP item are displayed in the Relationships tab. If the LDAP item does not yet appear in the Relationships list, refresh the table.
Working with related software library items

When you work with a change request, you might need to create a related software library item. For example, you might need to view related software library items (SLIs), for example, different versions of Norton Antivirus along with their license contracts. SLI is also used by Policy Manager to determine the location of software to deploy.

For more information, see “About the Definitive Software Library (DSL)” on page 274 and “Software license management” on page 276.

To work with related software library items

1. Open the change request.
2. Select the entry from the Relationships table.
3. In the Record Type field, select Software Library Item.
4. Click Search.

The Software Library Item Search Criteria dialog box appears.

Figure 5-84: Software Library Item Search Criteria dialog box

5. Complete the search criteria with the relevant information, for example, product name and manufacturer, and then click Search.

Matching items are displayed in the Software Library Item table.

6. Select the SLI to relate with the change request.
7 Click Relate.
   A message confirms that the SLI has been related to the change request.

8 Repeat steps 5 through 7 for all the SLIs that you want related to the change request.

9 Close the Software Library Item Search dialog box.
   The original change request and the related SLI are displayed in the Relationships tab. If the SLI does not yet appear in the Relationships list, refresh the table.

**About the Definitive Software Library (DSL)**

The Definitive Software Library (DSL) is a central repository of approximately 10,000 approved product dictionary entries (PDEs). PDEs are the definitive, or master, names and descriptions of software applications.

The DSL contains records and pointers to the approved versions of software used by an organization. BMC has added a Product Dictionary (PD) to the DSL as well to provide a normalized vocabulary for software products and suites. In addition, the Product Dictionary contains identifying characteristics of software packages that enhances the accuracy of BMC Discovery products by uniquely identifying a package regardless of installed name or location.

Any BMC application can use the DSL to identify a single name for a software application and its versions, which in turn supports software license compliance.

PDEs are made up of SLIs, which are the physical locations of where the master copies of the software applications and their versions are stored.

By default, each PDE in the DSL has an accompanying model and version. These are used by the software license management engine to determine if the existing PDE must have a related software license contract.
The DSL comes prepopulated with PDEs. You can also manually add PDEs and their associated SLIs to the DSL. The DSL is used by application administrators who want to add or modify PDEs and SLIs in the Definitive Software Library to facilitate software license management. You access the DSL functionality, for example, to create a PDE, from the Definitive Software Library Console.

After the DSL is set up, you can relate product categorizations listed in the DSL to CIs that match the exact six-tier product and class categorization of the product dictionary entry. The product categorization structure of your CIs and the product dictionary entry must match in the following categories:

- Tier 1
- Tier 2
- Tier 3
- Product Name
- Model/Version
- Manufacturer

For more information about working with the DSL, including permissions necessary to create or view PDEs, see the *BMC Remedy IT Service Management 7.0 Configuration Guide*. 
Software license management

Software license management and compliance means keeping track of what software your company has and that it has the legal right to use it. Organizations that are not compliant face legal charges from the company they bought the software from, or they must pay maintenance charges for software that is not being used. A common example of this is when companies acquire other companies, and the software licenses from those companies are not accounted for.

You can use the new software license management feature in the BMC Remedy Asset Management application to facilitate focus and follow-through on compliance. The following workflow diagram visually explains the software license management process as implemented in Asset Management.

For more information, see the BMC Remedy Asset Management 7.0 User’s Guide.
Working with incidents related to change requests

When you work with a change request, you might need to work with a related incident. For example, if a change request for a server upgrade resulted from connection problems, you can relate the incident about the connection problems to the change request for the server upgrade.

**Note:** If the BMC Remedy Incident Management application is not installed on the server, you cannot relate incidents to change requests.

***To create an incident related to a change request***

1. Open the change request so that it is displayed in the Change form.
2. Click the Relationships tab.
3. In the Request Type field, select Incident.
4. Click Create.
   A new Incident form is displayed.

**Note:** To create an incident from a change request, you must be a member of the Incident Submitter, Incident Master, or Incident User permission groups.

5. Create the incident.
   For instructions, see the *BMC Remedy Incident Management 7.0 User’s Guide*.

6. When you are finished creating the incident, save your work.
   A message indicates that a support staff member has been notified.

7. Click OK.
   Another message confirms that the new incident you created has been related to the existing change request.

8. Click OK.
   The related case does not yet appear in the Related Items list. You must first refresh the Related Items table. For instructions, see “Working with table data” on page 103.

9. Save your change request.
To relate an existing incident to a change request

1. Open the change request so that it is displayed in the Change form.
2. Click the Relationships tab.
3. In the Record Type field, select Incident.
4. Click Search.
   The Incident Relationship Search dialog box is displayed.
5. Choose the appropriate search criteria.

**Note:** To use more specific search criteria, click Advanced Search and enter the query in the Advanced Qualification Builder dialog box.

6. Click Search.
   If existing incidents match the search criteria, they are displayed in the Incidents table. If no cases match the criteria, a message indicates this.
7. Select the incident that you want to relate.
8. In the Relationship Type field, select how you want to relate the incident to the change request.
   You have the following options:
   - Related To
   - Caused
   - Corrects
9. Click Relate.
   A message confirms that the case has been related to the original request.
10. Click OK.
11. When you have finished relating cases, click Close.

To unrelate an incident from a change request

1. Open the change request so that it is displayed in the Change form.
2. Click the Relationships tab.
3 In the Show Related field, select Incident from the list.
   The table lists related incident.
4 Select the incident that you want to unrelate.
5 Click Remove.
   A message prompts you to confirm that you want to remove the relationship.
6 Click Yes.
   The item has been removed from the Related Items list.
7 Save your original change request.

Monitoring the progress of a change request

As the change request is being planned, you can follow its progress by viewing the information in the Work Info tab. For example, during its implementation phase, you can follow the progress of the tasks as they are being completed.

To view the progress of a change request
1 Open the change request so that it is displayed in the Change form.
2 View progress details of the change request by clicking the appropriate tab:
   - The upper region of the change request provides information about the status, next approval phase, potential risks, and whether it is escalated.
   - In the Requester tab, you can view who requested the change request and who is assigned to the change request. When the change request was created, the change request was automatically assigned to the appropriate support staff group or person.
   - In the Classification tab, you can view the timing of the change request and its categorizations.
   - In the Work Info tab, you can view information about each step in the process written in the work information history area.
   - In the Tasks tab, you can view the progress of the tasks associated with the change request.
   - In the Assignments tab, you can view who is assigned to the change request as change manager, change assignee, or change implementer.
Chapter 5—Change assignee role

In the Relationships tab, you can see all the related change requests, dependent change requests, related CIs, and so on.

In the Approvers tab, you can review the current stage in the approval process for the change request.

In the SLM tab, you can review the agreed-upon service targets for the request. This tab is only visible if the BMC Service Level Management application is installed.

In the Financials tab, you can view information relating to cost types, total costs, and the total costs in a specific currency.

In the Dates tab, you can view the planned dates.

**Monitoring associated tasks**

As change manager or change assignee, you must keep track of the change request to which you have been assigned. This includes monitoring the tasks associated with the change request.

> To view a task associated with a change request

1. Open the change request.
2. Click the Tasks tab.

All the tasks for that change request are listed.

**Figure 5-87: Tasks tab—Monitoring tasks**
To view details about a task, select the task in the list and click View. The task is displayed in the Task form.

In the Work Info tab of the Task form, you can view information about each step in the process written in the work history. You can also view work information for each task in the Work Info of Selected Task table on the Change form itself.

Click Save if you modified the task.

Close the Task form when you are finished.

**Responding to task reassignments as a change assignee**

As a change assignee, you might need to assign new assignees to tasks associated with your change. Task reassignment is performed manually, directly on the Task form.

1. In the change request, open the task that you want to reassign.
2. Click the Assignment tab.
   The task assignee is displayed.

![Figure 5-88: Assignment tab—Reassigning tasks](image)

3. After reviewing the task, reassign the request as needed.
If you decide to reassign the task:

- In the Assignee field, select a new staff member.
  
  The task is reset to a state in which the assignee is not requesting reassignment.

- In the Notify Assignee field, select Yes.

- Update the work history.

**Important:** If you decide to deny the reassignment request, set Notify Assignee to Yes and update the work history.

4 Click Save.

If you reassign the task, the previous and new assignee are automatically notified of the changed assignment. If you deny the reassignment request, the current assignee is informed that the assignment has not changed and that the request was denied.

**Viewing SLM service targets**

You can view the SLM service targets in effect for a change request. By finding out the priority of the change request, you can compare it to the rest of your workload and balance your workload more effectively.

**Note:** You must have BMC Service Level Management installed to be able to view a service target.

- To view service level targets for a change request
  1 Open the change request so that it is displayed in the Change form.
  2 Click the SLM tab.
Working with costs

You can calculate the financial impact involved in implementing a change request. You can calculate costs after a request has been created; however, usually you do this when the change request has been resolved. You can calculate the various kinds of costs, and you can associate costs with CIs.

Only users with Cost User permissions can delete or modify a cost, including the costs that they have submitted. In addition, users with Cost Manager permissions can configure the values that populate costs.

To view the cost of a change request

1. Open the change request so that it is displayed in the Change form.
2. Click the Financials tab.
You might need to refresh the table to display cost records.

3 In the Show field, select the type of cost you want to view (these values can differ depending on the customized types your application administrator has configured for cost categorizations):
   - All Cost Types
   - Fixed
   - Labor
   - Parts
   - Other

To add a cost to a change request
1 Open the change request so that it is displayed in the Change form.
2 Click the Financials tab.
3 Click Add.
   The Costs dialog box is displayed.
Enter the relevant information in the following fields:

- **Company**—This field is populated automatically with the name of the cost center specified in the Cost Center Code field. It identifies the company that is charged for servicing the change request.

- **Cost Center Code**—Identifies the code name for the business unit or organization within the company that is charged for servicing the change request. The default cost center is the business unit to which change requester belongs, but you can modify this.

  When you select the cost center code, the Company and Cost Center Name fields display the values attached to the cost center code.

- **Cost Center Name**—This field is populated automatically with the name of the cost center specified in the Cost Center Code field.

- **Cost Category**—This field is populated automatically according to the application you are working in.

- **Cost Type**—Enter the cost type. Options are Fixed, Labor, Other, or Parts. (These values can differ depending on how your application administrator has configured cost categorizations and the chosen company.)

- **Cost Classification**—Options are Actual or Budget.

- **Description**—Enter a cost description.

- **Related Cost**—Enter the rate. You select the Currency from the list. The available currencies are set by your administrator.
**Related Units**—Enter how many units, for example, hours or minutes, were required to implement the change.

**Unit Type**—Choose how you want to measure the cost. Choices are Flat Rate, Hours, or Minutes.

**Date Incurred**—Date charge was incurred. If you leave this field blank, it is set to the current date when you save the cost.

5 Click Save.

6 Perform steps 3 through 5 for each cost associated with the change request. The totals for budgeted and actual costs appear at the bottom of the table.

**Note:** Only users with Cost User permissions can create, modify, or delete cost entries. If you make a mistake when adding a cost entry—for example, if you charge too much for a service—you cannot delete the record itself. However, you can reverse the cost of the record by adding a new cost record, and entering a negative value equal to the amount that you want to negate. If you negate a cost, make sure that you document this in the Description field.

**To delete costs**

1 Open the change request so that it is displayed in the Change form.

2 Click the Financials tab.

3 Select a cost from the table.

4 Click Delete.

   A warning prompts you if you are sure that you want to delete the cost entry.

5 Click Yes.

   The cost entry is deleted from the change.

**Using auto-cost estimates**

You can include auto-cost estimates in a change request.
To use auto-cost estimates

1. Open the change request so that it is displayed in the Change form.
2. Click the Financials tab.
3. In the Calculation Unit Type field, select Flat Rate, Hours, or Minutes.
4. In the Budget Estimated Total Time, enter the time based on unit type.
   You use this information to forecast the cost. For example, you budget the change will take 2 hours to perform.
5. In the Actual Total Time, enter the time according to the calculation unit type.
   You enter this information after the change is completed, for example, you budgeted 2 hours to do the change but it actually took 3 hours.
6. Save your changes.
   This causes workflow to be triggered, based on the auto-cost roles. If a matching cost rate is found, a cost is created.

Allocating costs to configuration items

When relating CIs to a change request, you need only one related CI to create the allocation. If you have two or more CIs related to a change request, you can distribute the costs of the change request between the different CIs.

You cannot perform these steps until you relate the CIs to the change request. For more information, see “Working with configuration items related to change requests” on page 250.

To allocate costs to configuration items

1. Open the change request so that it is displayed in the Change form.
2. Click the Financials tab.
3. Click Create Allocation.
   The Cost Allocation dialog box appears.
Three sets of information are displayed:

- **Cost Information**—Shows information used to calculate the cost of the change request.
- **Relate To CIs**—Shows all CIs that are related to the change request.
- **Related CIs With Cost Allocated**—Shows all the CIs after you have allocated the costs to them.

**Note:** When you are viewing financials on CIs, only actual costs are displayed. As a result, a budgeted cost that is allocated to a CI appears on the change, but does not appear on the CIs financial table.

4 Enter missing information for cost type, cost rate, and so on.
5 In the Relate To CIs field, specify whether you want to relate the cost to a CI:

- **Divide evenly between CIs**—Choose this option if you want to divide the cost between all of the CIs (including services) that are related to the change. Doing so divides the Current Total by the number of related CIs. If you do not have CIs or services related to this change request, you cannot choose this option.

- **Let me allocate to CIs**—Choose this option if you want to distribute the cost among the different CIs. If you choose this option, the Selected CI Desc and Allocate To Selected CI fields are activated. If you do not have CIs or services related to this change request, you cannot choose this option.

The Related CIs Count field automatically displays the number of CIs that are related to the change request. You cannot change this information.

6 In the Relate To CIs table, click the CI to which you want to allocate a cost. The ID appears in the Selected CI Desc field.

7 In the Allocate to Selected CI field, enter the amount that you want to allocate to the CI.

8 Click Create Cost Record.

![Figure 5-93: CI Distribution—Cost allocated to the related CI](image)

This allocates costs according to your input. The cost record is displayed in the Related CIs with Costs Allocated table, and the Unallocated Cost decreases by the amount applied to the CI.
The remaining fields in the tab are read-only. They provide the following information:

- **Unallocated Cost**—Displays the Current Total less the amount already allocated to CIs during this session.

- **Average Cost Per CI**—Displays the Current Total divided by Related CIs Count. This indicates the amount that each cost record would be if you chose to automatically allocate the costs to the CIs.

9 Continue selecting CIs from the Related CIs table, and apply costs until the Unallocated Cost is equal to 0.

10 Click Close.

The table in the Costs tab shows the cost records you have created. You cannot modify or delete these records.

### Tracking the time spent working on change requests

You can track the time spent working on a change request after it has been fully assigned. The Support Company, Support Organization, Support Group, and Change Assignee must be set before you can use the Start Clock and Stop Clock buttons.

**Figure 5-94: Change form—Assignment tab**

<table>
<thead>
<tr>
<th>Requestor</th>
<th>Classification</th>
<th>Work Info</th>
<th>Tasks</th>
<th>Assignee</th>
<th>Relationship</th>
<th>Approved</th>
<th>SUM</th>
<th>Finances</th>
<th>Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time spent resolving change request</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Time</td>
</tr>
<tr>
<td>Time spent (min)</td>
</tr>
<tr>
<td>Total time spent (hr)</td>
</tr>
</tbody>
</table>

Start Clock | Stop Clock | Update Assignment Log
There are three ways to track the time spent working on a request:

- **Use the start clock and stop clock buttons**—The time is calculated based on when you click the start clock and stop clock buttons.

- **Manually enter in the time**—You can enter the actual time itself into the Time Spent field directly.

- **Create an effort log**—With the Update Assignment Log button, you can create an entry in the effort log. For more information, see “Tracking efforts” on page 176.

▶ **To track the time spent on a change request using the start and stop buttons**

1. Open the change request so that it is displayed in the Change form.
2. Click the Assignment tab.
3. Click Start Clock.
   
The current date and time are displayed in the read-only Start Time field.
4. If you want to close the Change form while working on the request, make sure to save the request first.
5. When you want to stop tracking the time, click the Stop Clock button. You must repeat steps 1 and 2 first if you closed the Change form in step 4.
   
   A message reports the number of minutes you spent working on the request. The time spent is added to the value in the read-only Total Time Spent field when you save the request.
6. Update the assignment log, as needed.
7. Click Save.
   
   You can use the start and stop clock buttons as many times as you like. Each successive time, the new time is added to the value already in the Total Time Spent field.

▶ **To manually track the time spent on a change request**

1. Open the change request.
2. Click the Assignment tab.
3 Manually enter the number of minutes in the editable Time Spent field.

4 Enter relevant information in the effort log, using the Update Assignment Log button.

5 Click Save.

The time you entered is added to the value already in the Total Time Spent field.

**Completing change requests**

A change request cannot be closed until all tasks are closed, due to success, cancellation, or failure. When all of the tasks related to a change request are closed, the requester and the change manager are notified that the change is resolved.

**Figure 5-96: Reviewing change requests**
When the requester has verified that the change request was resolved satisfactorily, the change request can be set to Closed. If the requester does not close the change request within the allowed response time of it being resolved, the change request is closed automatically after a specified period of time. The Status Reason for the change request indicates that the change was automatically closed.

The allowed response time depends on how the application administrator configured the BMC Remedy Change Management application. The default is 15 days.

If the requester is not satisfied with the change request, the requester can reopen the change request.

The change manager is notified that the change request is reopened, and must respond to the change request.

**Identifying change requests as rollbacks**

If the actions associated with a change request need to be reversed, your support staff and managers can identify the request as needing to be rolled back. This means that impacted systems need to be restored to their previous state before the change request was implemented. The status of a change request must be set to Implementation In Progress for you to identify it as a rollback.

1. From the Change form, open the change request.
2. Set the Status field to Implementation In Progress.
3. Set the Status Reason field to In Rollback.
4. Update the fields on the Work Info tab with information about why you are rolling back the change request.
5. Click Save.

It is recommended that you create a related task to implement the rollback for this change request. When the change request has been rolled back and the status is set to Completed or Closed, the Status field is automatically cleared and disabled. Changes in value to the Status field are tracked in the audit trail.
This section describes how change managers can use BMC Remedy Change Management to monitor issues pertaining to the daily aspects of change management activities and how they can help their staff meet their commitments to the organizations they support.

The following topics are discussed:

- Working as a change manager (page 296)
- Working with reassignment requests (page 301)
- Generating BMC Remedy Change Management reports (page 302)
- Predefined reports with Change Management (page 307)
- Using the Broadcasts feature as a manager (page 308)
- Creating change requests (page 308)
- Searching for change requests (page 309)
- Managing configuration items (page 309)
- Managing SLM service targets (page 311)
- Working with change request approvals (page 312)
- Calculating the costs of a change request (page 313)
- Using the Change Management Dashboard (page 315)
- Viewing the CCM Change Calendar (page 318)
Working as a change manager

The change manager (also known as the change supervisor) is a person or a group usually within your organization’s support department. In large companies, the change manager’s main responsibilities usually involve planning and oversight. But in small companies, the change manager can function as the change assignee who is actually performing the change. To be eligible to be the change manager, a user must have the functional role of Infrastructure Change Manager.

**Important:** Change managers should read Chapter 5, “Change assignee role,” carefully to understand the overall change request process.

Typically, the responsibilities of a change manager can include any or all of the following tasks:

- **Creating the change requests**—Anyone can create a change request using the Requester Console application. However, it usually is the change manager who creates change requests using the Change Management application. For more information, see “Viewing, creating, and modifying change requests” on page 160.

- **Accepting the change request**—When the change request is created, it is automatically assigned to the appropriate change manager, based on your organization’s support staff grouping and the change request’s categorization. The change manager is notified of assigned changes by email, pager, or BMC Remedy Alert. Also, when the change manager logs in to Change Management, he or she can choose to list all assigned change requests in the console. For more information, see “Working with change request assignments” on page 171.

- **Planning and scheduling the change request**—Planning activities include scheduling the change request, assessing risk and impact, creating plans, creating and sequencing the tasks that must be performed to accomplish the change request, and scheduling people and resources for each task. For more information, see “Planning the change request” on page 181.
Submitting the change request for approval—Whether a change request requires approval is determined by your organization’s business rules. The application administrator configures the approval process to determine which approval phases are available for the change request. If appropriate, the change manager can designate ad hoc approvers for emergency change approvals.

After gaining approval, the change manager sets the request’s status to Scheduled. The change manager can assign the tasks to the appropriate task implementers manually, or they can be assigned automatically.

For more information about submitting the change for approval, see “Understanding the approval process” on page 208.

Logging and tracking change requests—The change manager can track a request’s progress as task implementers fulfill their assignments. For more information, see “Tracking efforts” on page 176 and “Monitoring the progress of a change request” on page 279.

Assessing the cost of a change request—The supervisor can assess the cost of a change request and charge accordingly. For more information, see “Working with costs” on page 283.

Resolving change requests—A change request is resolved when all of the tasks are closed or canceled. For more information, see “Completing change requests” on page 292 and “Identifying change requests as rollbacks” on page 293.

The change manager is also typically responsible for addressing general, day-to-day issues from a personnel and customer satisfaction standpoint.

Typical management activities include handling assignments and monitoring support staff activity involved in implementing the change request. Even though change managers have the same permissions as support staff and can do the same procedures through the BMC Remedy Change Management application, they usually do not perform support staff activities.
For information about procedures that are usually performed by support staff, see the appropriate section:

- “Introducing the support roles” on page 77 provides information about the procedures that are performed by both change managers and task implementers.

- “Working with BMC Remedy Change Management as a task implementer” on page 328 provides information about the responsibilities of the task implementer.

- The manager can also carry out the same responsibilities as an approver. For information, see “Approver role” on page 345.

### Using the Overview Console

The Overview Console provides quick access to the tasks you perform as a change manager, and to the information you need and to the procedures that you perform most often.

**Figure 6-1: BMC Remedy IT Service Management Overview Console**
The Overview Console is useful for looking at different types of requests assigned to the same person. The Overview Console gives you a way to view requests in one console without opening multiple windows.

For more information, see “Opening the Overview Console” on page 82.

**Using the Change Management Console**

The Change Management Console provides a dedicated workspace for managing change requests. This console is designed for change managers who deal with Change Management daily and do not want to view other ITSM applications. It provides quick access to the information you need and to the procedures that you perform most often.

Various functions are available in the navigation pane of the Change Management Console. They provide you with quick ways to navigate to different areas in Change Management and to perform other functions.
Chapter 6—Change manager role

For detailed information, see the following links:

- “Using the Manager Console as a change manager” on page 107
- “Using the Broadcasts feature as a manager” on page 308

Flashboards

The Flashboards on the console graphically convey information to help you monitor the requests in your system. These Flashboards include all change requests still open, changes needing approval, changes requiring risk assessment, open tasks, and incidents (if BMC Remedy Incident Management is installed). Some of the Flashboards change depending on which tab you select, for example, Total Open Changes By Impact.

- The **Total Open Changes** Flashboard displays all open change requests.
- The **Changes Needing Approval** Flashboard displays all change requests needing approval.
- The **Change Risk Assessment** Flashboard displays all change requests by their risk level.

Reports

The Reports link in Console Functions allows you to generate predefined reports on change requests. You can view them with the built-in Crystal Reports viewer from Business Objects. For information about generating reports, see “Generating BMC Remedy Change Management reports” on page 302.

Help

The Help button is located in the top right corner of the console. Click the Help button to access help.

Logout

This applies to the Web only. Click the Logout button to log out of the BMC Remedy Change Management application.
Working with reassignment requests

Change managers are responsible for responding to reassignment requests. If approvals for change requests are required as part of the change request process, managers can provide approval authorization or rejection.

When a change manager reassigns a change request to another manager, the person is notified. Upon reviewing the change, the manager can reassign the change to another qualified change manager.

To respond to reassignment requests

1. Open the Overview Console or the Manager Console.
   All reassignment requests are displayed in the table along with the rest of the change requests. You should regularly monitor your assigned work to keep track of any change requests reassigned to you.

2. Select the appropriate change request.

3. Click View.
   The change request is displayed.

   After reviewing the change request, you can manually reassign the change manager, change assignee, or the change implementer.

4. Click the Assignment tab.

To deny the reassignment request, you must reassign it to another change manager, assignee, or implementer.
To reassign the change request, do one of the following steps:

- Select the change manager to whom you want to reassign the request.
- Select the change assignee to whom you want to reassign the request.
- Select the change implementer to whom you want to reassign the request.

b Select an assignment method, for example, Auto Assign.

c Click Set.

5 Click Save.

If you reassign the change request, the new assignee is automatically notified of the changed assignment.

For more information, see “Assigning change requests” on page 173.

Generating BMC Remedy Change Management reports

Change managers’ activities mostly center around change request analysis, for example, determining the length of time spent on change requests, types of changes requested, and frequently repeated tasks.

If your administrator has not set up a preference server for centralized user preferences, you must enter the report server name and set the options to view and print reports.

To set options to view and print reports

1 From the Remedy User toolbar, choose Tools > Options.
   The Options dialog box appears.

2 Click the Advanced tab.

3 In the Report Server field, enter the name of the server that you are currently logged on to.

4 Click OK.

Note: If you are having formatting problems in viewing reports on the Web, ask your administrator to make sure report configuration settings are correctly defined in the AR System User Preference form, as described in the BMC Remedy Action Request System 7.0 Configuring guide.
Generating predefined reports

The BMC Remedy Change Management application includes predefined reports that are designed to help support staff managers monitor activities related to their service desk. These predefined reports are outlined in this section.

**Important:** If you use Crystal Reports or Business Objects software to modify the prepared reports supplied with BMC Remedy Change Management, Remedy Customer Support can only provide limited assistance if you should have a reporting problem. Further, there is no guarantee that problems resulting from these modifications can be solved. The standard reports included with BMC Remedy Change Management are designed to be used without modification.

To generate a predefined BMC Remedy Change Management report

1. On the Change Management Console, click the Reports link. (If you are in a change request, you can click Reports from Other Functions.)

The Report Console is displayed.

![Figure 6-4: Report Console](image-url)
2 Select a report name.

The list varies according to which other BMC Remedy ITSM applications are installed. For information about change reports, see “Predefined reports with Change Management” on page 307.

3 Select a destination for your report. The options are:

- **File**—Your report is saved to a file at the location and in the format you specify.
- **Screen**—Your report is displayed in a separate window.
- **Printer**—Your report is sent to the printer specified in the Print Setup dialog box.

4 Click Run Report.

Your report is sent to the specified destination.

### Generating reports using qualifications

You can generate a report using search criteria that you or another user has saved previously, or you can specify searches yourself and save them.

#### To generate a change management report using a saved qualification

You can narrow your search using a search that you have already created and saved.

1 On the Change Management Console, click the Reports link.
2 Select a report from the Report Name list.
3 Click the Select Saved Qualification button.

The Saved Qualifications dialog box appears listing your saved searches.

![Figure 6-5: Saved Qualifications dialog box](image-url)
4 Select a search from the table, and click Return Selected.

5 Click Close to return to the Report Console.

   The qualification appears in the Qualification field.

6 Select a destination for your report.
   
   - **File**—Your report is saved to a file at the location and in the format you specify.
   
   - **Screen**—Your report is displayed in a separate window.
   
   - **Printer**—Your report is sent to the printer specified in the Print Setup dialog box.

7 Click Run Report.

   Your report is sent to the specified destination.

- **To create a qualification for generating reports**

   1 On the Change Management Console, click the Reports link.

   2 Select a report from the Report Name field.

   3 Select a field on which you want to search by clicking the arrow and selecting from the list in the first column.

      For example, if you are generating a report of all the change requests created by a certain requester, select Requester ID, or a Start Date and an End Date. (Only those change requests with a Planned Start Date or an Actual Start Date that falls within this range is included in the report.)

   4 Select a qualifier from the Operand menu.

      For example, to find matching values, select the equal sign (=).

   5 Type the value by which you want to qualify the search in the Value field.

      For example, to find all change requests created by Joe User, type Joe User.
Repeat these steps for other fields to further refine your search.

To use an Advanced Qualification to further narrow your search

1. Click the Advanced Qualification button.
   The Advanced Qualification Builder dialog box appears.
2. Enter the appropriate search criteria in the Qualification field.
3. Select field names by clicking either the Fields From or the Fields From Current Form buttons and selecting from the list.
4. Select a qualifier from the display.
5. Add values by typing directly in the Qualification field.

Click Select when you have finished creating your advanced qualification to return to the Report Console.

The qualification appears in the Qualification field in the Report Console.
7 Click Save Qualification if you want to save your qualification. You are prompted for a qualification name. Enter a name and click OK.

8 Select a destination for your report.

- **File**—Your report is saved to a file at the location and in the format you specify.
- **Printer**—Your report is sent to the printer specified in the Print Setup dialog box.
- **Screen**—Your report is displayed in a separate window.

9 Click Run Report.

Your report is sent to the specified destination.

**Predefined reports with Change Management**

This section describes the predefined reports for the BMC Remedy Change Management application and is organized by reporting area. The reports described in the following sections are the reports that pertain to BMC Remedy Change Management. If you have other Remedy applications installed, other reports might be listed, and the reports might be grouped differently. For more information, see the appropriate User’s Guide.

Table 6-1 lists and summarizes the predefined reports installed with Change Management.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changes Scheduled by Configuration Item</td>
<td>Displays all scheduled change requests grouped by configuration item.</td>
</tr>
<tr>
<td>Changes By Operational Categorization</td>
<td>Displays all change requests grouped by operational categorization.</td>
</tr>
<tr>
<td>Changes By Change Manager</td>
<td>Displays all change requests grouped by the change manager.</td>
</tr>
<tr>
<td>Changes and Tasks</td>
<td>Displays all change requests along with their respective tasks and task groups.</td>
</tr>
<tr>
<td>Change Risk Report by Planned Start Date</td>
<td>Displays change requests grouped according to their Risk Level and Planned Start Dates.</td>
</tr>
</tbody>
</table>
Using the Broadcasts feature as a manager

Broadcasts enable you to view and create messages that can be viewed by the entire organization or by users in the support, approver, management, and administrator groups. You can access broadcasts from the Overview Console, Change Management Console, or from within a change request.

You can use the broadcast feature to view messages and to post messages to your group. Broadcast messages enable you to stay informed about activities within your organization. For example, you can use broadcasts to monitor systems, share information, and distribute documents.

For more about using broadcasts, see the following information:

- “Broadcasting messages” on page 98
- “Creating broadcast messages” on page 98
- “Creating or modifying a broadcast message” on page 102
- “Limiting the number of messages” on page 102

Creating change requests

You can create new change requests by clicking the New Change link and entering information in the new Change form.

For detailed information about creating change requests, see “Creating change requests—Basic steps” on page 162.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Impact Report by Planned Start Date</td>
<td>Displays change requests grouped according to their Impact, Urgency, and Planned Start Dates.</td>
</tr>
<tr>
<td>Changes By Calendar Date Range</td>
<td>Displays all change requests grouped within a specified range of dates.</td>
</tr>
</tbody>
</table>
Searching for change requests

You can search for existing requests by clicking the Search Change link. In the Changes form that is displayed, you can specify search criteria. Matching requests are listed in the Results table above the form.

For detailed information about searching for change requests, see “Viewing, creating, and modifying change requests” on page 160.

Managing configuration items

Inside Change Management, you can create a new CI, search for existing CIs, and update records. When creating a CI name, you should follow a consistent naming convention. According to ITIL guidelines, identifiers should be short but meaningful, and for hardware, not based on supplier device names. For example, the name could include an indicator of the CI’s function (such as “Workstation” or “Monitor”) followed by a numeric code, such as MONITOR100.

**Note:** When creating CIs in Change Management standalone, the data set is always taken from the AST:AppSettings form. For more information, see “Relating CIs to alternate data sets” on page 256.

The following section briefly describes how to manage CIs. For detailed information, see the *BMC Remedy Asset Management 7.0 User’s Guide*.

**To manage configuration items**

1. From the Manager Console, choose Advanced Functions > Manage CIs. The Select a CI Type dialog box appears.

**Figure 6-8: Select a CI Type dialog box**
2 From the CI Type list, choose a CI Type, for example, System > Computer System.

3 Click Search.

The Asset Management form for your specific CI Type appears.

Figure 6-9: Typical Asset Management form

Enter parameters about the CI into the form. You must enter information into these fields before you can search the CI record.

4 Perform your search.
Managing SLM service targets

When you click the SLM tab, you can review the SLM service targets. (You must have installed the BMC Service Level Management application to have this capability.) If SLM is installed, the Change form displays both overview and in-depth information about the change request in relation to applicable service targets.

Figure 6-10: SLM tab

The SLM tab displays the service targets and milestones for the restoration of the unavailability. Service targets and milestones are defined from within the Service Level Management application. Escalations can be set up to notify the assignment group prior to acknowledgement or resolution breach times.

From the Change form, you can view service targets defined in SLM. Service targets can be defined in SLM for response time, and resolution time. Service targets can be determined by related CIs, product and operational categorization, and many other criteria. The Next Target Date field indicates the next deadline out of all the service targets attached to the change.

For information about managing SLM, see the BMC Remedy Service Level Management 7.0 User’s Guide.
Working with change request approvals

Certain change requests must pass through an approval process before they can be implemented.

The application administrator determines which change requests require approval, what kind of approval process the change requests must undergo, and who the approvers are. Support staff and management can add more approvers to the list. For information about adding more approvers, see “Understanding the approval process” on page 208.

Figure 6-11: Approving changes

Change managers submit the requests for approval and monitor the approval process.

Approvers are notified when a change request requires their approval. After reviewing the change request, they can approve it or reject it.

As a manager, you might be required to review change requests for approval. You review change requests and provide approval through the BMC Remedy Change Management application.

See the pages listed for the following procedures:

- For information about reviewing the approval process, see “Working with Change Management as an approver” on page 346.
- For information about reviewing proposed change requests and providing or denying approval, see “Approving or rejecting change requests” on page 349.
- For information about adding approvers, see “Adding approvers” on page 352.
Calculating the costs of a change request

When a change request has been resolved, you can calculate the cost involved in implementing it. If a change manager or task implementer has already added a cost calculation, you can view the calculation.

You can calculate the various kinds of costs, and you can associate costs with CIs. All the costs of a change request are totaled automatically.

For information about how to view costs, calculate costs, and allocate costs, see “Working with costs” on page 283.

**Note:** Only users with Cost User permissions can delete or modify a cost, including the costs that they have submitted. In addition, users with Cost Manager permissions can configure the values that populate costs.

**To modify a cost**

1. Open the change request so that it is displayed in a Change Request Information form.
2. Click the Financials tab.
3 In the Show field, select the type of cost you want to view.

4 From the table, select the cost that you want to modify.

5 Click View.

The Costs dialog box is displayed.

**Figure 6-12: Costs dialog box**

![Costs dialog box]

This dialog box contains information about the kind of cost. You cannot make changes in the Cost Category field.

6 Change the Cost Center Code, Cost Type, Description, or other information as appropriate.

7 When you are finished, click Save.

The changed cost record is listed in the table.

▶ **To delete a cost from a change request**

1 Open the change request so that it is displayed in a Change Request Information form.

2 Click the Financials tab.

3 Select the cost that you want to delete.

4 Click Delete.

A message prompts you to confirm the deletion.
5. Click Yes.
6. Click Save to save the change request.

Using the Change Management Dashboard

The Change Management Dashboard of key metrics provides Flashboards associated with changes occurring in the organization. This Dashboard allows the organization to make sure that change-related activities are meeting identified goals. Viewing the Change Management Dashboard requires a separate license and you must be a member of the CM Dashboard User group.

Figure 6-13: Change Management Dashboard

The Change Management Dashboard uses BMC Remedy Flashboards to provide executives (like the CIO), the CAB, or change managers important data points and key metrics in a graphic and numeric format. The Change Management Dashboard helps executives and managers who are monitoring changes make sure their organization is meeting its identified goals. It provides a mechanism for organizational improvement, for example, if they see areas that need improvement.
To view the Change Management Dashboard, you must be a member of the CM Dashboard User group.

The Change Management Dashboard presents a set of statistics that provides a snapshot of the state of the Change Management process. You have a choice of which statistics to view and you can select criteria for focusing the view on the needed perspective, as well how far back to look at these data. Example statistics are the history of planned and unplanned changes over one of several time ranges, the number of authorized changes over, for example, the last week or month, and the success rate of changes made for the last thirty days.

The Change Management Dashboard helps you understand the trends relating to change configuration management (CCM) and take appropriate action to balance the flow. The Dashboard uses four different graphical Flashboards displaying change request metrics all on one screen. You can filter the data presented by the Flashboards by date to refine the information displayed.

You can configure the Change Management Dashboard as needed. For maximum flexibility, you can select various Flashboards to display on the Dashboard screen, along with a time period that applies to all the Flashboards displayed.

To use the Change Management Dashboard


2. Enter a start and end time for the Flashboard data that you want to view.

3. In the change statistics area, define how you want the Flashboards displayed:
   - **Overall Health**—Choose one of the following settings:

     | Flashboard name     | Metric                                                      |
     |---------------------|--------------------------------------------------------------|
     | Change Success Rate | Successful closed change requests by Status Reason            |
     | Changes by Priority | Open change requests by Priority and Category                 |
     | Changes by Timing   | Closed change requests by Timing and Risk                     |
     | Changes Successful  | Successful closed change requests by Group and Category       |
     | Changes Unsuccessful| Unsuccessful closed change requests by Group and Category     |
**Financials**—Choose one of the following settings:

<table>
<thead>
<tr>
<th>Flashboard name</th>
<th>Metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Cost Variance</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Changes by Cost/Category</td>
<td>Average cost of closed changes by Category</td>
</tr>
<tr>
<td>Changes by Cost/Department</td>
<td>Average cost of closed changes by Department</td>
</tr>
</tbody>
</table>

**Customer Data**—Choose one of the following settings:

<table>
<thead>
<tr>
<th>Flashboard name</th>
<th>Metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Requests by</td>
<td>Change requests by Organization and Company</td>
</tr>
<tr>
<td>Changes By Business Justification</td>
<td>Closed change requests by Business Justification</td>
</tr>
</tbody>
</table>

**Operational Efficiency**—Choose one of the following settings:

<table>
<thead>
<tr>
<th>Flashboard name</th>
<th>Metric</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Completion</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Change Status</td>
<td>Open change requests by change request Status and Support Group</td>
</tr>
<tr>
<td>Changes by Impact</td>
<td>Closed change requests by Impact and Category</td>
</tr>
<tr>
<td>Changes by Performance Rating</td>
<td>Closed change requests by Performance Rating and Group</td>
</tr>
<tr>
<td>Changes Completed</td>
<td>Completed change requests by actual End Date and Category</td>
</tr>
<tr>
<td>Changes Planned and Unplanned/Category</td>
<td>Closed change requests by Category/Company versus closed emergency change requests by Category/Company</td>
</tr>
<tr>
<td>Changes Planned and Unplanned/Groups</td>
<td>Closed change requests by Group/Company versus closed emergency change requests by Group/Company</td>
</tr>
<tr>
<td>Changes Rolled Back</td>
<td>Closed, backed-out change requests by Group and Category</td>
</tr>
</tbody>
</table>

4 (Optional) Click Refresh to refresh each of the four Flashboards shown including the date criteria (Start Date and End Date) specified, and display the change request data that matches the qualifications.
5 Click Set Defaults to open the User View dialog box where you can save which Flashboards automatically display when the Change Management Dashboard form is opened.

**Figure 6-14: Change Management Dashboard User View dialog box**

The list for each Flashboard category lists the available Flashboards. In the Duration field, you can select a time period to show data for the last 7, 30, or 90 days.

6 Save your changes.

**Viewing the CCM Change Calendar**

The CCM Change Calendar is a console for managing CCM change activities, intended to be used by CIOs in enterprises and members of the CAB, usually during a CAB meeting. It provides a graphical view of change requests and business events occurring in the organization.

The Change Calendar uses the graphical view to display change requests and scheduled business events, similar to the way a project management application displays activities and tasks as a Gantt chart, except that the Change Calendar is much more dynamic and interactive.

Aided by links to investigative and analysis tools, you can better understand the risk and impact of changes. As a result of better planning, you can make more productive decisions about the forward schedule of changes (FSC). The CCM Change Calendar helps you take into account the interdependencies and potential conflicts made more visible through the Calendar console.

For example, suppose you are planning a company-wide upgrade to a new version of Adobe Acrobat. When you open the CCM Calendar the first time, you might be viewing the full details of the change requests and business events over a 5-day period, as configured for you by the application administrator.
Looking at the day picker calendar, you quickly decide that scheduling a major upgrade to the latest version of Acrobat on Sunday April 9 (which is a Risk Level 1) would overload already strained resources. Thursday April 13 is a condition “green” day and therefore much more promising. You click the day picker to “focus” the main calendar with the clicked day as the start day. This lets you look more closely at the day’s scheduled changes or business events. Then you decide if you must see a more “granular” view of the data. From the Show menu, you choose to view 1 day’s worth of data, to see scheduled changes by the hour. The 1-day view lets you drill down to one-half hour granularity.

You see that there are no time segments blocked out for changes. You decide that you can upgrade Acrobat at 7:00 a.m. to 10:00 a.m., the same time that you are installing other software applications based on your configuration policy.
You can select a change request from the calendar and view its essential details, for example, its change ID, its status, and so on. You also can click View Full Details and the request then appears in the Change form. With a few clicks on the Change Calendar, you quickly moved from viewing 5-days worth of information to a specific change request.

**Filtering criteria in the Change Calendar**

The Change Calendar displays a graphical representation of change records defined by your search criteria. You can use the search criteria available in this tool to search for any upcoming changes for the week. This information can assist you in the scheduling of change requests.

Of particular interest to the CAB, the Calendar’s primary view is a calendar-like schedule display that shows a focused view of the change requests that matched the current filtering criteria, when they are scheduled to begin and end, and related business activities and events.
You can filter the view by selecting criteria for which change requests and business activities that you want to look at. You can specify whether the search should search for all changes, change records with CI relationships, or changes filtered by location. By changing these filtering criteria, you can focus on only those items that are of interest. The calendar highlights the aggregate risk assessment for each day. You can drill down from any change request or business activity and see more detailed information about the item.

The Calendar is divided into two areas. The area on the top displays a quick summary of all change records for the days that you are viewing. Each day in the calendar displays the aggregate risk of changes scheduled for that day. The area on the bottom of the Calendar displays those business events that might have a definite impact on whether the change request can be carried out.

To view the CCM Change Calendar

1. Use one of the following methods to open the CCM Calendar:
   - On the IT Home page, click the CCM Calendar View link.
   - On the Change Manager Console, choose Quick Links > View Calendar.
   - On the Change form, choose Quick Links > View Calendar.
   The CCM Calendar appears.

2. From the Show field, select how many days’ worth of change requests and business events you want displayed.

   Users can select the time scale. You can set it to view a single day, five days, or seven days. Each day is color-coded to indicate the risk associated with carrying out the changes that are scheduled for that day. Only change activities are shown in the one-day view.

   **Important:** The data for all views is gathered by querying all change requests that have Requested Time, scheduled times, or actual times in the interval. However, the 1-day view only shows change requests based on the Scheduled Time only while the 5-day and 7-day views show any change request whose Requested Time, Scheduled Time, or Actual Time interval falls in the view duration. Actual time is also factored into the query, even though only scheduled ranges are shown.
3 (Optional) Click the collapse button if you are not interested in viewing business events.

The calendar then displays only change requests. You can then click the expand button to see both changes and business events.

4 Select a change request.

A summary of the most important details about the change requests are displayed at the bottom of the change calendar. Click the View Full Details link to open the change request in the Change form.

5 Click a day in the calendar day picker to select the change requests and business events for a specific day.

Figure 6-17: Calendar day picker

The day picker shows the days of the month in which the currently displayed activities occur. You can change the month in which activities are displayed with controls on the calendar day picker, moving forward or backward a month at a time or the day in the month by selecting a specific day.

Each day is color-coded based on the “maximum risk rule” computation of the aggregated change requests scheduled for that day. In this way, you can focus the activity chart time line around, for example, a high risk day to see what activities are scheduled then.

Next to the day picker is a legend that reminds you what the various bars and the color-coding mean in the change calendar.

Figure 6-18: Legend
6 In the navigation pane, select a filter option for displaying change requests.
For more information, see “Displaying change requests” on page 323.

7 Select which business events you want to display.
For more information, see “Displaying business events” on page 325.

8 (Optional) Define your own user special defaults.
You can use other quick links as well. For more information, see “Using Quick Links” on page 325.

9 (Optional) Click Refresh to refresh the change requests and business events displayed in the Change Calendar.

Displaying change requests

The Change Request links in the navigation pane let you easily specify which change requests you see in the Change Calendar. When you select a filter option, its label is displayed next to the Show field to alert users which search is being shown.

Important: If you do not provide any criteria for the CI, Location, or Service CI, then the filter searches for change requests that satisfy the general given criteria. The Change Calendar displays all change requests that have any relation to CI, Location, or Service CI.

Quick Filter

Opens the Quick Filter dialog box.
You can create, save, and delete your own search criteria, based on the following categories:
- Change Status
- Approval Status
- Risk Level
- Priority
- Company
- Region
When you select a search and click the Search button, the results based on your search criteria are displayed in the Change Calendar.
Filter By Related CI  Opens the Filter Change Requests by way of Related Configuration Item dialog box.
You can create, save, and delete your own search criteria, based on categories, such as Change Status, Approval Status, and so on. But you can further filter requests by choosing options, such as Product Categorization (for example, Software) and Assignment (by manager’s name, group, or assignee).
Finally, you can include CI criteria in your search, for example, a CI class like software.
When you select a search and click the Search button, the results based on your search criteria are displayed in the Change Calendar.

Filter By Location  Opens the Filter Change Requests by way of Direct and Impacted Location dialog box.
You can create, save, and delete your own search criteria, based on categories, such as Change Status, Approval Status, and so on. But you can further filter requests by choosing options, such as Product Categorization (for example, Software) and Assignment (by manager’s name, group, or assignee).
Finally, you can include an impact location in your search, for example, by region, site group, or site.
When you select a search and click the Search button, the results based on your search criteria are displayed in the Change Calendar.

Service CI Search  Opens the Filter Change Requests by way of Service CI dialog box.
You can create, save, and delete your own search criteria, based on service CIs. Service CIs are in a hierarchical structure as defined by the user company. In searching for change requests by means of a Service CI, you can specify the depth level to search. For example, depth level 2 means that you are searching the specified CI, its children, and its grandchildren (in the hierarchy tree) for all the related change requests.
When you select a search and click the Search button, the results based on your search criteria are displayed in the Change Calendar.
For more information about service CIs, see the BMC Remedy Asset Management 7.0 User’s Guide.
Displaying business events

The Business Events links in the navigation pane let you easily specify which business events you see in the Change Calendar. Each business event has a level attached to it. Here you make sure you are comparing the same level of business events. Events displayed can be any level 0 and above.

**Important:** If the Company field is cleared (every filter has a company field), then all business events of all companies are retrieved. Otherwise, only business events associated with the given company are retrieved.

**Global**

This setting is especially useful in a multi-tenancy environment. The global flag retrieves business events with Global as company identifier.
- If selected, displays all business events.
- If clear, displays only the business events for the company.

**Level**

Retrieves level of business event indicated. If no level is defined (that is, it contains no value), all business events of all levels are retrieved.

Using Quick Links

Quick Links in the navigation pane let you easily select important functions from the Change Calendar.

**Set Defaults**

Opens the User Defaults dialog box.

Your application administrator can define optional defaults for you. But you can override the following settings:

- **Quick Search**—Defines user setting for displaying change requests, based on categories, such as Change Status, Approval Status, and so on.
- **Business Events**—Defines user setting for displaying global business events and their level.
- **Service CI**—Defines user setting of the depth level displayed for service CIs.
- **Duration**—Defines user setting of duration, for example, 5 day.
- **Print Preferences**—Defines user setting for page type and orientation when printing.

When you click the Save button, your user defaults are used after you close and open the Change Calendar.
<table>
<thead>
<tr>
<th>New Change Request</th>
<th>Opens the Change form in New mode. For information, see “Creating change requests—Basic steps” on page 162.</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Business Event</td>
<td>Opens the Registration for Shared Time Segment form in New mode. For information, see “Registering time segments” on page 183.</td>
</tr>
<tr>
<td>Open Change Console</td>
<td>Opens the Change Console. For information, see “Using the Change Management Console” on page 106.</td>
</tr>
<tr>
<td>Reports</td>
<td>Opens the Report Console. For information, see “Working with reports” on page 130.</td>
</tr>
<tr>
<td>Print...</td>
<td>Opens the Print Properties dialog box. You can select page type (letter or A4), orientation (portrait or landscape), or supply a title for the printable page if you do not want the default. Do not use the single-quote character ‘ in this string as you trigger a JavaScript error.</td>
</tr>
</tbody>
</table>
This section contains information about using the Change Management application as a task implementer to manage and fulfill your task assignments.

The following topics are discussed:

- Working with BMC Remedy Change Management as a task implementer (page 328)
- Accepting task assignments (page 329)
- Reassigning tasks (page 332)
- Searching for assigned tasks (page 333)
- Working with a task in progress (page 333)
- Closing tasks (page 335)
- Adding financial information to a task (page 336)
- Using CCM tasks (page 336)
Working with BMC Remedy Change Management as a task implementer

Task implementers are the people or groups responsible for the tasks related to a change request.

Figure 7-1: Implementing tasks in a change request

When a change manager sets the task status to Scheduled, the task implementers are notified of tasks assigned to them by email, BMC Remedy Alert, pager, or some other means. After a task is assigned, task implementers can log their progress as they complete each task. When all of the tasks related to a change request are either closed or canceled, the change is set to Complete and the requester is notified that the change is resolved.

For a helpful overview of the entire process, see the following items:

- “Relation of task states to change states” on page 214
- “Using CCM tasks” on page 336

Note: For more information about configuring and administering the Task Management System, see the BMC Remedy Task Management System 7.0 Administrator’s Guide.
Accepting task assignments

You receive notification of assigned tasks by way of BMC Remedy Alert, email, and so on. You can also use the Overview Console or the Support Console to view all tasks assigned to you. The table list includes a column that shows the assignee of the task. Tasks are identified by the TAS prefix. To access the Support Console, the task implementer must have Infrastructure Change Master, Infrastructure Change User, Infrastructure Change Submit, or (at minimum) Infrastructure Change Viewer permissions.

**Note:** Following the recommended life cycle of a change request, the status of a task should be in Scheduled before you accept the task. For more information, see “Steps in the life cycle of a change request” on page 44.

- To receive notification of task assignment by BMC Remedy Alert
  1. Log in to BMC Remedy Alert as a Support staff member.
  2. When you or your group receive a notification that you or your group have been assigned to a task, the information is displayed in BMC Remedy Alert.
  3. To evaluate a task, select the task listed in the BMC Remedy Alert window.
  4. Choose Alerts > Details.
     The task is displayed in a Task form in Modify mode.

- To accept an assigned task
  When a change request is set to Scheduled and a task is not assigned, the task status is set to Pending. If the task is assigned, its status is set to Work in Progress.

**Note:** When the change is in Planning in Progress, all the tasks have a status of Staged and a status reason of Staging In Progress. When all the tasks’ status reasons have become Staging Complete, the change moves from Planning in Progress to Scheduled For Approval.

  1. Open the Change Management Support Console.
  2. Select Personal from the Console View.
3 Use the Quick Actions to set task as the primary table and then execute the action.

4 In the Assigned Tasks table, select the task that you want to accept.
   Tasks are identified by the prefix of TAS.

5 Click View.
   The task is displayed. You can click the Open link next to the Request ID field to open the parent change request.

Figure 7-2: Task form

6 If you are ready to begin working on the task—that is, if the Status Field of the change request is set to Scheduled—set the Status field to Work in Progress.
   This is an important step, because the task then moves into Work in Progress status. In addition, different escalations occur based on the task’s status. If the task is still in the Scheduled state while you are working on it, an inaccurate escalation can occur.
7 Click the Assignment tab.

**Figure 7-3: Task form—Assignment tab**

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Start/Stop Clock</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Assigned Company</td>
<td>Start Time</td>
</tr>
<tr>
<td>Assigned Organization</td>
<td>End Time</td>
</tr>
<tr>
<td>Assigned Group</td>
<td>Time Spent Hours</td>
</tr>
<tr>
<td>Assigned</td>
<td>Total Time Hours</td>
</tr>
<tr>
<td>Notify Assigned</td>
<td></td>
</tr>
</tbody>
</table>

8 Enter time spent as appropriate.

When you are ready to start working on the task, you can use the start and stop clock or the effort log to keep track of how much time you spent.

9 Click the Work Info tab and then enter the progress you have made on the task.

Optionally, you can add relevant information to the Task Plans field to describe how you intend to complete the task.

10 Save your changes.

If this is the first task to be moved to Work in Progress status, the following changes are automatically made to the change request:

- The entire change request’s status is also moved to Implementation in Progress. This includes all tasks that comprise the change request. The change manager is notified of the changed status, and the requester is notified when the status of the change is set to Scheduled.
- In the Task Dates region of the Change form, the Start Date field is filled in with the date and time at which the task was saved.
Reassigning tasks

If you cannot resolve a task to which you have been assigned, you can reassign the task yourself, or you can ask the change manager to reassign the task. You might ask the change manager to reassign the task in situations where you want to reassign the task to someone outside of your group.

To reassign a task

1. In the Assigned Tasks table on the Change Management Support Console, select the task that you want to reassign.
2. Click View.
   The task is displayed.
3. Click the Assignment tab.

Figure 7-4: Task form—Assignment tab

4. In the Assignee Group or Assignee fields, choose the group or person to you want to assign the task to.
5. Make sure the Notify Assignee field is set to Yes.
6. Click Save.
   The new implementer is notified of the request assignment. Until the new implementer accepts the task assignment, you are still assigned to the task and have responsibility for it.
Searching for assigned tasks

You can search for tasks by entering the fields by which you want to search in the Task Information form in Search mode, and you can also search for tasks assigned to you or your group.

To search for open tasks assigned to you

1. Open the Change Management Support Console.
2. Select Personal from the Console View.
   Your open tasks are displayed in the Assigned Tasks table.
3. To view the details of a task, select the item in the list and click View.
   The task is displayed.

To search for open tasks assigned to your group

1. Open the Change Management Support Console.
2. Select Console View > Select My Groups > Show All.
   This option shows all the requests that are assigned to your support group. You also could display all the requests that are unassigned.
   The My Group Selection dialog box appears.
3. Select the needed group or groups you wish to query against by selecting the check box under View Group and then clicking Update.
   The open tasks assigned to your group are displayed in the Assigned Tasks table. If you belong to more than one group, the tasks assigned to all those groups are listed.
4. To view the details of a task, select the item in the list and click View.
   The task is displayed.

Working with a task in progress

As you work on implementing or completing a task, Change Management enables you to update the task with the progress you are making.
To modify a task

1. If you would like to see the parent change request for this task, click the Change Details tab in the Change Management Support Console. Details for the parent change request are displayed, including any work info entries.

2. In the Assigned Tasks table, select the task that you want to view.

3. Click View.

   The task is displayed.

   **Figure 7-5: Task form**

4. Update the fields as appropriate.

5. On the Task form, click the Work Info tab.

6. Create a work info history entry for the task.

7. Click Save.
Closing tasks

When you have completed a task, you are ready to close it.

To close a task

1. In the Assigned Tasks table on the support console, select the task that you want to view.
2. Click View.
   The task is displayed.
3. Click the Assignment tab.
4. Update the time you spent on the task.
   You can create an entry in the effort log as needed.
5. Click the Work Info tab.
6. Make an entry in the Work Info History field.
7. At the top of the Task form, set the Status field to Closed.

When a task is set to a status of Closed and certain conditions apply, you are given the option of updating related CIs that might be affected by this modification. For more information, see “Working with relationships and dependent change requests” on page 233.

8. Select a status reason to describe how the task was closed. The three closure codes are:
   - Success
   - Failed
   - Canceled
9. Click Save.
Adding financial information to a task

When you are assigned a task, you can contribute financial information for the task, for example, actual time spent on the task. The task must be activated first before you can update any financial information.

But you can only calculate actual charges for the change inside the change request itself.

For more information about calculating the costs of a change request, see “Working with costs” on page 283.

To add financial information to a task

1. In the Assigned Tasks table on the support console, select the task that you want to view.
2. Click View.
   
   The task is displayed.
3. Click the Financials tab.
4. Enter budgeted estimated total time in hours.
5. When you are finished with the task, enter the actual total time.
6. Enter your calculation unit type, for example, flat rate.
7. Save your changes.

All this information is calculated and rolled up into the change request.

Using CCM tasks

Change Management 7.0 comes installed with the predefined task and task group templates that you can use out of the box for deploying or installing software and verifying task completion. This section how you can launch CCM tasks at run time from a change request.
Using CCM tasks to install software and verify compliance

1. Open Change Management and then create a change request. Although you can add tasks or task groups to a change during any state, for example, Initiate, they can only be worked on during the Implement state.

2. Use the process flow accelerators to advance through the states of your change request until you reach the Implement state.

3. Click the Task tab.

4. From the Request Type list, select Task Group Template and then click Relate. The Select Template dialog box appears.

5. Select a task group, for example, Automatic Verification and then click Relate. This task group comes for use out-of-the-box for deploying software and verifying task completion. The task group is then added to the change request.
6. (Optional) Click View Flow to see a read-only view of the task flow in the task group.

**Figure 7-8: Task Flow Viewer**

The Task Flow Viewer uses color codes to illustrate the different stages of the tasks. For example, a blue stage indicates that its status is Closed, but a yellow stage shows its status is Staged. The Viewer also shows you the flow between tasks.

You can also perform the following functions in the Task Flow Viewer.

- Zoom in to focus the view.
- Zoom out to expand the view
- Click the pan buttons to move the flow around.

7. Select the task you want to work on and then click View.
8 Click the Relationships tab.

9 Perform a search for a Software Library Item.

The Software Library Item Search dialog box appears. The SLI is the software that is being deployed. The SLI contains the “location” of the software. The SLI location can be either an actual physical repository (Fred’s top drawer) or electronic (a folder on your network).
Perform a search for an SLI and then click Relate. The Relationship Attributes dialog box appears.

Define the relationship attribute, for example, SOURCE.

Define the action attribute, for example, INSTALL.

Click Apply.

Close the dialog box.

The SLI is added to the change request.

Perform a search for a Configuration Item.

The CI Relationships Search dialog box appears. CIs are the actual machines where the software is deployed.
Perform a search for a CI and then click Relate. The Relationship Attributes dialog box appears.

Define the relationship attribute, for example, TARGET.

Define the action attribute, for example, INSTALL.

Click Apply.

Close the dialog box.

The CI is added to the change request.
**Note:** When the SLI and the CI are related to the task, the relationships are carried over to the change. If a task implementer wants to select SLIs or CIs related to the change to relate them to the change, use the Get Related Relationships quick action on the Relationships tab on the Task form. A similar quick action is found on the Task tab on the Change form to allow the change to relate SLIs or CIs to a task related to the change entry.

21 Click the General tab.

22 Click Launch.

The Policy Manager tool appears.

**Figure 7-14: Policy Manager**

[Image of Policy Manager tool]

**Important:** If you have deployed the integrated CCM solution with seamless authentication, the task implementer can launch the task from Change Management or Configuration Management without having to retype your user ID and password.

23 After you have performed the policy changes, click Save.

24 Close the Policy Manager window to return to the Task form.

25 (Optional) Review the Work Info about the task.
The work information for the task is updated with the changes performed by the task.

a. Click the Work Info tab.

b. In the Work Info History area, select the Policy Manager entry and then click View.

The Work Info dialog box appears.

Figure 7-15: Work Info dialog box

- Close the dialog box when you are finished viewing the information.
- Click Report to view an ASCII-format report of the task changes.

The report lists the software installed, if the policy was successful, and so on.

26 In the Status field, set the task status to Closed.

The status reason automatically is set to Success. You can select a different status reason, for example, Failed or Canceled.

27 After you have made all your modifications, save and close the task.

The Task form closes and you are returned to the change request.

28 Refresh the children of the task group table.

The status of the first task is marked as Closed and the status of the second task is now Waiting.
29 Open the second task:
   a Select the Check Compliance task and then click View.
      The Task form appears.
   b Click Details to view the target and package compliance.
      The Viewer window for Policy Manager appears.

   Figure 7-16: Policy Manager Viewer

   c Verify the compliance in Policy Manager.
   d Close the Viewer when you are finished to return to the Task form.

30 In the Status field, set the task status to Closed.
   You can view the work information for the task as needed. The task record is
   updated with the changes performed by the task.

31 After you have made all your modifications, save and close the task.
   The Task form closes and you are returned to the change request.

32 Refresh the children of the task group and the task and task groups tables.
   All tasks and the task group are marked as Closed.

33 Save the record.
Chapter 8 Approver role

This section describes the approver role. The approver uses this application to review, approve, or reject change requests, and to ask for more information about them.

The following topics are discussed:
- Working with Change Management as an approver (page 346)
- Approval phases (page 348)
- Approving or rejecting change requests (page 349)
- Adding approvers (page 352)
- Viewing non-approver notifications (page 353)
Working with Change Management as an approver

Change Management 7.0 is fully integrated with the BMC Remedy Approval Server for business, technical, and financial approvals.

Approvers are responsible for reviewing their assigned change requests, and for approving or rejecting them. Approvers are configured by the application administrator and are responsible for change requests with a specific categorization and location. The application administrator also determines which types of change requests need approval, and what type of approval process they require.

Figure 8-1: Change request going through approval

A change request goes through several phases as it progresses through its life cycle. The Process Flow Status area prompts users to approve the change request. A change request in the Request for Authorization state is shown next. To approve the change request, the required users must click the accelerator in the Initiate stage and then approve, cancel, or reject the change request before it can then move to the next stage.

Figure 8-2: Process Flow Status area—Approving the change request

Approvers can approve or reject change requests. If they need more information about a change request, approvers can request that information.
There can be more than one level of approver, and there can be several approvers on each level. All approvers on each level must approve the change request before the change can be reviewed by the next level of approvers. Approvers can review the actions of previous approvers by viewing their comments and the approval audit trail.

The application administrator can also configure the change management chain (parent-child) approval process. If the change is configured for the management chain approval process, the requester’s manager is notified.

If the change is approved by all approvers, the approval process is complete. If the change is rejected by any approver, the approval process is stopped. The supervisor can then cancel the change or update it and resubmit it for approval.

For more information, see “Understanding the approval process” on page 208. For information about chain approval processes, see the *BMC Remedy Approval Server 7.0 Guide for Users and Administrators*.

**Approval criteria**

The main criteria used to determine approvers include the following categories: Impacted Areas (Company, Organization, Department, Region, Site Group, Site), Operational Categorization, Product Categorization (Product Categorization of associated CIs are used in place of the Product Categorization on the change form when available), the Requester Support Group structure, the Change Manager, Change Assignee, and Change Implementer Support Group structures.

In addition, advanced criteria available are Timing, Timing Reason, and Change Type. Approvers can also be created on an *ad hoc* basis for existing change requests by the Change Manager, Change Assignee, or the Requester of the change request. The Requester of the change request can only create ad hoc approvers when the Change record is in Draft status.
Approval phases

Approvals in the Change Management application are divided into four main phases:

Review Phase: Occurs when the status of the change request becomes Request for Authorization. When approved, the status changes to Request for Change.
- If no approvers are defined, the change request is moved to the Request for Change state, and requires the Change Manager or Change Assignee to move the change forward.
- If the Request for Change state does not have any approvers, the change is moved to Planning in Progress.

Business Approval Phase: Occurs when the change request is placed in Request for Change status. When approved, the change is placed in Planning In Progress. If no approvers are defined, the change request moves to Planning In Progress and requires the Change Manager or Change Assignee to approve it before the change can move forward.

In addition, a Business Approval Phase with No Impact is available for pre-approved changes where the change is automatically scheduled after the approval phase is satisfied.

Implementation Approval Phase: Occurs when the change request is placed in Scheduled for Approval status. When approved or there are no approvers, the change is then set to a status of Scheduled.

Close Down Approval: Used when the change request is placed in Completed status with a status reason of Final Review Required. When approved, the status reason is automatically updated to Final Review Complete.

For more information about approval phases, see “Steps in the life cycle of a change request” on page 44.

The Approvers tab shows the groups and individuals who must approve the change request. Approvals can be generated automatically, based on information captured on the change request. They can also be generated manually on an ad hoc basis. A pending approval in Request For Authorization status is shown next.
Approving or rejecting change requests

You can use the accelerators in the Process Flow Status area or the Approvers tab to quickly approve or reject change requests. The Approvers tab automatically lists all the change requests that are pending your approval.

To approve or reject a request using process flow accelerators

1. Open the change request.
2. Advance through the states of your change request until you reach an approval stage.
3 Click the process flow accelerator in the stage and then approve, cancel, or reject the change request.

Figure 8-4: Approving the change request using process flow accelerators

The change request must be approved before it can move to the next stage.

4 Save your changes.

To approve or reject a request using the Approvers tab
1 Open the change request.
2 Advance through the states of your change request until you reach an approval stage.
3 Click the Approvers tab.

Figure 8-5: Approving the change request in the Approvers tab

All change requests that have been assigned to you for approval are listed in the Approvers tab.
4 Use the Show field to filter which approvals you see.

The following options let you filter the approval signature entries on the table. No action is taken without refreshing the table contents. The options are:

- **Pending**—This is the approval request’s state when you receive the request.

- **Approved**—Setting the request to this status can complete the approval or trigger the next step in the approval process. For example, it can send the approval request to the next approver if there are several levels of approvers.

- **Rejected**—Setting the request to this status denies a request and completes the approval process, regardless of whether more approvers are defined. A signature cannot be modified after the request has been rejected. The approval process is considered finished. If the change request is to be implemented, the change manager must first restart the approval process.

- **Hold**—Places a change request in a Hold state. By placing a change request in Hold, approvers acknowledge receipt of a request, and indicate that they are not ready to take further action.

- **More Information**—Additional information is needed by the approver before action can be taken on the change request. For more information about reviewing and responding to (if appropriate) More Information requests, see the *BMC Remedy Approval Server 7.0 Guide for Users and Administrators*.

- **Canceled**—Used only by workflow. You cannot set it.

- **Error**—Used only by workflow. You cannot set it.

- **Closed**—Used only by workflow. You cannot set it.

5 Select the change request that you want to work with.

6 Approve or reject the change.

The request is removed from the list of approvals. The change request must be approved before it can move to the next stage.

7 Save your changes.
Adding approvers

When a change request is configured to require approval, you should review who the approvers are and, if appropriate, create additional approvers. The following rules apply:

- You can add Support Groups or Individuals as approvers.
- Group approval requests are sent only to group members with the Infrastructure Change Approver role.
- If an individual approver is needed, only people defined as Support Staff within the People form can be chosen as approvers.

To add approvers

1. Open the change request.
2. Advance through the states of your change request until you reach an approval stage.
3. Click the Approvers tab.
   
   The Approvers table displays the list of approvers generated for the change request. Their signature is required for approval. You might need to refresh the table to see the lists. The list displays the following information:
   
   - Approval Status—Indicates status of work on the change.
   - Approvers—Indicates the names of the approvers.
   - Approver Signature—Indicates who owns the signature.
   - Alternate Signature—Displayed when someone other than the original signature owner has approved or rejected the change.
4. Click Add.
   
   The Add Approver dialog box appears.

Figure 8-6: Add Approver dialog box
5 Select an individual or a group to add.
6 Enter the name of the individual or group.
   You can add more than one individual approver or group.
7 (Optional) To search for an individual, enter a name or initial in the Full Name+ field and press Return.
   The People Search form appears.
8 Click Save and close the dialog box.
   You might have to refresh the table field to display all approvers.
9 Save your changes.
   The approver is notified that they must review the change request.

Viewing non-approver notifications

You can view non-approver notifications associated with a change.

To view notifications

1 Open the change request.
2 Advance through the states of your change request until you reach an approval stage.
3 Click the Approvers tab.
4 Click View Notifications.
   The Non-Approver Notifications dialog box appears.
In the Notification For field, select which notifications you want to view. The options are:

- Individual
- Group
- Inherent Group/Role

Enter a first and last name, as needed.

In the Status field, select Pending (default) or Notified.

Click Add.

The notification appears in the table.

Click Delete to remove the notification.

A warning appears, verifying that you want to delete the selected notification.

Click Yes to delete the selected notification.

The notification is removed from the table.

Close the Non-Approver Notifications dialog box.
Appendix A  
Change and Configuration Management (CCM)

This section provides an overview of Change and Configuration Management (CCM). The following topics are discussed:

- About Change and Configuration Management (CCM) (page 356)
- Processing Configuration Management tasks (page 358)
- CCM solution overview (page 360)
**About Change and Configuration Management (CCM)**

Closed loop integration with BMC Configuration Management is the mechanism for the accelerated execution of a change request. It also provides verification that the change was successfully performed, based on requirements specified in the change request.

When you perform a change to the configuration of IT managed resources, you must maintain consistency and control through the entire process. A “closed loop” approach makes sure that the change is properly documented, assessed, tracked, implemented, and verified. A closed-loop CCM solution from beginning to end makes sure that the change requested was actually completed. All of these stages are provided in the BMC Change and Configuration Management (CCM) suite of products. This section provides an overview of the integration points between the components found in the solution.

**Figure A-1: BMC Remedy CCM solution overview**
The BMC CCM solution addresses three types of change essential to an IT organization:

- Software packaging
- Patch deployment
- Software licence management

Among the numerous advantages in using BMC’s CCM solution are these:

- Consistent identification of Configuration Items (CI) and Software Library Items (SLI) throughout the change process, which improves communication between members of the support staff.
- Reduction of cost and overhead using an integrated out of the box solution that preserves flexibility.
- Automatic transfer of critical information between steps to maintain the integrity of the change.
- “Closed loop” verification of software-related tasks to make sure that the change was made successfully and to provide an audit trail.

At the heart of the CCM solution is the BMC Atrium CMDB. The BMC Atrium CMDB, in the context of ITIL, supports the following primary functions:

- Accounts for all IT assets.
- Provides accurate information to support other Service Management processes.
- Provides a sound basis for Incident, Problem, Change, Asset, and Release Management.
- Enables the verification (and correction) of records against the infrastructure.
- Provides access to federated data stored outside the BMC Atrium CMDB, but linked to CIs, extending the BMC Atrium CMDB functionality to a vast data store of related information and detailed attributes.
- Related information, such as detailed Incident or Discovery data, does not by itself qualify as a CI, but its data relationships with CIs enable you to view it through the BMC Atrium CMDB.
- Detailed attributes, such as machine details or problem records, are CI attributes you don’t track at the BMC Atrium CMDB level.
Processing Configuration Management tasks

A change request can include multiple configuration management tasks, each essential to the successful implementation of the change. The CCM Task Management Subsystem (TMS) manages these tasks in a sequence you define.

The CCM solution organizes tasks into three main categories:
- Policy-based
- Deployment-based
- Verification-based

Policy-based tasks

BMC Configuration Management enables you to maintain centralized control of packaged data and applications across the enterprise. You administer the state of each endpoint on your network using Policy Manager. A policy consists of a list of software packages or patches your targets (users, machines, or groups) are supposed to have. Use Policy Manager to manage the state of software and data on an ongoing basis.

Policy-based tasks include:
- Deploying applications and data
- Deploying patches
- Harvesting licenses when you have exceeded maximum limits
- Enforcing the removal of unauthorized applications
Deployment-based tasks

BMC Configuration Management also supports the deployment of large volumes of software or data, and execution of one-time jobs. You administer these tasks using Deployment Manager (DM). Use DM to execute deployment jobs that typically do not require ongoing management. Deployment-based tasks include distribution of:

- Data
- Applications
- Commands and scripts

Verification-based tasks

The Task Management Subsystem launches verification tasks when it receives notification that a policy-based task has succeeded. You can verify compliance for policy-based tasks based on a target, package, or both.

You can configure TMS to launch verification tasks manually or automatically. The system verifies tasks based on:

- The compliance percentage of specified targets or software packages.
- A time window that you specify for completing the task.
CCM solution overview

The need for a company to have the latest version of a software application installed on their system is a perfect example of a typical CCM solution. The following scenario describes a CCM solution in which users interact with the BMC Remedy ITSM suite, including an IT Product/Service Catalog and fulfillment. Imagine users who need Adobe Acrobat on their computer. This requires that the IT organization undertake a service-related Change process.

Figure A-2 illustrates how to initiate such a change request.

Figure A-2: Life cycle of a change request
Step 1  **Request**—The user submits a service request to install the latest version of Adobe Acrobat on his system. His manager receives a notification of the service request requiring her approval. She sees no problem with this request for change (RFC) and approves it. Workflow then generates a change request ID.

Business rules in the Change Management application make sure that the RFC is automatically routed to the appropriate support group or individual. The Change Manager receives notification that an RFC has been assigned to him. In this scenario, he is also the Change Assignee.

Since this request is not urgent, workflow routes the RFC as a standard change. However, the Change Manager recognizes that the entire company, not just this one user, should receive the latest version of Acrobat. As a result, even though the change’s urgency is medium and its timing is normal, the impact of such a company-wide installation is extensive.

If the request is urgent, for example, a mission critical server has crashed, then an entirely different business policy would be implemented.

Step 2  **Planning**—The Change Manager plans a forward schedule of changes (FSC). The change request includes planning all the changes approved for implementation, targeting dates, and estimating the risks and costs. The time segment for the change is scheduled on the calendar. The Change Manager reviews the RFC and verifies that the correct change request template and tasks are connected to the change request generated by the service request. Here the Change Manager relates the two Policy Manager and Compliance Check tasks (already provided with the Change Management application) to the change request. If necessary, he can edit the appropriate change request and task information.

He updates the RFC by adding the appropriate implementers or assignees for the tasks, as well as any Backout, Test, and Implementation plans if needed. Finally, he adds the appropriate date information for the tasks and updates the Status of the RFC from Planning in Progress to Scheduled.
Step 3  Approval—Since this is a standard change, the business rules dictate that this type of change does not require any additional approvals. The Change Manager approves it.

*If* the change request requires additional approval, for example, because the change’s impact is not just widespread but also potentially disruptive to users, the Change Manager initiates the approval process. In this case, each level of approvers must review the request and approve it. Within the ITIL framework, the Change Advisory Board (CAB) must approve all significant changes.

Step 4  Implementation—Workflow routes the tasks to the task implementers. BMC Configuration Management takes over the process of task management and verification. The Task Management Subsystem (TMS) within Change Management hands off policy, deployment, or verification tasks in the specified sequence. You can configure verification tasks to kick off manually or automatically, but after TMS initiates them, they run automatically. Figure A-3 illustrates the life cycle of a configuration management task.
Step 5  **Create Policy**—The task implementer receives notification of the task to install the latest version of Adobe Acrobat company wide. She uses Change Management to view the “Install Acrobat” task.

Unlike a change request process—where multiple users engage in the request, planning, approval, implementation, and review stages—a Configuration Management task process benefits from automation features in the update or deployment stages.

In this scenario, saving a policy is the first step. The task implementer creates or updates a policy, then reviews job details.
Important: If you launch a BMC Configuration Management console window from Change Management to edit a policy or deployment job, make sure to work on only one Configuration Management task during that session. Launching new browser windows can create session conflicts and corrupt your data.

As the change request enters the Implementation stage, task implementers log their progress as they work to implement the change request and its related tasks. When the first task is completed, task implementers for the next stage in the sequence are notified of their task assignment. Task implementers can calculate the cost of implementing their tasks.

Step 6  Review Details—The task implementer reviews the details and makes any necessary edits.

She views task details from TMS, retrieving data based on the Change ID and Task ID. She creates a new policy as required.

Change Management fills out the application’s online form with the BMC Atrium CMDB data the task requires, in this case, a target. The BMC Atrium CMDB contains a single source of truth about the content and configuration of machines on your network. The BMC Atrium CMDB is updated as task implementers work on the CIs that need improvement or alteration. In addition to the target information provided by the BMC Atrium CMDB, the Definitive Software Library (DSL) provides source information about Software Library Items (SLIs). SLIs represent the packaged software and data available in the system.

Because her company has deployed the integrated CCM solution with seamless authentication, which uses web services as the communication protocol between Change Management and Configuration Management, the task implementer can launch the task from Change Management or Configuration Management without having to retype her user ID and password.

Step 7  SPM:Update—She uses Policy Manager to update policy information and store the policy in the directory service. When she saves a policy, Policy Manager sends a Success message to TMS.
Step 8  Get Details—When tuners running on the endpoints check in, they receive their new policy and update the local machine. Because packaged applications use the BMC Configuration Management channel format, the process takes advantage of file compression, bandwidth throttling, checkpoint restart, and byte-level and file-level differencing. The location of a package application is captured in the DSL as Software Library Items are available for future service requests.

At the scheduled time, all company computers are updated by the Policy Service running on their systems.

Step 9  Query Compliance—The verification task queries the BMC Configuration Management inventory database for information about the compliance percentage you specified as the threshold for success, and elapsed time. The goal IT configured in the compliance task was to deploy the software on 80 percent of the company’s machines within seven days.

When the task achieves the specified compliance level or the time window expires, the verification process sends a status message back to TMS.

In this scenario, the verification process notifies TMS that the task completed successfully. In this case, at least 80 percent of the machines are in compliance within seven days.

All necessary information regarding the task identifier, target, and packages is automatically transferred back to Change Management.

If the task is not successful, the task verification process notifies TMS of the failure. Details of the failure from Configuration Management are recorded in the Work Info tab of the change request and the task is then closed with a status reason of Failed.

The configuration management life cycle is now finished. Change management picks up the process again at the Review step.

Step 10  Review—The change request enters the Review stage. The task implementer must now verify that the task has been completed.
During the task and verification process, BMC Configuration Management captures audit trail data, including:

- Task ID
- Change ID
- Time stamps
- Machines

In BMC Configuration Management’s Report Center, you can view predefined queries on the Machine Details page summarizing tasks performed on any computer. For more information, see the Report Center Administrator’s Guide (available on the BMC Customer Support website) or Report Center help.

When all task implementers finish their tasks and mark them as Closed in Change Management, the system notifies the requester that the change request has been resolved.

When the requester is notified of the status change, the requester can close the change request by setting the Confirm Resolution to Closed. If the requester does not close the change request, the request closes automatically after a preconfigured time. If the change request is part of a dependent sequence, the Change Manager for the next change request in the sequence is notified.

Reviewers verify that the change request was completed successfully. For example, they can analyze key performance indicators (KPIs) that apply performance analytics to the change, such as how many incidents the change eliminated. Reviewers can also analyze the accuracy of the BMC Atrium CMDB.

The service request and the RFC are Closed.
Appendix

Change request status transitions

The following change request status transition diagrams are included for reference. You can use these to follow the flow of a change request from the Draft to the Completed states.
Figure B-1: State transitions—Steps 1 to 7

1. Draft
2. Request for Authorization
3. Review
4. Request for Change
5. Business Approval
6. Planning in Progress
7. Staged

Change States: Draft → Request for Authorization → Review → Planning in Progress → Schedule for Review → Schedule for Approval → Implementation Approval → Scheduled → Implementation in Progress → Completed (Final Review Required) → Closed

Approval Phases: Staged → Task Staged

Task Group States: Staged → Task Staged

Task States: Work in Progress → Pending Assigned → Work in Progress → Closed

Completed (Final Review Completed) → Closed

Cancelled

368 Appendix B—Change request status transitions
**Step 1** When a change request is created, it moves into the Draft state. The approval group or approvers are notified that the change request requires approval for the Review phase. Any task groups or tasks are in the Staged state. Tasks are marked as Staging in Progress in the Status Reason field.

- If there are approvers in the Review approval phase, the change remains in the Request for Authorization state.
- If the Timing of the change is No Impact, it moves to the Scheduled state.
- If the Timing of the change is Latent, it moves to the Completed state.

**Step 2** If there are no approvers in the Review approval phase, the change request moves to the Request for Change state and the change manager or the change assignee are notified. The change request requires that the change manager or change assignee to approve it before the change can move forward.

**Step 3** When the change request is in the Request for Change state, the approval group or approvers are notified that the change request requires approval for the Review phase.

**Step 4** The change remains in the Request for Change state if there are approvers in the Business Approval phase. If there are no approvers in this phase, the change moves to Planning in Progress.

The change moves automatically to Planning in Progress when all approvers approve the change. Change managers and change assignees can approve the change on behalf of the approvers. If they cancel the request, it moves to the Canceled state.

**Step 5** Approval group or approvers are notified that the change request requires approval for the Business Approval phase.

**Step 6** Change manager or change assignee is notified that the change is ready for planning. When the status reason of all the tasks has been marked as Staging Complete, the change moves to the Scheduled for Review state.

**Step 7** Task implementers are notified that the task or tasks are set to staged.
Figure B-2: State transitions—Steps 8 to 16

Step 8  Change manager or change assignee is notified when the change request is in the Schedule for Review state. The change can be moved into the Scheduled for Approval State, canceled, or moved back to Planning in Progress state.
Step 9  The change remains in the Scheduled for Approval State if there are approvers in the Implementation Approval phase. If there are no approvers, the change moves to the Scheduled state.

Step 10  Approval group or approvers are notified that the change request requires approval for the Implementation Approval phase.

Step 11  The change automatically moves to the Scheduled state when all approvers approve the change or if there are no approvers. Change managers and change assignees can approve the change on behalf of approvers. In the Scheduled state, the change manager, change assignee, and change requester are notified when the change request has been scheduled as a change with no impact. For taskless changes only, the change implementer is notified. Tasks can be set to the Assigned state.

Step 12  When the change manager or change assignee moves the change request into the Implementation in Progress state, the task group is set to Work in Progress and the first task is set to Pending or Assigned.

Step 13  In the Implementation in Progress state, the task implementers are notified to start working on tasks. They set the task to Work in Progress when actual work begins. Task implementers can now update the task information and start implementing the task.

Step 14  After last task is marked as Closed, the task group is set to Closed. The change manager, change assignee, and change requester are notified that the change request is completed. Workflow enters required information into the Actual Start Date, Actual End Date, and Performance Rating fields.

The change automatically moves to the Completed (Final Review Required) state when all the tasks have been completed and there are approvers for the Close Down phase. Change managers and change assignees can approve the change on behalf of approvers.

Step 15  Approval group or approvers are notified that the change requires approval for the Close Down approval phase. The change request is placed in Completed status with a status reason of Final Review Required. If approved, the status reason is automatically updated to Final Review Complete.

Step 16  Change manager or change assignee is notified when the final review is completed. The change automatically moves to the Completed (Final Review Complete) state when all tasks are completed and there are no approvers for the Close Down phase.
Figure B-3: State transitions—Steps 17 to 19

Appendix B—Change request status transitions
**Step 17**  After the final review is completed, the change request moves into the Closed state.

**Step 18**  If a change has been rejected, it can be moved back to the Canceled state. The change manager or change assignee can also move it back to the Draft state and start the process over. The change requester is notified of the rescheduled change.

**Step 19**  If change request is canceled, requester is notified.

- If a change request is canceled, all the task groups and tasks associated with the change are canceled as well.
- If a task group is canceled, all its tasks are canceled.
This glossary contains terms for all of the ITSM applications.

For a list of AR System terms, see the glossary in *Action Request System 7.0: Concepts Guide*.

For a list of CMDB terms, see the glossary in *BMC Atrium CMDB 2.0 Concepts and Best Practices Guide*.

**accelerated depreciation**
Any method of depreciation that allows greater deductions in the earlier years of a CI’s life cycle. See also *depreciation* and *configuration item (CI)*.

**access permission**
See *permission group*.

**action**
A mechanism, such as an alert or a Set Fields action, for making sure that SLM commitments are met. You can define one or more actions that are associated with a milestone.

**administrator**
See *application administrator*.

**Application Administration console**
The main interface for configuring ITSM applications. The console works like a control panel from which administrators can perform common configuration activities and activities specific to different ITSM applications and subsystems.

**agreement**
A documented understanding between two parties. An agreement can be one of three types: service level agreement, operational level agreement, or underpinning contract. See also *service level agreement (SLA)*, *operational level agreement (OLA)*, and *underpinning contract (UC)*.

**agreement owners**
A feature that allows you to select which individuals or groups of people to notify at certain times, for example, when an SLA is at risk or when an SLA is going to expire.

**application administrator**
An individual responsible for the management of the ITSM applications, including setting up forms, setting access rights for users, and creating configurations.

**Administration console**
See *Application Administration console*.
approval
A process that generates electronic signature lines for items that require approval, and tracks who has approved or rejected a given request.

asset manager
The manager responsible for both strategy and day-to-day CI management functions, for example, updating CIs and configurations, running reports, or negotiating contracts.

assignee
The person assigned the responsibility of working on any of the following activities: change request, incident ticket, problem investigation, known error, solution database entry, and so on.

assignment
Automatically or manually assigning a group or individual the responsibility of resolving an issue or request. ITSM applications use the Assignment form for group automatic assignment and the Assignment Engine for individual automatic assignment.

audit schedule
A schedule used to perform periodic audits that check for differences between the information in the CI database and the CIs that are deployed in the company.

availability service target
A service target that measures the time that an asset or service is available or unavailable. This service target applies specifically to data that is tracked in an application based on AR System, such as Asset Management.

BMC Atrium Configuration Management Database (BMC Atrium CMDB)
An infrastructure built on AR System and used to build data models and define datasets.

book value
The value of a CI equal to the purchase cost minus the accumulated depreciation.

broadcast message
An application feature that enables users to create messages that can be viewed by the entire organization or by users in specific groups.

BSM
See business service management (BSM).

bulk inventory
Assets that you order in quantity, such as power cables.

bulk items
Items that are not tracked by an individual record for each unit. Bulk items in inventory are tracked by quantities of an item type. For example, items such as cables do not require individual records but rather, one record for a bulk quantity of the specific cable type.

Bulk Performance Manager Node
A feature that allows the administrator to add multiple nodes to a service target at one time. This feature is specific to collection nodes for BMC Performance Manager. See also collection node.
business service management (BSM)
A flexible, comprehensive management approach that links IT resources and business objectives. BSM makes sure that everything IT does is prioritized according to business impact, and enables IT organizations to proactively address business requirements.

CAB
See change advisory board (CAB)

CCM
See Change and Configuration Management.

change advisory board (CAB)
A group that advises change management on the implementation of significant changes to the IT infrastructure. This group is often made up of representatives from various IT areas and business units.

Change and Configuration Management
An application feature that proactively manages both IT and business-driven changes, and protects the IT environment. It does this by using planning and decision-making data contained in a dedicated BMC Atrium CMDB.

change authority
The name of a group with the authority to approve changes. This group can also be called the Change Advisory Board. See also change advisory board (CAB).

change management
As a concept, the process of planning, scheduling, implementing, and tracking changes to the IT infrastructure, or any other aspect of service, in a controlled manner. By using change management, you can implement approved changes with minimal disruption to the business environment.

change manager
A person responsible for filtering, accepting, and classifying all change requests. The change manager is also responsible for planning and coordinating the implementation of the changes. Sometimes known as a change supervisor.

change request
The controlled process for the addition, modification, or removal of approved, supported, or baselined hardware, networks, software, applications, environments, or systems. A change request can involve multiple change activities.

charge-back
The process of charging departments or cost centers for the IT infrastructure required to support their business processes.

charge-back invoice
A detailed list of charges to cost centers, including any charge-back percentage.

charge-back percentage
A percentage used to calculate charge-back costs.

charge-back report
A report used by a cost manager to track information and find entries that might need to be adjusted.

charge-back summary
The total charges made to cost centers, including charge-back percentage. For split cost centers, it also provides information about how charges are allocated for source cost centers and target cost centers.

CI
See configuration item (CI).
CI browser
A component of ITSM. The CI browser lets you search for and view CIs and their relationships.

CI unavailability
The downtime of a CI.

CI unavailability record
The time when a CI is either partially or completely unavailable to perform its required function. CI unavailability records can be broadcast or related to other records.

collection point
The component in the SLM application that is responsible for collecting the data. You can add multiple collection points with different port numbers.

collector
The component in the SLM application that manages the collection points and retrieves data.

Company field
A field in ITSM that controls multi-tenancy. It shows only data for the companies for which you have permission. See also multi-tenancy.

compliance at risk target
A target (such as 99.5 percent) that identifies when the agreement’s compliance reaches a point that is nearing a breach state and should be identified as a potential risk. See also compliance-only service target and compliance service target.

compliance-only service target
A service target that enables you to access data already processed by another product for use in compliance calculations. Using the compliance-only service target, SLM calculates compliance results at the agreement level only, by accessing service target results that were already processed by another application. See also compliance at risk target and compliance service target.

compliance service target
A target (such as 99 percent) that tracks the performance of the agreement to see the percentage of time the agreement was met over specific time periods. See also compliance at risk target and compliance-only service target.
configuration
Sets of CIs that are required by different groups of people in the company.

configuration catalog
A feature of Asset Management that stores your standard configurations (such as a standard desktop, laptop, server, and so on) for management purposes.

configuration item (CI)
An infrastructure component or an item associated with the infrastructure that is (or will be) under the control of configuration management, for example, a Request for Change. A CI can be complex or simple, large or small. CIs can include entire systems or be a single module or minor component. CIs can also include records of people (users and customers) and locations.

configuration management
The process of maintaining detailed IT inventory records. It involves identifying and defining the CIs in a system, recording and reporting the status of all CIs and requests for change, and verifying the completeness and correctness of all CIs. See also configuration item (CI).

Configuration Management Database
See BMC Atrium Configuration Management Database (BMC Atrium CMDB).

contract
A documented relationship between two parties that identifies details about each party, accounting and budget codes, purchase cost, and expiration dates, and ties one or more SLAs, OLAs, or underpinning contracts to the interested parties. The contract also makes it possible to segment and restrict access to the compliance and service target results so that results can be viewed by contract.

cost center
An entity tracking cost information within an organization. See also split cost center.

cost management
All of the policies, procedures, and deliverables required to fulfil an organization’s costing and charging requirements.

currency code
The three-letter code that represents a currency type, such as USD for United States Dollars.

dashboard
Web-based, graphical user interface using flashboards where compliance and service target results can be viewed by service level managers, service delivery managers, other IT professionals, and customers or line of business owners. See also service level agreement (SLA), service target, and flashboard.

data consumer
An application that works with data in ITSM. It might view the data or modify it. See also data provider.
data provider
An application that loads data into ITSM. This is often a discovery application. See also data consumer.

dataset
A logical group of data in ITSM. A dataset can represent data from a particular source, a snapshot from a particular date, and so on. The dataset used by BMC products for reconciled production data is named BMC Asset.

decision tree
A step-by-step guide set up by an administrator. It guides the user through a questionnaire and, based on the user’s answers, completes part of the form for a new incident.

declining balance depreciation
A method of calculating depreciation in which CIs depreciate at a constant rate per year, accelerated by a factor of 150 percent. In this method of accelerated depreciation, 150 percent of the straight-line depreciation amount is taken the first year, and then that same percentage is applied to the undepreciated amount in subsequent years. See also declining balance depreciation.

double-declining balance depreciation
A method of calculating depreciation in which CIs depreciate at a constant rate per year, accelerated by a factor of 200 percent. In this method of accelerated depreciation, double the straight-line depreciation amount is taken the first year, and then that same percentage is applied to the undepreciated amount in subsequent years. See also declining balance depreciation.

down CI
A CI out of service for repairs or not working.

DSL
See definitive software library (DSL).

escalation
A workflow component that searches at specified times or at regular intervals for requests matching a specified condition, and performs specified operations on all matching requests. Escalations are generally used to find records that have exceeded needed business rules or processes, and take appropriate action. They run on the AR System server.

federated data
Data linked from a CI in ITSM but stored externally. Federated data might represent more attributes of the CI or related information, such as change requests on the CI.

flashboard
A real-time visual monitoring tool that shows you the state of your service operations, warns you about potential problems, and collects and shows trend data.

depreciation
The loss of an asset’s value resulting from the passage of time.
**form**
A collection of fields that represents a record of information in the AR System. AR System administrators can define and change the fields and workflow associated with a form. An AR System application can include many forms.

**functional role**
A defined role used for notifications and to extend access granted by permission groups.

**global**
A setting that applies changes or defines certain parameters for all companies in a multi-tenancy environment. See also multi-tenancy.

**goal**
Measurement method that allows you to track the time taken to resolve an issue or track how often an asset or service was available. Goals are used to determine whether service targets are met.

**guest user**
Users who have not been configured with login information in the People form. Guest users cannot create change requests.

**impacted area**
Companies, locations, or organizations affected by changes or updates to CIs.

**incident**
Any event that is not part of the standard operation of a service and that causes an interruption to or reduction in the quality of that service. See also incident management and problem investigation.

**incident management**
As a concept, a reactive process typically initiated in response to a customer's call. The primary goal of the incident management process is to restore normal service operation as quickly as possible and with minimum disruption to the business.

**incident manager**
A person who monitors incident tickets and activities to help plan resources and to identify incident trends. The incident manager also handles assignments.

**incident matching**
A search process in Incident Management that can be used to search for other incidents, problem investigations, known errors, and solution database entries that share some of the same characteristics as the current incident, such as product categorization.

**incident owner**
The user who records the incident. This user might differ from the current incident assignee. See also assignee.

**Information Technology Infrastructure Library (ITIL)**
A set of guidelines for the management and provision of operational IT services.

**instance**
A record in ITSM. An instance is an object of a particular class. Both CIs and relationships are considered instances.

**inventory**
The quantity of CIs available.

**ISO currency code**
See currency code.

**ITIL**
See Information Technology Infrastructure Library (ITIL).
key performance indicator (KPI)
A data point used to measure whether performance-monitoring service targets meet their goals. See also service level agreement (SLA).

known error
A problem that has been successfully diagnosed and for which a temporary work-around or permanent solution to the known error has been identified. See also problem and work-around.

KPI
See key performance indicator (KPI).

life cycle asset management
Managing the life of a CI through its purchase, deployment, and disposal.

maintenance schedule
A schedule used to perform maintenance on CIs.

measurement
The metric by which supervisors measure the ability of the support staff to meet their agreements.

milestone
A point in time that triggers a set of actions as you progress toward an agreement compliance target or service target goal. The triggered actions are to make sure your goals are being met.

multi-tenancy
A feature in ITSM that uses the Company field to limit access by individuals. The Company field can be used to represent a company, department, or other group. The Company field also can be used to control access in a hosted environment. By default, ITSM applications operate in multi-tenancy mode. See also single-tenancy.

navigation pane
An area on the left side of consoles that provides links to functionality and links to other programs.

New Request Wizard
A simple form for requesters to submit service requests. Requesters use the New Request Wizard interface to submit service requests to IT, which is the only way to submit a service request from the Requester console.

non-bulk CIs
Stand-alone configuration items, for example, a single server or laptop.

notification
A message sent to a user by workflow. Notification can be in the form of an alert, email message, or other method using integrations.

OLA
See operational level agreement (OLA).

operational catalog
A feature in which operational categories for service requests are defined.

operational categorization
A three-tier hierarchical representation of operations as defined in the Operational Catalog configuration form. This categorization is included in records to specify the range of operations to which a record applies.

operational level agreement (OLA)
An internal agreement used to define and track the level of service provided for an IT organization. An example is an agreement between the network management team and the service desk.
operator
One of a number of functions that enable you to define advanced searches or build qualifications.

Overview console
A central console for ITSM applications. The console works like a control panel from which users can access all assigned work and perform their primary activities.

parent/child contract
A parent, or main, contract that has other children, or subcontracts, associated with it.

PDE
See product dictionary entry (PDE).

peer change request
A dependent change request that can be completed at the same time as another change request.

peer-to-peer
Devices that are on the same level in an organization’s network (for example, two workstations). See also notification.

performance-level service target
A service target that compares a service level to the goals defined in the service target to determine whether the goal is met. Allows you to monitor whether a critical application that you are using has responded within the time period specified in the goals. See also goal.

performance-monitoring service target
A service target that compares a goal to a defined threshold to determine if the goal is met. For example, it allows you to monitor whether a critical application that you are using responds within 4 seconds or if the application meets other criteria such as being in a state of “OK.”

permission group
A feature of the ITSM applications that controls what areas of the application a user can access. Each permission group can access only certain areas of the application. A user can belong to more than one permission group.

problem
The root cause of an incident or potential incident. After a resolution or work-around is identified, the problem becomes a solution database entry or known error. See also incident, known error, solution database, and work-around.

problem investigation
A process that helps an IT organization diagnose the root cause of incidents and potential incidents. It initiates actions that help to improve or correct the situation, preventing the incident from recurring.

problem management
As a concept, a process that identifies the cause of problems and initiates actions that help to improve or correct the situation, preventing an incident from recurring or occurring in the first place. The cause identified by a problem investigation can be documented in a known error or solution database record. See also incident, known error, solution database, and problem.

problem manager
A person who reviews problem investigations and known errors to maintain the quality and integrity of the problem management process. This person coordinates the assignment of problem investigations and known errors to support staff, and also reviews problem investigation requests and performs business impact analysis.
process flow  
Shows the progress of a request as it moves through the stages of its life cycle. It does this within a form, such as an incident request. A diagram shows the stages of the process, as indicated by best practices, rooted in ITIL processes. It indicates the current stage and state of the request. The process flow diagram also serves as a wizard, guiding the user through the life cycle.

product categorization  
A five-tier hierarchical representation of products as defined in the Product Catalog configuration form. This categorization is included in records to specify the range of products to which the record applies.

product dictionary entry (PDE)  
An entry in the Definitive Software Library that represents the master name of a software application. See also definitive software library (DSL).

push field  
An advanced action that allows you to push information from the “Applies To” form for which you are creating an SLA to another form on the same server. See also service level agreement (SLA).

reconciliation  
A feature in Asset Management that checks for duplicate CI records and enables the user to delete one and keep the other.

registered user  
A user who has an entry in the People form with an AR System login ID.

relationship  
A type of BMC Atrium CMDB class that defines the relationship between two CIs.

reminder  
A message similar to an AR System notification, except that you can define the content of a reminder and specify when to send it.

request-based service target  
A service target that measures how long a process takes, such as the time to respond to or resolve a service desk request, or the time to respond to or resolve a change request.

requester  
A person in the organization who needs assistance from the IT support staff. A requester is usually an employee in the organization who needs to have a change implemented or an incident resolved.

Requester console  
The front end for the Change Management and Incident Management applications. It provides an easy, user-friendly interface that allows users to quickly submit requests for change or incidents to the two back-end applications, and to view their submitted requests.

residual value  
The value you can purchase an item for after its lease expires.

return on investment (ROI)  
A method of calculating when the capital cost of implementing a project, product, or service will be recovered through the savings that result from completing the activity. The ROI can be expressed in terms of internal savings, increased revenue from external sources, or some combination of these types of savings. See also service level agreement (SLA) and service level management (SLM).
review period
A period of time over which the compliance of an agreement is monitored on a regular basis. The following review periods are provided in SLM: Daily, Weekly, Monthly, and Quarterly. For example, if a Monthly review period is added to a service level agreement, then the SLA’s compliance target needs to be met on a monthly basis. If a Daily review period is also added, then the SLA’s compliance target needs to be met on both a daily basis and a monthly basis. See also service level agreement (SLA) and service level management (SLM).

ROI
See return on investment (ROI).

role
A set of responsibilities, activities, and authorizations, usually within the context of a single application or a business system.

Note: Access to Remedy ITSM applications is based on user roles. Depending on your role in the organization—requester, support, management—you work with a different application (or view) on your desktop.

root cause
The underlying cause of an IT-related problem experienced by a customer.

row level locking
See multi-tenancy.

salvage value
The estimated value that a CI will realize at the end of its useful life. See also useful life.

script
Detailed instructions that have been set up by an administrator to prompt users with questions that can assist in resolving or assigning an incident.

service catalog
A list of IT services, default levels, and options.

service level agreement (SLA)
An agreement between a service provider and its customers or lines of business that formally documents the needs of the customer and makes sure the correct level of service is received from the service provider.

service level management (SLM)
As a concept, the continuous and proactive process of defining, agreeing, monitoring, reporting, and reviewing the performance of IT services to make sure that adequate levels of service are delivered in alignment with business needs and at acceptable cost.

service manager
A manager who uses Asset Management to create service objects used for interpreting business problems, for example, cost of unavailability of services to a business area.

service request
A request for service to the IT organization. Service requests can be requests for change or requests to resolve incidents that impact the user.

Service Request console
See Requester console.
service target
The individual level of service to achieve. A service target includes terms and conditions, goals, costs, and milestones. Examples of service target goals include incident resolution time of 30 minutes, application response time of 4 seconds, and an application being in a state of “OK.” See also availability service target, performance-monitoring service target, request-based service target, and compliance service target.

set field
An advanced action that allows you to pull information from other forms to set in the form for which you are creating the agreement.

single-tenancy
A feature that allows selection of a default company for company fields in ITSM. Single-tenancy mode is required to give unknown users access to the ITSM Requester console. See also multi-tenancy.

SLI
See software library item (SLI).

SLM
See service level management (SLM).

software library item (SLI)
The physical storage locations of the master copy of a software application and its versions.

software license compliance
Keeping track of what software your company has and that it has the legal right to use it.

solution database
A repository that stores reusable solutions to customer product problems in an easy-to-retrieve format.

solution entry
A reusable solution to a customer product problem. This is stored in the solution database.

split cost center
A cost center that enables a department to split its costs with other departments. For example, a project management group might split its costs with an engineering department and a sales department. The project management department would be a split cost center, and the engineering department and sales department would be target cost centers.

straight-line depreciation
A method of calculating depreciation in which CIs depreciate at a constant value per year. The annual depreciation is calculated by subtracting the salvage value of the CI from the purchase price and then dividing this number by the estimated useful life of the CI.

submitter
A person who reports a problem, makes a request, or enters information into a database. See also change request.

submitter group
One of several special access control groups that the AR System provides. Users automatically belong to this implicit group for requests they have submitted. See also assignee.

sum-of-the-year’s digits depreciation
A method of calculating depreciation in which CIs lose more of their value early in their lifetime. This method of calculating depreciation of a CI assumes higher depreciation charges and greater tax benefits in the early years of a CI’s life.
task
A unit of work that needs to be completed as a step in implementing an incident or problem investigation. In the Change Management application, you can also group a number of activities for requests with a number of actions that need to be completed before the request can be resolved. Your administrator creates task templates and task group templates that you can reuse for the same types of requests. Tasks can be manual or automatic.

task management system (TMS)
A sub-system that is used to create task templates and task group templates. Besides the ability to set up predecessor-successor relationships, TMS supports branching and multiple task paths as well as the data exchange between activities.

TCO
See total cost of ownership (TCO).

template
1. A set of predefined criteria or settings that can be used by many agreements or service targets. See also service level agreement (SLA).
2. A form set up by an administrator that a user can select to complete an incident ticket or a change request with information consistent with the user’s support group and the type of incident or change request.

terms and conditions
The conditions that specify whether a service target should take effect. For example, the terms and conditions could specify that the service target applies only to incidents in which the priority is urgent and the service is email. Or the service target applies only to a specific set of KPIs. See also service target.

time-based service target
A service target that measures the time taken, for example, to resolve an incident from the time the incident was reported to the time it was resolved. Any time that falls within the "Exclude when" qualification is ignored and not measured.

TMS
See task management system (TMS).

topology
The pattern of links connecting pairs of nodes of a network.

total cost of ownership (TCO)
A method of calculating all expenses associated with a CI over its lifetime. The calculation considers depreciation, maintenance, staff costs, accommodation, and planned renewal.

UC
See underpinning contract (UC).

underpinning contract (UC)
A contract that is used to track performance against prearranged goals that the IT organization has with an external service provider or supplier.

useful life
The number of years that a depreciable CI is expected to be in use.

wildcard
A character that users can type to represent other characters in a search. For example, in search statements in character fields, users can specify wildcards to match single characters, strings, or characters within a range or set.

work info
A record describing work performed.
work-around
A temporary resolution to an incident, problem, or known error.

workflow
The automated set of business processes used to run a company.
Index

A
accelerators, process flow 35
accessing
  applications
    from Change form 148
    from Change Management Console 114
Change Calendar 146
CI Relationships Search form 146
CI Unavailability form 147
Configuration Manager 140
Home Page in Overview Console 89
main consoles 80
Operational Catalog Listing dialog box 146
Overview Console 82
Policy Manager 342
Process Viewer 139
Product Selection dialog box 146
Requester Console 51
Service Request form 65
service requests 61, 66, 67
Update Effort Log dialog box 147
View Broadcasts dialog box 146
ad hoc
  change tasks, relating 218
  requests 56
Add Approver dialog box 352
Add Attachment dialog box 100, 152

adding
  See also relating
  approvers to change requests 352
  costs to change requests 284
  costs to change tasks 336
  financial information to change tasks 336
  predefined task groups to change requests 221
  predefined tasks to change requests 221
  time segments 188
Advanced Qualification Builder dialog box
  generating reports 133, 306
  searching for change requests 116
Advanced Search Selection dialog box 148, 155
Advanced tab 147
allocating costs to CIs 287
Allow Guest User option 49
alternate data sets, relating CIs to 256
application administrators
  configuring approvals 26
  responsibilities 34
  working with Change Management 34
Application Preferences form 94
Approval Process Configuration form 208, 349
approvals
  about 26, 208
  bypassing standard process 211
  change request 210, 312, 349
  creating 153
  criteria 347
  emergency 211
  implementation phase 212
approvals (continued)
phases 37, 348
process 346
status 346
stopping 212
viewing change request 313
viewing default phases 349
viewing status 36
approvers
about 26, 346
adding to change requests 352
approving change requests
using Approver tab 350
using process flow accelerators 349
Change Advisory Board (CAB) and 32
ITIL 32
rejecting change requests
using Approver tab 350
using process flow accelerators 349
responsibilities 346
viewing non-approval notifications 353
working with Change Management 32
Assigners Lookup form 349
Assigners tab 209, 348, 349, 350
AR Submitter locked mode 49
Asset Distribution tab 289
Asset Management
about 13
form 310
managing software licenses 276
Assigned Work table
about 83
filtering records 87
assigning
change requests
about 171
automatically 172
manually 173
reassigning 181
to change implementers 174
change tasks
all in change request 227
single 227
assigning (continued)
sequence numbers
change request 166, 247
task 224
task group 224
Assignment tab
Change form 173, 174, 290, 301
Task form 227, 229, 281, 331, 332
assignments
accepting 329
notification of
group 180
individual 180
Remedy Alert 180, 329
task implementer 329
reassigning 332
Associate Time Segment to CIs dialog box 199
audience for this guide 15
audit logs, viewing 152
Authoring Group dialog box 101
auto-cost estimates 286
auto-fill 89
B
Best Practice icon 12
best practices
ITIL 35
process flow status 35
Process Viewer (ITIL) 139
retries 72
BMC Atrium CMDB
about 12
functions defined by ITIL 357
viewing CI relationships 195
BMC Configuration Management Policy Manager.
See Policy Manager
BMC Remedy Alert notifications 180, 329
BMC Remedy Asset Management. See Asset Management
BMC Remedy Change Management. See Change Management
BMC Remedy User
opening main console 80
opening Requester Console 51
Broadcast Details tab 99
Broadcast Search Criteria tab 101, 102
Broadcast Submitter role 98

broadcasts
  about 98
  Change Management console 124
  CI unavailability 268
  creating 98
  limiting 102
  managers, using 308
  viewing 76, 101

browsers
  opening main consoles 81
  opening Requester Console 51

bulletin board messages. See broadcasts

business events
  registering 184
  viewing in Change Calendar 325

business models, sample 45

Business Objects Report Preview dialog box 123

business service managers. See managers

Business Time Segment dialog box 187, 189, 194

C

CAB. See approvers
calendars. See Change Calendar
canceling
  change tasks 232
  service requests 61

CCM Change Calendar. See Change Calendar

CCM solution, about 360

CCM. See Change and Configuration Management
change administrators. See application administrators

Change Advisory Board. See approvers

Change and Configuration Management
  about 356
  CCM solution 360
  predefined task groups 336
  predefined tasks 336
  Task Management Subsystem 358

change assignees
  about 144
  adjusting effort logs 179
  approval process 208
  assignments
    accepting 171
    notification of 180
  change requests
    creating 162
    modifying 168
    planning 181
    reassigning 181
    viewing assigned 125
  change tasks
    reassigning 281
    viewing assigned 124
  responsibilities 30, 144
  support staff role 79
  using
    Change form 145
    Change Management Console 106
    Support Console 108
  work information
    creating 125
    viewing 125

working with Change Management 30

Change Authority. See approvers

Change Calendar
  opening 321
  quick links 325
  viewing 318
  viewing business events 325
  viewing change requests 323

Change form
  about 145
  advanced functions 147
  Approvers tab 209, 348
  change requests
    copying 158
    searching for 154
  Dates tab 182
  designating change implementer 31
  Email System link 147
  Financials tab 283
  functions 146
Change form (continued)
  opening other applications from 148
  Paging System link 147
  quick links 146
  Related Items tab 249
  Relationships tab 235, 236, 237, 251
  Relationships table 244
  Reminders link 147
  selecting change templates 156
  sending email from 149
  sending pages from 149
  SLM tab 282
  Task tab 216, 218, 222, 225
  viewing
    audit logs 152
    impacted areas 153
    request stages 35
    risk reports 159
change implementers
  assigning change requests 174
  designating in Change form 31
  responsibilities 31
  support staff role 79
  working with Change Management 31
Change Location Company field 164
Change Location of the Requester tab 153
Change Management
  See also Change Management Console
  about 13, 24
  predefined reports 307
  reports 130
  roles
    application administrator 34
    approver 32, 346
    change assignee 30, 144
    change implementer 31
    change manager 28, 296
    manager 33
    requester 28, 48
    support staff 78
    task implementer 30, 328
  table data 103
Change Management Console
  about 106, 299
  Advanced Functions 113
  Assigned Change table 125
  Assigned Tasks table 124
  broadcasts 124
  change requests
    displaying 123
    searching for 123
  Company and Console View 111
  flashboards 300
  functions
    advanced 113
    general 112
  generating reports 300
  Help button 300
  inventory
    managing locations 135
    reserving 138
    using 138
    viewing locations 135
  logging out 300
  Manager Console 107
  opening
    Configuration Manager 140
    other applications from 114
  Process Overview 139
  quick actions 125
  relocating CIs 137
  reminders 126
  Search Criteria area 123
  Support Console 108
  viewing assigned tasks 109
  Work Info area 125
Change Management Dashboard form 318
Change Management Dashboard. See Dashboard
change managers
  about 296
  adjusting assignee effort logs 179
  approvals
    about 26
    change request 312
    process 208
change managers (continued)
change requests
approving 312
creating 308
planning 181
reassigning 301
searching for 309
viewing assigned 125
ITIL 26, 28
managing configuration items 309
managing SLM targets 311
responsibilities 28, 296
support staff role 78
using Change Management Console 106, 299
using Manager Console 107
viewing assigned change tasks 124
working with Change Management 28
Change Relationship Search dialog box 245
change requests (continued)
copying
about 158
configuration item relationships 254
costs
calculating 283, 313
deleting 286, 314
estimating 286
modifying 313
creating
additional details 165
approvals 153
as change manager 308
basic steps 162
dependent 247
related 244
denying reassignment 301
dependencies 25
dependent 233
effort logs 176
emergency 211
exporting 122
filtering by status 88
implementing 212
life cycle 44, 360
listing tasks 280
modifying 168
monitoring 279
order 25
ordering 247
peer 25, 206
planning 181
printing 122
process flow 34
reassigning 181, 301
registering time segments 183
rejecting 209, 349
related
configuration items 250
incidents 277
LDAP objects 271
software library items 273
<table>
<thead>
<tr>
<th>Term</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>change requests (continued)</td>
<td></td>
</tr>
<tr>
<td>relating</td>
<td></td>
</tr>
<tr>
<td>configuration items 251</td>
<td></td>
</tr>
<tr>
<td>existing incidents 278</td>
<td></td>
</tr>
<tr>
<td>new incidents 277</td>
<td></td>
</tr>
<tr>
<td>predefined task groups 221</td>
<td></td>
</tr>
<tr>
<td>predefined tasks 221</td>
<td></td>
</tr>
<tr>
<td>unavailable CIs 261</td>
<td></td>
</tr>
<tr>
<td>resolving 292</td>
<td></td>
</tr>
<tr>
<td>resubmitting rejected 212</td>
<td></td>
</tr>
<tr>
<td>reviewing 365</td>
<td></td>
</tr>
<tr>
<td>rollbacks 293</td>
<td></td>
</tr>
<tr>
<td>sample business model 45</td>
<td></td>
</tr>
<tr>
<td>searching for</td>
<td></td>
</tr>
<tr>
<td>advanced 116, 154</td>
<td></td>
</tr>
<tr>
<td>all 117</td>
<td></td>
</tr>
<tr>
<td>as change assignee 114</td>
<td></td>
</tr>
<tr>
<td>as change manager 309</td>
<td></td>
</tr>
<tr>
<td>available time segments 196</td>
<td></td>
</tr>
<tr>
<td>by login ID 115</td>
<td></td>
</tr>
<tr>
<td>by specific criteria 118</td>
<td></td>
</tr>
<tr>
<td>from Change Management console 114</td>
<td></td>
</tr>
<tr>
<td>from Support Console 117</td>
<td></td>
</tr>
<tr>
<td>group open 118</td>
<td></td>
</tr>
<tr>
<td>your open 117</td>
<td></td>
</tr>
<tr>
<td>sequence 25, 247</td>
<td></td>
</tr>
<tr>
<td>stages 37</td>
<td></td>
</tr>
<tr>
<td>states</td>
<td></td>
</tr>
<tr>
<td>reason requirements 40</td>
<td></td>
</tr>
<tr>
<td>relation to task states 214</td>
<td></td>
</tr>
<tr>
<td>transition diagrams 367</td>
<td></td>
</tr>
<tr>
<td>transitions 36</td>
<td></td>
</tr>
<tr>
<td>status</td>
<td></td>
</tr>
<tr>
<td>reason requirements 40</td>
<td></td>
</tr>
<tr>
<td>transition diagrams 367</td>
<td></td>
</tr>
<tr>
<td>templates 156</td>
<td></td>
</tr>
<tr>
<td>tracking time 290</td>
<td></td>
</tr>
<tr>
<td>unrelating</td>
<td></td>
</tr>
<tr>
<td>change requests 250</td>
<td></td>
</tr>
<tr>
<td>configuration items 255</td>
<td></td>
</tr>
<tr>
<td>incidents 278</td>
<td></td>
</tr>
<tr>
<td>change requests (continued)</td>
<td></td>
</tr>
<tr>
<td>viewing</td>
<td></td>
</tr>
<tr>
<td>approval status 36</td>
<td></td>
</tr>
<tr>
<td>approvals pending 313</td>
<td></td>
</tr>
<tr>
<td>as change assignee 161</td>
<td></td>
</tr>
<tr>
<td>costs 283</td>
<td></td>
</tr>
<tr>
<td>in Change Calendar 323</td>
<td></td>
</tr>
<tr>
<td>in Change Management Console 125</td>
<td></td>
</tr>
<tr>
<td>priority 282</td>
<td></td>
</tr>
<tr>
<td>progress 279</td>
<td></td>
</tr>
<tr>
<td>related change tasks 280</td>
<td></td>
</tr>
<tr>
<td>related configuration items 250</td>
<td></td>
</tr>
<tr>
<td>SLM targets 282</td>
<td></td>
</tr>
<tr>
<td>stages 34</td>
<td></td>
</tr>
<tr>
<td>status 279</td>
<td></td>
</tr>
<tr>
<td>Change Risk Report dialog box 159, 205</td>
<td></td>
</tr>
<tr>
<td>change status transitions, infrastructure 367</td>
<td></td>
</tr>
<tr>
<td>change supervisors. See change managers</td>
<td></td>
</tr>
<tr>
<td>change tasks</td>
<td></td>
</tr>
</tbody>
</table>
| See also configuration management tasks; tasks about 213 ad hoc 218 assigning a single task 227 all tasks in a change request 227 to task implementers 226 assignments accepting 329 notification of 329 canceling 232 changing status 227 closing 335 costs adding 336 calculating 336 creating 218 denying reassignment 282 dependencies 25 modifying as change assignee 226 as task implementer 334 monitoring 280 predefined 221 predefined CCM 336 394 Index
change tasks (continued)
reassigning
  as change assignee 281
  as task implementer 332
scheduling 228
searching for assigned 333
states 214
tracking time 229
viewing 216, 280
Change Template Selection dialog box 156
Change Type field 163
Change/Incident Data tab 64, 71, 74
CI Advanced Search dialog box 193
CI Relationship Viewer 195
CI Relationships Search form 146, 252, 261, 340
CI Status Information tab 266
CI unavailability
  broadcasting 268
  creating
    about 259
    additional 262
    for existing records 263
    from related CIs 264
  deleting 269
  modifying 267
CI Unavailability Search dialog box 260
CIs. See configuration items
Classification tab 164, 203
CMDB. See BMC Atrium CMDB
Command Event Master permissions 71
Company and Console View 111
Company field
  Change Location 164
  multi-tenancy and 84, 111, 164
Compute Level icon 163
Configuration Information form 251
Configuration Item Unavailability dialog box 264
configuration items (continued)
  managing 309
  related to change requests 250
relating
  alternate data sets 256
  change requests 251
  unavailable to change requests 259
relocating 137
unavailability
  broadcasting 268
  deleting 269
  modifying 267
unrelating from change requests 255
using the CI Relationship Viewer 195
viewing
  from related change requests 250
relationships in BMC Atrium CMDB 195
Configuration Management Database. See BMC Atrium CMDB
configuration management tasks
  See also change tasks; tasks
  about 358
  deployment-based 359
  life cycle 363
  policy-based 358
  predefined CCM 336
  verification-based 359
Configuration Manager, using 140
consoles
  opening main 80
  Requester 50
Copy Infrastructure Change dialog box 158
Copy Related Relationships form 240
copying
  change request relationships 240
  change requests 158
  configuration item relationships 254
Cost Allocation dialog box 287
Cost User permissions 286
costs
  adding to change requests 284
  adding to change tasks 336
  allocating to configuration items 287
  analyzing 27
  calculating change request 283, 313
costs (continued)

Cost User permissions 286
deleting from change requests 286, 314
estimating 286
managing 27
modifying change request 313
negating 286
reversing 286
viewing 283
Costs dialog box 268, 284, 314
Create Reminder tab 126
creating
additional CI unavailability 262
approvals for change requests 153
broadcasts 98
change requests
as change assignee 162
as change manager 308
dependent 247
related 244
related without dependencies 244
CI unavailability 259, 263
effort logs 176
incidents
from Change form 148
related to change requests 277
known errors from Change form 148
problems from Change form 148
qualifications for reports 305
relationships between change requests 235, 245
reminders 126
requester records 90
requests from Overview Console 85
service requests 54
time segments
as change assignee 185
configuration item 193

D

Dashboard
about 315
using 316
data sets
alternate 256
preferences 256
used when creating CIs 309
Dates tab 182, 228
Define Report Qualification dialog box 306
Definitive Software Library 274
deleting
CI unavailability 269
costs from change requests 286, 314
reminders 128
denying reassignment
change request 301
change task 282
dependencies
change request 25, 233
configuring enforcement levels 25
creating between change requests 247
specifying change request sequence 247
task 25
viewing 249
dependent change requests 233
Deployment Manager 359
deployment-based tasks 359
diagrams, change request status transition 367
dialog boxes. See forms
DM. See Deployment Manager
documents available for ITSM 15–19
DSL. See Definitive Software Library

E

editing profiles in Overview Console 89
effort logs
adjusting assignee time 179
creating 176
deleting 179
modifying 178
tracking assignee time 291
email
Email System link on Change form 147
sending from Change form 150
<table>
<thead>
<tr>
<th>Email System dialog box</th>
<th>151</th>
</tr>
</thead>
<tbody>
<tr>
<td>emergency change requests, approving</td>
<td>211</td>
</tr>
<tr>
<td>enforcement, configuring dependency levels</td>
<td>25</td>
</tr>
<tr>
<td>Event History dialog box</td>
<td>71</td>
</tr>
<tr>
<td>events</td>
<td></td>
</tr>
<tr>
<td>retrying, best practice</td>
<td>72</td>
</tr>
<tr>
<td>viewing logs</td>
<td>71</td>
</tr>
<tr>
<td>Existing Configuration Item Unavailability dialog box</td>
<td>263</td>
</tr>
</tbody>
</table>

**F**

| Financials tab | 283, 336 |
| flashboards | 300 |
| forms | |
| Add Approver | 352 |
| Add Attachment | 100, 152 |
| Advanced Qualification Builder | 116, 133, 306 |
| Advanced Search Selection | 148, 155 |
| Application Preferences | 94 |
| Approval Process Configuration | 208, 349 |
| Approvers Lookup | 349 |
| Asset Management | 310 |
| Associate Time Segment to CIs | 199 |
| Authoring Group | 101 |
| Business Event/Location Definition | 185, 188 |
| Business Objects Report Preview | 123 |
| Business Time Segment | 187, 189, 194 |
| Change | 31, 35, 145 |
| Change Management Dashboard | 318 |
| Change Relationship Search | 245 |
| Change Risk Report | 159, 205 |
| Change Template Selection | 156 |
| CI Advanced Search | 193 |
| CI Relationships Search | 146, 252, 261, 340 |
| CI Unavailability Search | 260 |
| Configuration Information | 251 |
| Configuration Item Unavailability | 264 |
| Copy Infrastructure Change | 158 |
| Copy Related Relationships | 240 |
| Cost Allocation | 287 |
| Costs | 268, 284, 314 |
| Define Report Qualification | 306 |
| Email System | 151 |
| Event History | 71 |

forms (continued)

| Existing Configuration Item Unavailability | 263 |
| Impacted Areas | 153 |
| Incident | 277 |
| LDAP Search | 272 |
| Manage Inventory | 135 |
| Modify Effort Log | 178 |
| Modify Relationship | 242 |
| My Group Selection | 111, 333 |
| New/Modify Broadcasts | 98, 102, 269 |
| Non-Approval Notifications | 353 |
| Operational Catalog Listing | 146 |
| Options | 97 |
| Paging System | 149 |
| People | 90 |
| People Search | 121 |
| Person Information | 90, 92, 122 |
| Print Properties | 326 |
| Product Selection | 146 |
| Qualification Name | 132 |
| Quick Filter | 323 |
| Registration for Shared Time Segment | 186 |
| Related Configuration Item | 324 |
| Relationship Attributes | 340, 341 |
| Relationships for Configuration Item | 254 |
| Reminder Details | 128 |
| Reminders | 126, 128, 129 |
| Request Work Info | 59, 68, 69 |
| Risk Assessment Questions | 163, 205 |
| Saved Qualifications | 134, 304 |
| Search Inventory Locations | 137 |
| Search Operational Categorization/Location Definition | 185 |
| Search Time Segment | 192 |
| Select a CI Type | 309 |
| Select Request Type | 85, 86 |
| Select Status Values | 88 |
| Select Template | 222, 337 |
| Service Request | 66, 72 |
| Software Library Item Search | 273, 339 |
| Survey | 63 |
| Task | 219, 330, 334 |
| Task Effort Log | 230 |
| Task Information | 217 |
forms (continued)
  Time Segment Analysis 197, 201
  Update Effort Log 147, 176
  User Defaults 325
  User View 318
  View Broadcasts 101, 102
  Work Info 343
Functions tab 146

G
  global flag, multi-tenancy and 325
  groups
    See also support groups; task groups
    assignment notification 180
  Help Desk Master 277
  Help Desk Submitter 277
  Help Desk User 277
  searching for open change tasks 333
  viewing
    assigned change requests 111
    task 216
    your support 114

H
  Help Desk
    Master permission group 277
    Submitter permission group 277
    User permission group 277
  help desk cases. See incidents

I
  icons
    Best Practice 12
    Compute Level 163
    New 12
  impact
    analyzing 27
    assessing for change requests 203
  Impact field 163
  Impacted Areas dialog box 153
  impacted areas, viewing 153
  implementation approval phase 212
  Incident form 277
  Incident Management, about 13

incidents
  creating from Change form 148
  related to change requests 277
  relating
    existing to change requests 278
    new to change requests 277
    resolving with Solutions database 75
  unrelating from change requests 278

Information Technology Infrastructure Library.
  See ITIL
  infrastructure change status transitions 367
  inventory
    managing locations 135
    reserving 138
    using 138
    viewing locations 135
  IT Service Management, about product
    family 12–14
  ITIL
    approvers 32
    best practices 35
    BMC Atrium CMDB functions 357
    CAB 32
    change managers 26, 28
    identifiers for CIs 309
    Process Viewer 139

K
  known errors, creating from Change form 148

L
  launching Policy Manager 342
  LDAP objects related to change requests 271
  LDAP Search dialog box 272
  life cycles, modifying change request 168
  limiting number of broadcast messages 102
  locked mode, AR Submitter 49
  logging in
    main consoles 80
    Requester Console 51
  unknown users 49
  logging out, Change Management Console 300
logs
  effort 176, 291
  event 71
  Task Effort 230
  viewing audit 152

M
main consoles
  opening with browser 81
  opening with Remedy User client 80
Manage Inventory dialog box 135
Manager Console, about 107
Manager tab 74
managers
  See also change managers
  working with Change Management 33
messages. See broadcasts; email; paging
Modify Effort Log dialog box 178
Modify Relationship dialog box 242
modifying
  change requests 168
  change tasks
    as change assignee 226
    as task implementer 334
  CI unavailability 267
  costs 313
  effort logs 178, 179
  relationships between change requests 241
  reminders 128
  requester records 93
  service requests 59
  time segments 188
monitoring
  change requests 279
  change tasks 280
multi-tenancy
  Change Location Company field 164
  Company field 84, 111
  global flag 325
  unknown users 49
My Group Selection dialog box 111, 333

N
names, finding user 120
New icon 12
New Request Wizard, defined 54
New/Modify Broadcasts dialog box 98, 102, 269
Non-Approval Notifications dialog box 353
Notes log fields 169
Notification Audit tab 153
notifications
  See also assignments
  receiving 41
  Remedy Alert 180
  sending 41
  triggering with state changes 41
  viewing non-approver 353
Notifications tab 150

O
opening
  applications
    from Change form 148
    from Change Management Console 114
  Change Calendar 146
  CI Relationships Search form 146
  CI Unavailability form 147
  Configuration Manager 342
  Home Page in Overview Console 89
main consoles
  about 80
  with browser 81
  with Remedy User client 80
Operational Catalog Listing dialog box 146
Overview Console 82
Policy Manager 342
Process Viewer 139
Product Selection dialog box 146
Requester Console 51
Service Request form 65
service requests 61, 66, 67
Update Effort Log dialog box 147
View Broadcasts dialog box 146
Operational Catalog Listing dialog box 146
operational categorizations, registering 184
options
  setting 94
  viewing 94
Options dialog box 97
Index

BMC Remedy Change Management 7.0

Overview Console
  Assigned Work table  83
  auto-filling fields  89
  Console Functions  87
  Console View  87
  creating requests  85
  filtering records  87
  filtering requests by status  88
  finding requests  86
  opening  82
  opening applications from  87
  opening Home Page  89
  printing records  89
  profile
    editing  89
    viewing  88
  refreshing record status  89
  status
    refreshing  89
    selecting  88
  viewing requests  85

Policy Manager
  Closed Loop Verification task and  221
  Create and Modify Policy task and  221
  launching  342
  managing software and data  358
  updating policies  364
  using SLIs  273
  Viewer window  344

policy-based tasks  358
predefined
  CCM task groups  336
  CCM tasks  336
  reports  303
  task groups  221
  tasks  221

preferences
  data sets  256
  setting
    advanced options  96
  new request form  95
  search request form  95
  view  96
  viewing  94

Print Properties dialog box  326
printing
  change requests  122
  reports  302
  service requests  60
  table data in list format  104
  table data shown on screen  103

Problem Management, about  14
problems, creating from Change form  148
process flow
  accelerators  35
  change request  34
  moving changes to another state  169
  status area  36

Process Flow Status wizard  35
Process Status Flow area  169
Process Viewer  139
product dictionary entries, defined  274
Product Selection dialog box  146

P
paging
  a person  149
  on-call groups  149
  Paging System link on Change form  147
Paging System dialog box  149
peers
  change request  25, 206
  task  25, 224
People form  90, 92, 122
People Search dialog box  121
permissions
  Command Event Master  71
  Cost User  286
  Help Desk groups  277
  ITSM  28
  Requester Console  48
Person Information form  90
phases, approval  348
policies
  defined  358
  updating  364
User's Guide

Q
Qualification Name dialog box  132
qualifications
creating to generate reports 305
generating reports
with  131
with advanced  133
with saved  134
without  130
using
advanced for reports 306
saved 304
to generate reports 304
Quick Filter dialog box  323
quick links, Change Calendar 325

R
reassigning
change requests
as change assignee 181
as change manager 301
denying reassignment 301
change tasks
as change assignee 281
as task implementer 332
denying reassignment 282
receiving notifications 41
records
filtering in Assigned Work table 87
finding requester 92, 120
Recurrence Definition tab 191
registered users 48
registering
business events 184
operational categorizations 184
time segments 183
Registration for Shared Time Segment form 186
rejections
change request 209, 349
resubmitting 212
Related CIs with Costs Allocated table 289
Related Configuration Item dialog box 324
Related Items tab 249
relating
See also relationships; unrelating
change tasks 218
configuration items to alternate data sets 256
configuration items to change requests 251
existing change requests 245
existing incidents to change requests 278
LDAP objects to change requests 271
new change requests 244
new incidents to change requests 277
predefined task groups to change requests 221
predefined tasks to change requests 221
software library items to change requests 273
unavailable CIs to change requests 259
Relationship Attributes dialog box 340, 341
relationships
See also relating; unrelating
about 233
copying 240
creating 235
defining 236
ending 250
modifying 241
quick actions 238
removing 244
viewing 242
Relationships for Configuration Item dialog box 254
Relationships tab 235, 236, 237, 251, 252, 255
Relationships table 244
relocating CIs 137
Reminder Details dialog box 128
reminders
about 126
creating 126
deleting 128
modifying 128
Reminders link on Change form 147
viewing 128
Reminders dialog box 126, 128, 129
removing
relationships from change requests 244
time segments 193
Report Console 130, 132, 303

Index ▲401
reports
about 27, 130
generating
about 302
in Change Management Console 300
predefined 303
with advanced qualifications 133
with qualifications 131, 304
with saved qualifications 134
without qualifications 130
predefined 303, 307
printing 302
qualifications
advanced 306
creating 305
using saved 304
Report Console 130, 132, 303
View Risk 205
viewing 302
viewing risk 159
request masters
adding work information 68
canceling service requests 67
Command Event Master permissions 71
defined 48
opening service requests 66
reopening service requests 67
using Service Request forms 65
viewing Work Info tab 68
working with service requests 65
Request Work Info dialog box 59, 68, 69
Requested By/Service Location tab 74
Requested For tab 74
Requester Console
See also service requests
functions 52
opening 51
user permissions
Command Event Master 71
registered user 48
request master 48
unknown user 48
using 53
Requester Contacted icon 167
requester records
about 90
creating 90
finding 92
modifying 93
requester role 48
requesters
See also requester records
approval 26
searching for 120
working with Change Management 28
Requesters tab 74
requests. See change requests; service requests
resubmitting rejected change requests 212
retrying events, best practice 72
risk
analyzing 27
assessing for change requests 203
computing levels of 205
View Risk report 205
viewing reports 159
Risk Assessment Questions dialog box 163, 205
Risk Level field 163
roles
application administrator 27, 34
approver 27, 32, 346
Broadcast Submitter 98
change assignee 27, 30, 79, 144
change implementer 27, 31, 79
change manager 27, 28, 78, 296
company executive 33
ITSM 28
manager 27, 33
problem manager 28
requester 27, 28, 48
support staff 78
task implementer 27, 30, 79, 328
rolled back change requests 293
Sample business model 45
Saved Qualifications dialog box 134, 304
Scheduling change tasks 228
Search Business Event/Location Definition form 185
Search Inventory Locations dialog box 137
Search Operational Categorization/Location Definition form 185
Search Time Segment dialog box 192
Searching for change requests
  advanced option 154
  as change manager 309
  by login ID 115
  by specific criteria 118
  from Change Management Console 114, 123
  from Overview Console 86
  from Support Console 117
  group open 118
  your open 117
Change tasks
  assigned 333
  group open 333
  your open 333
Requester records 92
Requesters 120
Service requests 60
Time segments
  available 196
  to relate 192
Users 120
Select a CI Type dialog box 309
Select Request Type dialog box 85, 86
Select Status Values dialog box 88
Select Template dialog box 222, 337
Sending notifications 41
Sequence numbers
  adding to
    change requests 166, 247
    task groups 224
    tasks 224
  change request 25, 206
  task 25
Service Level Management. See SLM
Service level targets. See SLM targets
Service Request form
  about 72
  accessing 65
  adding work information 69
  search mode 66
  viewing work information 69
Service requests
  See also Requester Console
  accessing Service Request form 65
  ad hoc requests 56
  adding work information 68, 69
  canceling 61, 67
  completing surveys 62
  creating 54
  finding 60
  modifying 59
  opening 66
  printing 60
  reopening 61, 67
  request IDs 60
  resolving with Solutions database 75
  Service Request Wizard 54
  sorting 57
  states 57
  troubleshooting 71
  updating work info 59
  viewing
    event logs 71
    records 58
    Work Info tab 68
    work information 69
Service targets
  See also SLM
  managing 311
  viewing 282
Setting
  new request form options 95
  preferences and options 94
  search request form options 95
  view 96
Show Reminders tab 128
Single-tenancy 49
SLIs. See software library items
SLM tab 74, 282, 311
SLM, about 14
Software Library Item Search dialog box 273, 339
software library items
  Definitive Software Library 274
  product dictionary entries 274
  related to change requests 273
  software license management 276
software license management
  about 276
  Asset Management and 276
Solutions database, resolving incidents 75
sorting
  service requests 57
  table data 103
states
  change request transitions 367
  changing in Process Status Flow area 169
  comparing change and task 214
  service request 57
  triggering notifications when changed 41
status
  change request transitions 367
  reason requirements for change requests 40
Status field 162
Status Flow tab 349
Summary field 163
Support Console, about 108
support groups
  See also groups; task groups
  viewing 114
  viewing assigned change requests 111
Support Groups tab 114
support staff
  about 78
  change assignee role 79
  change implementer role 79
  change manager role 78
  task implementer role 79
  working with Change Management 78
Survey dialog box 63
surveys, service request 62

**T**
table data
  about 103
  printing all in list form 104
  printing screen 103
  sorting 103
  updating 103
  viewing 103
tabs
  Advanced 147
  Approvers 209, 348, 349, 350
  Asset Distribution 289
  Assignment
    Change form 173, 174, 290, 301
    Task form 227, 229, 281, 331, 332
  Broadcast Details 99
  Broadcast Search Criteria 101, 102
  Change Location of the Requester 153
  Change/Incident Data 64, 71, 74
  CI Status Information 266
  Classification 164, 203
  Create Reminder 126
  Dates 182, 228
  Financials 283
  Functions 146
  Manager 74
  Notification Audit 153
  Notifications 150
  Recurrence Definition 191
  Related Items 249
  Relationships 235, 236, 237, 251, 252, 255
  Requested By/Service Location 74
  Requested For 74
  Requesters 74
  Show Reminders 128
  SLM 74, 282, 311
  Status Flow 349
  Support Groups 114
  Task Work Info 79
  Tasks 109, 213, 216, 218, 222, 225, 280
  Work Info 74, 169, 231, 279
targets, viewing SLM 282
Task Effort log 230
Task form
  about 217
  accepting assigned tasks 330
Assignment tab 227, 229
Dates tab 228
modifying tasks 334
relating ad hoc tasks to change requests 219
task groups
  See also groups; support groups
  assigning sequence numbers 224
predefined 221
predefined CCM 336
viewing 216
task implementers
  about 328
  accepting assignments 329
change tasks
  adding costs 336
  assigning 226
  closing 335
  handling 213
  modifying 334
  reassigning 332
  using predefined CCM 336
receiving assignment notifications 329
responsibilities 31, 328
searching for tasks
  assigned 333
  group open 333
  your open 333
support staff role 79
  working with Change Management 30
  working with in-progress tasks 333
Task Management Subsystem 358
task management system
  installed with Change Management 24
  integrated with Change Management 24, 25
Task Work Info tab 79
tasks
  See also change tasks; configuration management tasks
  adding work information 231
  assigning sequence numbers 224
  configuration management 358
  dependencies 25
tasks (continued)
  deployment-based 359
  life cycle 363
  order 25
  peer 25, 224
  policy-based 358
  predefined 221
  predefined CCM 336
  reviewing 364
  sequence 25
  verification-based 359
  viewing assigned 109, 124
Tasks tab 109, 213, 216, 218, 222, 225, 280
templates
  change request 156
  predefined task 221
  predefined task group 221
tenancy
  multiple 49, 84, 111, 164, 325
  single 49
Time Segment Analysis window 197, 201
time segments
  about 183
  adding 188
  configuration item 193
  creating 185, 193
  modifying 188
  registering 186
  relating to
    business events 192
    categorizations 192
    configuration items 192
  removing 193
  searching for
    available 196
    to relate 192
  selecting 186
  viewing 191
Timing field 165
TMS. See Task Management Subsystem
BMC Remedy Change Management 7.0

tracking
change request time
about 290
automatically 291
in effort log 291
manually 291
task time
about 229
automatically 229
in effort log 230
manually 230
troubleshooting service requests 71

U
unavailability. See CI unavailability
unknown users
defined 48
logging in 49
multi-tenancy and 49
unrelating
See also relating; relationships
change requests 250
configuration items from change requests 255
incident records from change requests 277
incidents from change requests 278
Update Effort Log dialog box 147, 176
updating table data 103
Urgency field 163
URL, main console 51, 81
user client, opening main console with 80
User Defaults dialog box 325
user roles. See roles
User View dialog box 318
users
Allow Guest User option 49
registered 48
request master 48
searching for 120
unknown 48

V
verification-based tasks 359
View Broadcasts dialog box 101, 102
View Flow button 217
View Risk report 205
view, setting 96
Viewer window, Policy Manager 344
viewing
approval phases, default 349
assigned tasks 109
audit logs from Change form 152
broadcasts 76, 101
business events in Change Calendar 325
Change Calendar 321
change requests
approvals 313
assigned to groups 111
assigned to you 111
costs 283
from support console 161
in Change Calendar 323
in Change Management Console 125
priority 282
progress 279
relationships 242
change task groups 216
change tasks 124, 216, 280
configuration items
locations 135
related to change requests 250
relationships 195
dependencies 249
event logs 71
impacted areas from Change form 153
inventory locations 135
notifications 353
preferences and options 94
profile in Overview Console 88
reminders 128
reports 302
request details 53
requests 85
risk reports 159
service requests 52, 58
SLM targets 282
support groups 114
table data 103
viewing (continued)
  time segments 191
  user requests 53
  Work Info tab 68
  work information 69

W
wizards
  Process Flow Status 35
  Service Request 54
Work Info dialog box 343
Work Info tab
  about 169
  adding information 231
  information for service request 74
  progress of change request, monitoring 279
  viewing 68